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Executive summary

This document contains the Step 1 and Step 2 system requirements for enhanced FOC functions,
which have been derived from the operational requirements provided by P11.01.02 in its Step 1 and
Step 2 OSED.

The document does not constitute an update to an older WP11.01.03 Technical Specification
document, but is designed as an all-new document. It does take into account the content of the
Technical Specification documents that have been produced throughout the course of SESAR 1 in
WP11.01.03, however, for the purpose of this document all content has been completely reviewed
and amended if necessary. The technical requirements presented herein were developed to support
the software prototypes produced in P11.01.04 that allowed the validation of the operational concepts
and requirements defined by P11.01.02.

The main topics covered by the technical requirements are Trajectory Management, Free Route,
Advanced Flexible Use of Airspace (AFUA), User Driven Prioritization Process (UDPP), Extended
Flight Plan (EFPL), Aeronautical Information Management (AIM), and Meteorology. An allocation of
the requirements to the topics is provided in the document.

This specification may be used by Flight Planning Service Providers for the adaptation of their FOC
systems and it can also be used by Airlines for the further development of their flight planning tools. It
is supporting SESAR solutions #31 (Advanced Flexible Use of Airspace), #33 (Free Routing), #37
(Extended Flight Plan), and #57 (User Driven Prioritization Process). It shall also serve as a reference
document in SESAR 2020, providing the complete list of technical requirements for the FOC identified
in SESAR 1
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1 Introduction

1.1 Purpose of the document

The purpose of this document is to provide the technical specification and interface requirements
(TS/IRS) for the FOC functions.

The business trajectory base approach within SESAR expresses the specific intentions of Airspace
Users. Project P11.01.03 is describing the adaptation and developments of technical means
supporting the 4D business trajectory management. P11.01.03 is responsible for the design of the
FOC system, from business objectives to systems requirements, fully compliant with the SESAR
performance target, but is also responsible to ensure that the design of FOC system meets
stakeholder needs and that system elements are developed accordingly. This document describes
the translation of the operational requirements into system requirements for Step 1 and Step 2 as
available. The document includes consequently the translation of the operational and business
requirements for an FOC from P11.01.02 into system requirements and specifications for the FOC.
This specification may be used by Flight Planning Service Providers for the adaptation of their FOC
systems. This specification can also be used by Airlines for the further development of their flight
planning tools.

All requirements, scenarios and use cases in this document are in accordance with the operational
scenarios and requirements described in the WP11.01 Step 1 and Step 2 as available OSED [29]2
and have been designed taking into account the description of the Technical Architecture in the
WP11.01 FOC Step 1 and Step 2 TAD [7] (see also Figure 1). The requirements presented herein
have been developed to support the software prototypes produced in P11.01.04 that allowed the
validation of the operational concepts and requirements defined by P11.01.02. For all requirements
and traces, Dataset 16 has been used as the reference.

The system requirements of the FOC within this document consider in addition the topics of accuracy,
safety, interoperability and conformity to standards.

Concluding, this technical specification defines the reference for system requirements of the FOC as
a blue print for the development of future FOC. This specification should be used by Flight Planning
Service Providers and airlines for the development of their enhanced FOC tools. The specification is
prototype and release neutral.

2 At the time of writing, no mature draft of the WP11.01 Step 1 and Step 2 (as available) INTEROP
[30] was available. Therefore, this document could not serve as a reference for this TS document.
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Figure 1: TS document with regards to the other SESAR deliverables

1.2 Intended readership

The intended readership includes:

e P04.03: Project that takes care about pre-operational validation across different concepts/
elements of En Route operating context. As concepts like Free Route are discussed in this

document, this project might be interested in reading this document.

e P04.05: Operational project dealing with the definition of the business and mission trajectory
within the En Route environment, which can provide additional operational inputs/needs to the

FOC system functions in particular for the extended flight plan.

e SWPO05.05: Operational project dealing with the needs relating to trajectory management,
specifically the creation, amendment, distribution of the business trajectory and mission

trajectory. The FOC related requirements are of importance here, therefore,
of interest to SWP05.05.
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e 05.06.02: Operational project dealing with the optimization of the vertical profile (departure/
arrival) under consideration of practices and limitations of ATC controllers and flight crews.

e SWPO07.02: responsible for the ops/technical coordination in WPQ7 (Network Operations). As
the AU with its FOC is one important stakeholder influencing network operations, the content
of this Technical Specification is of interest to this project.

e P07.05.04: dealing with the flexible airspace management and airspace design. As the FOC
related requirements of the AFUA concept as well as Free Route aspects are described in
this TS document, members of this project might be interested in this document.

e P07.06.02: Operational project dealing with the support (by NM) of airspace user to allow
them to operate their flights in an optimum way. In order to achieve this, many concepts
described in here play an important part and, therefore, this document is of interest to this
project.

e SWPO08.03: Project dealing with the development and building of the service view by defining
the logical shared information services and specifying the information (service) models. As
the FOC requirements are satisfying several services, members of SWP08.03 might be
interested in reading this document

e P09.01: System project implementing Initial 4D concept in aircraft which can be supported by
time constraints and weather uplinks from FOC system. As the FOC side of the 4D concept is
presented in this TS, the content should be taken into account by P09.01 in order to ensure
that the AU FOC and the aircraft systems can work together seamlessly.

e P13.02.02: This project focuses on digital NOTAM and digital pilot briefing. As in this TS
document the requirements for the FOC to handle this are detailed, the document is of
interest to this project.

e P14.02.09: Project in charge of the realisation of the SWIM test platform. The descriptions
given in this document should be used to deduce requirements for the SWIM environment.
Furthermore this project might review web services that were developed in the course of this
project.

e P16.06.xx: Projects dealing with safety, security, resilience, robustness and performance of
technical and operational solutions within SESAR. This document is of interest to these
projects in order to deduce input for the definition of respective requirements and to review
the setup of the proposed system in regard to the aspects covered by the P16.06.xx projects.

e PB04.03: the members of the SESAR Technical Architecture project to check that content
presented in line with the system decomposition/architecture.

Also all members of projects contributing to the following Enabling Areas and Operational Focus
Areas might have an interest in reading this document:

e ENBO02.01.02 AIM/MET

e ENBO03.01.01 TMF Trajectory Management Framework
e OFAO03.01.03 Free Routing

e OFAO03.01.04 Business and Mission Trajectory

e OFAO05.03.01 Airspace Management and AFUA

e OFAO05.03.06 UDPP

Naturally, the contents of this document may also be useful for any project, which is affected by the
4D Trajectory Management within SESAR and with its connected system developments. Also with
regard to SESAR 2020 this document can provide beneficial input to many projects.

Finally, this document might be interesting for Aircraft Manufacturers, Original Equipment
Manufacturers (OEM), and Aircraft Equipment Manufacturers, as well as regulators and
standardization bodies, such as for example EUROCAE WG76 dealing with AIS/MET Datalink
Applications.
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1.3 Inputs from other projects

The following inputs have been considered while writing this system specification (ordered by project
number):

For a correct writing of all requirements, this document has taken into account the guidelines
provided by the SJU [1][2][3][5][6]-

PB.04.02 - D106 - Transition ConOps SESAR 2020 - Consolidated deliverable with
contribution from Operational Federating Projects [8]

PB.04.03 - D98 - Architecture of the Technical Systems Description Document SESAR 2020
Transition edition [9]

P04.07.02 - D37 - Free Route Operational Service and Environment Definition (OSED) for
Step 1 — Iteration 2 [10]

P04.07.02 - D63 - Free Route Safety and Performance Requirements (SPR) for Step 1 [11]
P07.06.02 - D45 - Step 1 Business trajectory OSED 2015 update [12]
P07.06.02 - D74 - User Driven Prioritisation Process (UDPP) Step 2 V2 Interim OSED [13]

P09.01 - DO1 - Aircraft and System Performance and Functional requirements -step 1 (WA1)
[14]

P09.48 - D05 - Validation Report for AIS/MET Services and Data distribution [15]

P09.48 - D08 - Functional Requirement Document on AIS/MET Services and Data
Distribution [16]

P09.48 - D09 - High Level Architecture Document [17]

P13.02.02 - D118 - OSED - Digital Integrated Briefing (the project is part of an AIM dedicated
OFA focusing on digital NOTAM and digital pilot briefing) [18]

Furthermore, the following documents internal to WP11.1 have been used as reference, source or
higher-level document:

firg me
ELERAPLRS (s

P11.01.03 - DO1 - Step 1 Use Cases and System requirements for FOC system [19]
P11.01.03 - DO7 - BMT (FOC) Step 2 Technical Specification [20]

P11.01.03 - D10 - EFPL (FOC) Step 1 Technical Specification [21]

P11.01.03 - D13 - FR (FOC) Step 1 Technical Specification [22]

P11.01.03 - D06 - AFUA (FOC) Step 1 Technical Specification [23]

P11.01.03 - D21 - TS Stepl and Step 2 as available for FOC system Sabre [25]
P11.01.03 - D21 - TS Stepl and Step 2 as available for FOC system Honeywell [26]
P11.01.03 - D19 - Civil AU Operations Centre Technical Architecture Description (TAD) [7]

P11.01.01 - DO1 - DOD - Definition of trajectory requirements for Step 1 [28]
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e P11.01.02 - D08 - FOC Operational Service and Environment Definition (OSED) Step 1 and
Step 2, as available [29]

e P11.01.02 - D08 - FOC Interoperability Requirements (INTEROP) Step 1 and Step 2, as
available [30]

e P11.01.02 - D01 - FOC Safety and Performance Requirements (SPR) Step 1 [31]

The requirements from the WUF (Weather Uplink FMS) TS [24] are not included in this document as
Honeywell has agreed with SJU that no further deliverables are required, therefore, the WUF TS is
considered by Honeywell as not being a subject of the overall common TS consolidation.
Furthermore, the interface requirements for AIM also remain in a separate IRS document produced by
Honeywell [27].

1.4 Structure of the document

The document is organised as followed:

e Chapter 1 introduces the document. It defines the purpose and scope of the document and
identifies its intended audience. It also provides a list of acronyms and terminology;

e Chapter 2 provides a general description of the functional blocks;

e Chapter 3 includes all system requirements, sorted by requirement type and sub-sorted by
functional block affiliation;

e Chapter 4 lists the assumptions considered while writing this document;
e Chapter 5 lists the references and applicable documents.
e Appendix A provides an allocation of the requirements to the different topics

e Appendix B lists all requirements from the source documents that have been set to status
“deleted”

e Appendix C lists all requirements that were already set to status “deleted” in the source
documents

1.5 Requirements Definitions — General Guidance

With regard to the definition of the requirements, the following points are of importance:

As throughout the run time of WP11.1.3 multiple Technical Specifications have been produced (see
Section 1.3), the requirements identifiers are strongly differing from each other as different numbering
schemes have been used. In order to have a unified numbering scheme in this document, it was
decided to adopt a new scheme as will be detailed below. In order to have a clean final requirement
structure, the original requirements were set to status “deleted” in Appendix B with the delete reason
“change of identifier (now REQ-11.01.03-TS-*******+)*  An jdentical requirement has then instead
been added to Chapter 3 with the identifier. In some cases, a slight rewording of the requirements has
been performed in this process in order to have a harmonized requirement formulation for different
topics. In that cases the deletion reason “change of identifier (now REQ-11.01.03-TS-**** ****) [
wording harmonized” has been given in Appendix B.

The status of a requirement has been set to “validated” only if V3 maturity was reached in an exercise
from WP11.1 point of view. Otherwise, the status of a requirement remains “in progress”.
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The field validation method of a requirement was completed the following way: If the requirement has
been successfully validated, then the validation method used for the V3 exercise is used. If a
requirement is still “in progress”, then the validation method has been added that is expected to be
used for achieving V3 maturity.

All “REQ Trace” tables of the requirement have been completed with information from affected
Functional blocks and Enablers as well as Operational Focus Areas. As this Technical Specification
has been produced in parallel to the WP11.01 Step 1 and Step 2 (as available) OSED [29] and before
a mature draft of the WP11.01 Step 1 and Step 2 (as available) INTEROP [30] was available, the
requirements were traced to the OSED instead of the INTEROP.

Requirements are numbered according to the following template:

REQ-11.01.03-TS-nnoo.pqqq
Where:
1. ‘nn’ identifies the SESAR Step.

Table 1 gives an overview in regard to this 2 digit nn code.

nn SESAR Step

S1 SESAR Step 1
S2 SESAR Step 2
S3 SESAR Step 3

Table 1: Requirement identifier - SESAR Step allocation

2. '00’ identifies the source document of the requirement.

Table 2 shows a list of all source documents together with their oo identifier.

00 Source Document

TS Step 1 Use Cases and System requirements for FOC|
system [7]

BT BMT (FOC) Step 2 Technical Specification [18]

EF EFPL - EFPL (FOC) Step 1 Technical Specification
[21]

FR FR (FOC) Step 1 Technical Specification [22]

AF AFUA (FOC) Step 1 Technical Specification [23]

ST TS Stepl and Step 2 as available for FOC system
Sabre [25]

HT TS Stepl and Step 2 as available for FOC system
Honeywell [26]

NR New requirement defined in this TS document

Table 2: Requirement identifier — Source document
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3. ‘p’ identifies the functional block that shall be described by the used requirements.
Furthermore these digits refer to requirements that are non-functional as performance
and safety requirements.

Table 3 provides the mapping of the value of p to the Functional Block.

p Functional Block

1 Flight Management

2 Operations Management

3 Decision Support Management
4 Data Management

5 Communication Management
6 Flight Deck Management

Table 3: Requirement identifier — Functional Block allocation

4. ‘qqq’ is a uniqgue number identifying the single requirements. This numbering is started
individually for each ‘nnoo.p***' combination. The counting interval is 5 (five).

1.6 Functional block Purpose

In order to have one comprehensive document (and in line with previous WP11.1 Technical
Specifications), we decided on not producing one Technical Specification per Functional Block but to
write one TS document including all Functional Blocks of the FOC operation. This way it is easier to
show dependencies and interactions. Furthermore, this document can serve as a single general
reference, summarizing all FOC requirements arising from SESAR1 based on the complete work
experience from WP11.1.

Compared to the previous version of this document [7], a new set of functional blocks has been used
that was first introduced in the SESAR2020 transition edition of the ADD [9]. In there, the FOC
operation has been divided into the following new functional blocks, which cover specific areas of
activity:

Flight Management
Operations Management
Decision Support Management
Data Management

e Communication Management
e Flight Deck Management

The functional blocks are highly dependent on each other and their interaction is not only necessary
but a precondition to achieve a safe and smooth flight operation. Taken together, they reflect the
entire FOC system.

To facilitate in getting an overview of how the functional blocks are involved in the procedural and
technical process and how they interact, the functional blocks will be further decomposed into
functions (as outlined in chapter 2.6.1 and 2.6.2).

The following sections will provide you with information about each functional block involved in the
Business Trajectory Management, viewed from the FOC system point of view.
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1.7 Functional block Overview

1.7.1 Flight Management

Flight Management covers all activities within the FOC system that deal with a particular flight. The
activities are executed in the short-term planning and the execution phases of the flight. There are
three main functions in this Functional Block. First, Flight and Trajectory Planning, that groups all
functionalities that are related to the generation and exchange of the flight and trajectory data.
Second, Flight monitoring, monitors both, the data domains considered during the generation of the
trajectory and the trajectory adherence throughout the execution of the flight. Third, the Flight Deck
Support, supporting the flight crew in all phases of flight. The main users of the functions within this
Functional Block are in the flight dispatch department of the AU.

1.7.2 Operations Management

Operations Management covers all activities within the FOC system that deal with the whole set of
flights operated by the AU. The activities cover the medium- and short-term planning as well as the
execution phases of the flights. The three main functions are Flight Schedule Management
(supporting the medium- and short-term planning of the flight leg sequence), Operations Control
(focussing on ensuring legal compliance and safe conduct of the flight operations during the
management of the flight leg sequence on the day of operations, also included is UDPP), and
Workload Management of all users of the FOC system (includes for instance capabilities for task
assignment, workload monitoring, and support for workload balancing). The main users of the
functions within this Functional Block are in the operations control department of the AU.

1.7.3 Decision Support Management

This Functional Block supports the users of the FOC in the decision making process. The two main
functions are the CDM support and the impact assessment. The CDM support is responsible for
supporting CDM processes, both external (between other ATM actors and the FOC) and internal
(between different users and functions of the FOC). The impact assessment supports what-if
functionalities, providing means to analyse which part of the operation and to what extent it is
affected. The users of these functions are either users of the other Functional Blocks of the FOC or
specialised staff trained for the handling of complex situations.

1.7.4 Data Management

Data Management contains the functions for the retrieval, processing, and storage of all data required
in the other Functional Blocks. This includes data provided by AIS or weather providers as well as
internal AU’s data. Moreover functions are provided to access the data as well as functions that allow
a notification of human and system users about new, changed, or deleted data. The main users of the
functions within this Functional Block work in the AU’s back office department. But all users within the
FOC might use functions of this Functional Block to access the processed data.

1.7.5 Communication Management

Communication Management provides the technical means for the communication with the flight crew
and the aircraft, with the other ATM actors, and with other external data and service providers.
Moreover it provides the means for the communication if the FOC acts as data or service provider.
The main functions are Ground/Ground (G/G) communications, Air/Ground (A/G) Communication and
SWIM TI, the SWIM-related technical infrastructure. The FOC system can have the capability to keep
the electronic content of the portable devices of the flight crews (used instead of paper-based flight
bags) updated. The provided technical means are used by the other Functional Blocks when needed
during the realization of their functions. The main users are technical officers responsible for
management and operation of the technical means.
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1.7.6 Flight Deck Management

Flight Deck Management covers all activities executed by the flight deck crew during the preparation,
execution, and wrap-up of a particular flight. These activities belong to the tasks that the flight deck
crew has to conduct by order of the Airspace User. They complement the activities of the flight deck
crew related to the control of the aircraft.

1.8 Glossary of terms
All terms have been defined in either one of the source documents [18][21][22][23][24][25][26][27] or

one of the documents referenced therein. Furthermore, the WP11.1 OSED [29] can be used as a
reference.

1.9 Acronyms and Terminology

Term Definition
4D Four Dimensional
4DT Four Dimensional Trajectory
AIG Air-Ground
A/C Aircraft
AA2A ATC Area to Avoid
ACARS Airline Communication and Reporting System
A-CDM Airport Collaborative Decision Making
ACK Acknowledgement message
ADD Architecture Definition Document
ADEP Aerodrome of Departure
ADES Aerodrome of Destination
AFUA Advanced Flexible Use of Airspace
AIBT Actual In Block Time
AIM Aeronautical Information Management
AIP Aeronautical Information Publication
AIREP Aircraft Report
AIS Aeronautical Information Services
AIXM Aeronautical Information Exchange Model
ALDT Actual Landing Time
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Term

Definition

AMAN Arrival Manager

AMDAR Aircraft Meteorological Data Relay
ANSP Air Navigation Service Provider

AO Aircraft Operators

AOBT Actual Off Block Time

AP/ APT Airport

APOC Airport Operations Centre

ARES Airspace Reservation/Restriction
ARINC Aeronautical Radio Incorporated

ARO Aerodrome Reporting Office (ICAO acronym)
ASM Airspace Management

ATCO Air Traffic Controller

ATC Air Traffic Control

ATFCM Air Traffic Flow & Capacity Management
ATFM Air Traffic Flow Management

ATIS Automatic Terminal Information Service
ATM Air Traffic Management

ATMS Air Traffic Management System

ATOT Actual Take Off Time

ATSU Air Traffic Services Unit

AU Airspace User

AUP Airspace Use Plan

BGA Business and General Aviation
BIRDTAM Bird Notice to Airmen

BMT Business/Mission Trajectory

B2B Business to Business (B2B)

BT Business Trajectory
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Term Definition
CCs Capacity Constraint Scenario
CDM Collaborative Decision Making
CHG FPL Change message
Cl Confidence Index
COTS Commercial-off-the-shelf
CPDLC Controller-Pilot Data Link Communications
CTA Controlled Time of Arrival
CTO Controlled Time Over
CTOT Calculated Take-off Time
D-ATIS Digital Air Traffic Information Service
DCB Demand Capacity Balancing
D-NOTAM Digital NOTAM
D-MET Digital Meteorological Information
D-METAR Digital METAR
D-TAF Digital TAF
DCT Direct
DMA Dynamic Mobile Area
D-MET Digital Meteorological Information
D-NOTAM Digital NOTAM
DOC Direct Operating Cost
DOD Detailed Operational Description
DOF Day of Flight
DRA Direct Routing Airspace
D-VOLMET Digital Meteorological Information for Aircraft in Flight
E-ATMS European Air Traffic Management System
EAUP European Airspace Use Plan
ECAC European Civil Aviation Conference
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Term Definition
ECHG Modification message of the Extended FPL
ECNL Extended CNL (Cancel) message
EDLA Extended DLA (Delay) message
EFB Electronic Flight Bag
EFPL Extended Flight Plan
EFPM Extended Flight Plan Message
EIBT Estimated In Block Time
EID Electronic Information Device
ENB Enabler
EOBT Estimated off-block time
ERNIP European Route Network Improvement Plan
ETA Estimated Time of Arrival
EUROCAE European Organisation for Civil Aviation Equipment
EUUP European Updated Airspace Use Plan
FAA Federal Aviation Authority
FAB Functional Airspace Block
FB Functional Block
FC Flight Crew
FCT Function
FDA Fleet Delay Apportionment
FF-ICE Flight and Flow Information in a Collaborative Environment
FIBT Forecasted In Block Time
FIXM Flight Information eXchange Model
FIXM 4D FIXM 4D Flight Plan Message
FL Flight Level
FMS Flight Management System
FOBT Forecasted Off Block Time
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Term Definition
FOC Flight Operations Centre
FOC-FM Functional Block FOC Flight Management
FOC-OM Functional Block FOC Operations Management
FOC-DSM Functional Block FOC Decision Support Management
FOC-DM Functional Block FOC Data Management
FOC-CM Functional Block FOC Communication Management
FOC-FDM Functional Block FOC Flight Deck Management
FPL Flight Plan
FSPD Flight Specific Performance Data
GAMET General Aviation Meteorological Information
GAT General Aviation Traffic
GUFI Global Unique Flight Identifier
HSPT HOT SPOT
IBT In-Block Time
ICAO International Civil Aviation Organization
ICAO FIXM ICAO flight plan in FIXM format
ICAO FPL ICAO flight plan
ICAO XML ICAO flight plan in Eurocontrol XML format
ICAO TXT ICAO flight plan in text format
ID Identifier
IEI Imbedded Element Identifier
IER Information Exchange Requirements
IFPS Initial Flight Plan Processing System
INTEROP Interoperability Requirements
iRBT Initial Reference Business Trajectory
IRS Interface Requirements Specification
iSBT Initial Shared Business Trajectory
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Term Definition
ISRM Information Service Reference Model
ITCZ Intertropical Convergence Zone
i4D Initial 4D trajectory
KPA Key Performance Area
KPI Key Performance Indicator
Lat Latitude
LOA Letter of Agreement
Long Longitude
LROPS Long Range Operations
MCDU Multifunction Control Display Unit
MEL/CDL Minimum Equipment List / Configuration Deviation List
METAR Meteorological Aviation Routine Weather Report
NM Network Manager
NMF Network Manager Function
NMOC Network Manager Operations Centre
NOP Network Operations Plan
NOTAM Notice to Airman
NPR Nominal Preferred Route
OBJ Objective
OBT Off Block Time
oC Operating Credit
OEM Original Equipment Manufacturer
OFA Operational Focus Area
OFP Operational Flight Plan
ol In the context of this TS: Operating Index
oIS On Board Information Service
OR Operational Requirements
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Term Definition
OSED Operational Service and Environment Definition
PANS Procedures of Air Navigation Services
PANS-ATM Procedures of Air Navigation Services — Air Traffic Management
PCS Process
PDS Pre-Departure Sequence
PIB Pre-flight Information Bulletin
PIBT Published In Block Time
POBT Published Off Block Time
PTR Profile Tuning Restrictions
PWI Predicted Wind Information Message
RAD Route Availability Document
RBT Reference Business Trajectory
REJ Reject Message
REQPWI Request for Predicted Wind Information Message
RMAN Runways Manager (first Airport process to organise departure)
RNP Required Navigation Performance
RPAS Remotely Piloted Aircraft Systems
RSA Restricted Airspace
RTA Required Time of Arrival
RTS Real Time Simulation
RTSA Real Time Status of Airspace
SARPs Standards and Recommended Practices
SBT Shared Business Trajectory
SCN Scenario
SESAR Single European Sky ATM Research Programme
SESAR Programme The programme which defines the Research and Development activities and
Projects for the SJU.
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Term Definition

SFC Sub-function

SIGMET Significant Meteorological Information

SFP Selective Flight Protection

SFP OC SFP Operating Credit

SFP Ol SFP Operating Index

SIBT Scheduled In Block Time (initial Airline schedule)

SITA Société Internationale de Télécommunication Aéronautique

SJuU SESAR Joint Undertaking (Agency of the European Commission)

SJU Work Programme | The programme which addresses all activities of the SESAR Joint
Undertaking Agency.

SOA Service Oriented Architecture

SOBT Scheduled Off Block Time (initial Airline schedule)
SPECI Special METAR forecast

SPR Safety and Performance Requirements
STAM Short-Term ATFCM Measures

STD Scheduled Time of Departure

SvC Service

SWIM System Wide Information Management
TAD Technical Architecture Description
TAS True Air Speed

TMA Terminal Manoeuvring Area

TOD Top of Descent

TR Technical Requirements

TS Technical Specification

TSAT Target Start-up Approval Time

TT Target Time

TTA Target Time of Arrival
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Term Definition
TTO Target Time Over
TTOT Target Take-off Time
T™W Target Window
TXT Text
UDPP User Driven Prioritisation Process
UIBT User In Block Time (prioritisation given by User)
UOBT User Off Block Time (prioritisation given by User)
UuP Updated Airspace Use Plan
VALP Validation Plan
VALR Validation Report
VPA Variable Profile Area
WOC Wing Operations Centre
WP Work Package
WSA Weather
WX Weather
WXXM Weather Information Exchange Model
XML Extensible Markup Language

433
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2 General Functional block Description

2.1 Context

The Airspace Users Operations consists of two Operational Nodes,

e the Airspace User Ops Support, and

o the Flight Deck.

These Operational Nodes interact with the Operational Nodes of the other ATM actors. Figure 2 gives
an overview of all Operational Nodes that have been defined in the context of the SESAR
programme.

Network Operations

ATS Operations Airspace Airspace
Organisation Management

Aerodrome En-Route/ Node Node
ATS Approach
ATS

Node Node

Traffic Flow
and Capacity
Management

Airspace Users Operations Node

Airport Operations

Airport Ops Airport
Support Vihicle

Node Node
Meteorological
Service
Provider

Node

Figure 2: Operational Nodes overview

The two Operational Nodes of the Airspace Users Operations are supported by the Civil AU
Operations Centre capability configuration. The Civil AU Operations Centre includes seven systems
that support the airspace user to perform its operations. The seven systems are

e Civil AU Crew Operations Centre,
e Civil AU Flight Operations Centre,
e Civil AU Business Operations Centre,

e Civil AU Passenger Operations Centre,
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e Civil AU Cargo Operations Centre,

e Civil AU Aircraft Operations Centre, and

e Civil AU Airport Operations Centre.

Further information about this structure can be found in the ADD SESAR 2020 Transition edition [9].

This Technical Specification focuses on the Civil AU Flight Operations Centre. In the remaining
document Civil AU Flight Operations Centre will be referred to as Flight Operations Centre or its
acronym FOC. Figure 3 gives an overview of the civil Airspace Users Operations, its nhodes, capability
configuration and supporting systems.

Airspace Users Operations

Civil AU Operations Centre

Civil AU Crew : € Civil AU Civil AU Civil AU Cargo Civil AU Civil AU
Operations - Op 5* Business Passangers Operations Aircraft Airport
LR Operations Operations Operations Operations

System = 8 € System System System System System

Capability Configuration

Figure 3: Overview Civil Airspace Users Operations

The Flight Operations Centre (FOC) system supports the operations of Airspace Users, performing
manned or unmanned flight operations of civil aircraft.

The FOC Technical System represents the ‘Flight Operations’ domain as part of the whole operations
of the airspace user. The domain ‘Flight Operations’ covers all activities that deal with the flights that
are operated by the Airspace User. These activities refer to the medium- and short-term planning and
the execution phases of the flights.

2.2 Functional block Modes and States

This section is not applicable to the FOC.

2.3 Major Functional block Capabilities

This chapter gives an overview of the grouping of requirements in accordance with the architecture
and structure of the FOC. The structure of requirements is based on the functional block structure
defined for the flight operations centre.
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Civil AU Flight Operations Centre

Figure 4: Structure of the FOC

Figure 4 gives an overview of the structure of the FOC and lists all specific functional blocks. This
structure has been chosen to support system engineers and developers to assess the need to
address changes in capabilities in the single components of the FOC.

2.4 User Characteristics

Table 4 lists all relevant user roles that relate to the Flight Operations Centre. These roles are in
accordance with the Final FOC Step 1 and Step 2, as available, OSED document [29]. For more
details on the FOC related user roles please consult the referenced document.

493

24/7 access to
8/5 access to
Data editing
Data reading
Data
communication
Data printout
Data base
integration
Different
languages

Flight Dispatcher

Flight Monitoring Officer

Flight Schedule Planner

Flight Schedule Monitoring Officer

Operations Control Officer

Decision Support Officer

Load Controller

Data Maintenance Officer

Technical Supervisor

Table 4: FOC user roles characteristics

2.4.1 System Access Times

System access times describe the time intervals in which a user of the FOC system will access the
system. The system must be build up in a way that supports the respective access times. In the
context of the FOC system two access time types are differentiated.

24/7 Access to system

The user of the FOC (a human being or process, simulating a human being) accesses the system
continually without any interruption of it. That means that the system must be available at 24 hours, 7
days of a week.

8/5 Access to system

launding mambers

Avenue de Cortenbergh 100 | B -1000 Bruxelles
S . Www.sesarju.eu 29 of 145

©SESAR JOINT UNDERTAKING, 2015. Created by Lufthansa Systems, Sabre Airline Solutions, and Honeywell for the
SESAR Joint Undertaking within the frame of the SESAR Programme co-financed by the EU and EUROCONTROL. Reprint
with approval of publisher and the source properly acknowledged



516
517
518
519
520
521

522

523
524
525
526

527

528
529
530

531

532
533

534

535
536
537
538

539
540
541
542
543

544
545

546

547
548
549
550
551
552
553

554
555
556
557
558
559
560

The user of the FOC (most likely a human being) accesses the system only during office times.
Typically this office times are limited to 8 working hours during a week of 5 days. Deviations of these
access times are depending on the organization using the FOC system. Longer or shorter access
times are possible. The main difference between the 24/7 access to system capability and the 8/5
access to system capability is that the 8/5 access to system capability requires not a continuous
access to the system

2.4.2 Flight Operations Management

The data handling capabilities deal with all tasks that are needed to handle data within the FOC
system. These capabilities include entering, changing, reading and deleting. These tasks will be
fulfilled using an HMI (Human Machine Interface). The respective user will directly change the data
manually. The following capabilities are defined for the FOC system users.

Data edit capability

This capability includes entering and saving data into the FOC data system and changing or deleting
of a stored data set. Users that have this capability are allowed to manipulate data sets available in
the FOC system. This does not include the change of any system configuration.

Data read right

This capability includes the select of data stored in the FOC system. The data is typically displayed on
a monitor. The data read capability is a subset of the data edit capability.

2.4.3 Data Distribution

The data distribution capability is granting the user of an FOC system access to data communication
functionalities using AFTN, SITA, ACARS, e-mail or other means of communication interfaces.
Furthermore this includes the printout of data. The following data distribution capabilities are defined
for FOC system users.

Data communication

This includes sending and receiving data via e.g. AFTN, SITA, ACARS, e-mail, FAX messages.
Data printout

This includes sending data to a printer connected directly with the FOC or via a network.

Data base integration

This capability includes the integration of (external) databases not directly included with the FOC, e.qg.
an aircraft configuration database.

2.4.4 Human Machine Interface

Depending on the airline using the FOC different individual designs for the HMI will be implemented.
In general we can differentiate between FOC system operation that is based on a high degree of
automation with almost no interaction of human operators and those FOC operation that are based on
manual interaction of a human operator. Such FOC setups should not be confused with the possibility
to request — for example — trajectory options from outside of the AU organization. Such options might
be implemented as part of a service. The AU operating the FOC system will be able to enable and
disable services that are provided to 3" parties in this context.

It would break the scope of this document to describe all possible kinds of different HMI designs. For
that reason the respective selectors are only named.

To keep it simple only a very limited set of actions will be defined that can be used for FOC systems
with a high degree of automation as well as for FOC systems that are based on human operator
interaction only and for all degrees of automation in FOC systems between these both extremes.

The following table lists the main actions that will be available in an FOC system.
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Action Description

Trigger Trigger is the action that will directly start a process within the
FOC system. An example is the trigger that starts the filing
process of a flight plan to the ATC unit. The action trigger will
be available for the HMI (for direct interaction of a human
operator) and for the system automation domain.

If applicable in any requirement a Trigger will be defined.

Select Select defines whether a defined action shall be triggered or
which action shall be triggered in case that an action is
optional or several options are available for an action.

An example is the attachment of so-called Flight Performance
Data into the Extended Flight Plan. As this is optional data the
FOC operator will select whether this data set will be attached

or even not.
Whenever applicable in any requirement a Selector will be
defined.

Return Return will be used in case that any data or information (from

the FOC system) must be acknowledged by a human
operator. The term return can — in this case — be taken as a
synonym for actions like display (on a screen) or print-out (on
a printer). As the last terms are more related to individual FOC
system design, they will be substituted by the term return.

Table 5: Process Word List of the FOC HMI
HMI Language

As FOC systems are used worldwide, user from different countries will have access to the system.
Therefore it must be considered that users with different languages and different degree of English
speaking capabilities are using the FOC system.

2.5 Operational Scenarios

The operational scenarios used as basis for this document can be found in chapter 5 of the Final FOC
Step 1 and Step 2, as available, OSED document [29].

2.6 Functional

2.6.1 Functional decomposition

The Flight Operations Centre supports Airspace Users, performing ICAO compliant manned or
unmanned flight operations, in the management of the operations of those flights. It consists of six
Functional Blocks that group the functions that are required to perform the flight operations. In some
cases the functions are separated into sub-functions (<SFC>)°. Figure 5 gives an overview of the
functional break down of the flight operations centre. The following sub sections give descriptions of
the respective elements.

® The grouping into function and sub-function only addresses sub-functions that relate to the concepts
discussed within the SESAR programme. Other sub-functions are not mentioned here as they are not
affected by the SESAR programme.
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Civil AU Flight Operations Centre

<FCT> Flight
Schedule =FCT> CDM Support
Management

<SFC> Schedule
<FCT> Flight Planning <FCT> Impact
Monitoring Assessment

<8FC> Schedule

<FCT> Data <FCT>GIG

Processing and A <FCT> Fuel Order
5 4 Communication
Notification

<FCT> Flight and
Trajectory Planning

<ECT> AIG <FCT= Aircraft

<FCT=> Data Access £ ommbnicaton Performance
Calculation

<SFC> Data Manitorin
Monitoring ' g <FCT> Data <FCT> Navigation
<FCT=>SWIM TI
Compilation Log Recording
<3F:d>h;r:.:31&:emry <FCT> Operations
monitoring Lo <FCT> Flight Wrap

<SFC> UDPP
<FCT> Flight Deck
Support

= <SFC> Operations
<SFC> Briefing Control

<SFC> Dynamic <FCT=> FOC user
Data Provision workload
management

Figure 5: Function breakdown of the Flight Operations Centre

2.6.1.1 Flight Management (FOC-FM)

The functional block flight management refers to all activities that relate to an individual flight. This
includes in particular the

e Flight and trajectory planning,
¢ Flight monitoring, and

e Flight deck support.

2.6.1.1.1 Flight and Trajectory Planning

The flight and trajectory planning includes the generation and exchange of trajectory data. This also
includes the iterative planning of trajectories in the context of the SBT planning. Besides this the
management of the RBT, including agreement dissemination and RBT revision is facilitated by the
flight and trajectory planning. All these capabilities are not only limited to the pre-departure planning
phase but also refer to the flight execution phase where the FOC can be used to support the flight
crews and ATM stakeholders.

All these activities are based on a wide range of information that are properties or boundary
conditions of the flight and have to be considered by the airspace user to allow efficient and cost
optimal flight operations. This also includes activities like airport suitability check, flight cost and fuel
amount evaluation, trajectory optimization, provision of information used for the flight crew briefing
etc.

2.6.1.1.2 Flight Monitoring
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The flight monitoring relates to the on-going process of monitoring all data that is in relation to the
flight as well as the trajectory flown by the aircraft and to compare this with all data used for planning
and the trajectory that has been planned (e.g. RBT as soon as available). Hence the flight monitoring
can be separated into two aspects:

e Data monitoring, and

e Trajectory adherence monitoring.

2.6.1.1.2.1 Data monitoring

The data monitoring assesses the impact of any change of the boundary conditions of the flight onto
the business trajectory. This includes an analysis whether any data change leads to an inability to fly
the trajectory, respectively whether any data change might allow a more optimal trajectory to be
planned. This monitoring starts with generation of the first trajectory that is used as SBT and can
continue during the flight execution when the RBT has been agreed.

2.6.1.1.2.2 Trajectory adherence monitoring

The trajectory adherence monitoring relates to the comparison of the aircraft position and future path
of the aircraft trajectory with the agreed reference trajectory, the RBT. This monitoring will be based
on aircraft position data derived from the aircraft directly or from any surveillance system and besides
that on trajectory predictions that estimate the path of future positions of the aircraft. This monitoring
can be performed throughout the whole execution phase and is especially relevant for medium- and
long-haul flights.

2.6.1.1.3 Flight Deck Support

This function supports the flight crew through the corresponding phases of the flight, when an
involvement of the flight crew is required. The main purpose of this function is to keep the flight crew
up to date with regard to the planned flight as well as with regard to the data that might impact their
flight. Hence this function includes the two sub-functions:

e Briefing, and

e Dynamic Data Provision.

2.6.1.1.3.1 Briefing

This includes the initial provision of the operational flight plan that includes all relevant information that
is required by the flight crew to safely and efficiently commend the planned flight. Initially the briefing
is performed in the short-term planning phase. But the point of time when this briefing is performed
might differ from AU to AU, as well as from flight to flight*.

Besides that the briefing might be performed throughout the whole lifecycle of the flight, if significant
changes to the operational flight plan have been done. An example could be a change of the planned
trajectory due to an RBT revision. Such dynamic update of the operational flight plan could happen
throughout the whole phase from initial briefing till the arrival at the airport of destination.

2.6.1.1.3.2 Dynamic Data Provision

The Flight Operations Centre provides permanently information to the flight crew that is relevant for
the flight and increases their situational awareness. The dynamic data provision may start directly

* The briefing for a long-haul flight might be performed several hours before departure while on short-
haul flights the briefing might be performed very close to the departure time.
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after the briefing of the flight crew and will be perform until the arrival of the aircraft at its final parking
position.

2.6.1.2 Operations Management (FOC-OM)

The functional block operations management relates to all activities that refer to the whole set of the
flights operated by the AU. This refers especially to the schedule of flights including their
interdependencies to each other flight. It takes care about the achievement of optimal overall flight
operations efficiency. That means that every single flight is considered as single element of the whole
flight operation that is in focus. Besides that it manages the workload of the FOC user to ensure that
overloads are avoided and flight operation is supported in an efficient way. The operations
management is separated into two main functions that are

e Flight schedule management,
e Operations control, and
e FOC User Workload Management.

The activities supported by the operations management cover a time period that lasts from the
medium-term planning phase until the end of the flight execution.

2.6.1.2.1 Flight schedule management

The flight schedule management is grouped into different functions that relate to the planning of the
sequence of flights that is intended to be executed. This also includes the provision of flight intent
data in the context of the SBT planning. The schedule planning is based on the route network that has
been provided route network management in the business operations centre. Such route network
describes all intended flights in the form of a seasonal schedule that only includes intended airport
connections that shall regularly be flown. Based on this data the schedule management creates the
daily flight schedule and monitors its development over time throughout the medium- and short-term
planning. This includes two main aspects that are:

e Schedule planning, and

e Schedule monitoring.

2.6.1.2.1.1 Schedule planning

The schedule planning relates to the planning of the flight leg sequence in the scope of the aircraft
fleet that is operated by the airspace user. The result is the daily flight schedule of intended flights as
they will be operated under static conditions.

2.6.1.2.1.2 Schedule monitoring

The schedule monitoring covers all activities that relate to the supervision of aspects that might
impact the flight sequence in the flight schedule. That also relates to the analysis of the cascading
effects of flight delays on other flights. This includes the interdependencies of flights operated with the
same aircraft, as well as interdependencies of flights that are linked due to passenger/ cargo transfer
etc.

2.6.1.2.2 Operations control

The operations control has the focus to ensure smooth and efficient flight operations on the day of
operations with the focus on managing the flight leg sequence. This function is based on the flight
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schedule provided by the schedule management but also establishes the link to other systems that
provide information that relate to the individual flights in the flight sequence list. Besides the system
link this function is tightly connected to the flight planning functions as both functions have strong
dependencies onto each other. While the flight schedule will be optimized to reduce costs caused by
delays and other deviations from the flight schedule, the flight planning is focussing on an optimal
flight operation of a single flight event. Both aspects are competing in some cases to each other as
recovering a flight schedule to avoid delay costs might require to fly faster; and consequently with a
less optimal cost index, what might decrease the flight cost efficiency for a single flight. The will be on
the achievement of a good trade-off between flight cost efficiency and overall flight operations
efficiency.

The operations control function includes two main aspects:
e User Driven Prioritization Process,

e Operations Control.

2.6.1.2.2.1 User Driven Prioritization Process (UDPP)

UDPP is used to handle when one or more flights are not conducted anymore according their original
schedule or when events appear that might influence the flight leg sequence. Such situations might
be a consequence of reduced capacities at an airport in any ATC sector that requires delaying certain
flights. UDPP can help to reduce deviations from the planned schedule by influencing the applied slot
times and 4D constraints. This can help bring the flight closer to the original schedule or might
influence the sequence of flights positively. This also includes the monitoring of constraint situations
and to identify risks and opportunities with regard to the fleet prioritization.

2.6.1.2.2.2 Operations Control

The function Operations Control needs to deal with situations when UDPP options have been
identified by the separate UDPP functionality that monitors the constraints situations at the airports or
concerning the network. The UDPP options need to be evaluated if the possible benefit can be
achieved and if this is the case consecutively the UDPP options need to be applied to the operations
of the Airspace User.

2.6.1.2.3 FOC User Workload Management

The FOC User Workload management is used to assess the workload and work list of every user of
the FOC with the target to balance the workload of every FOC user and to avoid work overloads and
delays with regard to the tasks that are required to manage the flight operations of the Airspace User.
This includes the task assignment, workload monitoring, and workload balancing support.

2.6.1.3 Decision Support Management (FOC-DSM)

The functional block decision support management is a kind of superordinate function that supports
the airspace user in all coordination and decision making processes within the airspace user
organization and with other ATM actors. It focuses on the management of complex situation that
require the involvement of several different parties and the coordination of collaborative decision
making. In particular this includes two main functions that are

e CDM support, and

e Impact assessment.

2.6.1.3.1 CDM support
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CDM Support - supports the external and internal CDM processes. The external CDM processes refer
to the collaboration with other ATM actors either triggered by them or by the FOC. The internal CDM
processes refer to the collaboration between the different users and functions of the FOC. Both types
of CDM processes are connected because external CDM processes require typically the support by
internal CDM processes.

One supported CDM process is related to UDPP. User Driven Prioritisation Process (UDPP) is a
collaborative AU Driven Process that gives the Airspace Users a role in the Demand Capacity
Balancing (DCB). The actors in this process include Airport Operations Centres, the Network
Manager, and the participating Airspace Users.

2.6.1.3.2 Impact Assessment

Impact Assessment - supports what-if functionalities. It provides means for the analysis which part of
the operation is affected by an event and how much. Furthermore it collects the information about the
impact from the different functions of the FOC allowing an evaluation of the overall impact of the
event. Such events can refer for instance to the possible usage of opportunities (e.g. released
restricted airspace). The FOC impact assessment is also executed when another ATM actor involves
the FOC in its impact assessment (e.g. NM).

The impact assessment is furthermore applied to the analysis of UDPP options covering operational
as well as commercial aspects. An UDPP option affects always a list of flights in which one or more
flights shall be preferred and one or more flights shall be penalised compared to the initial situation.
As a consequence of this the impact of the UDPP option to each single flight needs to be evaluated
as well as its overall impact to the Airspace User. During this internal impact assessment the result of
the impact assessment is taken into consideration that is executed by the other actors participating in
the process.

2.6.1.4 Data Management (FOC-DM)

The data management is a foundation pillar of flight operations. This is due to the fact that the timely
and correct provision of data is a key for safe, orderly and efficient flight operations. This functional
block includes functions used for the retrieval, processing and storage of the data that is used by all
other FOC functional blocks. Besides these functions a further focus is on the validation and
qualification of retrieved data. This is especially important for data that is retrieved from electronic
sources, as this data shall be — as much as possible — processed in an automatic way. The data
management takes care about many different data domains as:

e Aeronautical data,

e Constraint data,

e Meteorological data,

e Terrain and obstacle data,

e Aircraft data, and

e Airspace User data.
In particular this includes three main functions that are

e Data processing and notification,

e Data access, and
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e Data compilation.

2.6.1.4.1 Data Processing and Notification

The data processing and notification function includes retrieval, processing, and storing of data for the
activities covered by the FOC. This also includes the tracking of changes in specific sets of data and
the notification of human and system users about new, changed, and deleted data.

2.6.1.4.2 Data Access

This function allows human and system user to access data that is available in the FOC, to add,
change, or delete such data.

2.6.1.4.3 Data Compilation

The purpose of this function is the generation of data, based on data that has been recorded, stored
or entered during the lifecycle of a flight, with the purpose to provide analytical data relating to the
activities performed in the context of flight operations centre. This includes all data within the FOC
from the flight planning phases as well as from the flight execution phase. This function especially
compiles FOC related data that will be used for post flight analysis.

2.6.1.5 Communication Management (FOC-CM)

The functional block communication management includes all technical resources that are required to
establish the information exchange between the FOC with the flight crew and the aircraft, the other
ATM actors and with other external data providers. This communication will be established in a bi-
directional way allowing the FOC to act as data receptor as well as data or service provider. All other
functional blocks of the FOC will draw from the functions of this functional block to fulfil their
communication needs. This functional block includes three main functions that are:

e G/G communication,
e A/G communication, and

e SWIMTL

2.6.1.5.1 G/G communication

The G/G communication includes all means of communication between the FOC and other ATM
actors and other external data and service providers. Besides that the communication with the flight
crew — if outside of the aircraft — is also included. This includes for example the communication with
the briefing application used by the flights crews.

2.6.1.5.2 A/G communication

The A/G communication includes the communications between the FOC and the flight crew,
respectively the flight deck. This relates mainly to all communication during the flight execution. This
communication channel can be used to provide the flight crews with updated data (e.g. trajectory, or
weather) and can allow to the establishment of an on-going flight crew decision support throughout
the whole execution of a flight. The other way around the aircraft might provide information to the
FOC (e.g. aircraft position) that can be used for the trajectory monitoring.

2.6.1.5.3 SWIM TI
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This functions provides the technical infrastructure that is required to embed the FOC as a node into
the overall SWIM infrastructure. This will enable an efficient and seamless communication with all
ATM actors in real-time and will allow the consumption and provision of technical services from and to
other ATM actors.

2.6.1.6 Flight Deck management (FOC-FDM)

The functional block flight deck management relates to the provision of functions that are used by the
flight crews while preparing, executing and wrapping up a particular flight. These activities
complement the activities of the flight deck crew that relate to controlling the aircraft and have to be
conducted by order of the airspace user as holder of the aircraft operator certification. This functional
block supports the following activities:

e Fuel order,
e Aircraft performance calculation,
¢ Navigation log recording, and

e Flight wrap-up.

2.6.1.6.1 Fuel order

This activity gives the flight crew overview about the calculated fuel amounts that are required to
execute the flight including trip fuel, alternate fuel, holding fuel, contingency fuel, final reserve fuel and
additional fuel. The flight crew will be enabled to influence the fuel amount by adding an additional
margin of fuel to the overall amount of fuel. Based on this the flight crew can directly order the
respective amount of fuel.

2.6.1.6.2 Aircraft performance calculation

This includes the evaluation of the current aircraft performance parameters on the basis of the current
boundary conditions, as meteorological data and aircraft weight. This also includes the calculation of
required runway length like take-off distance required for example. These evaluation activities relate
all flight phases as take-off, climb-out, cruise, approach and landing and consider all relevant aircraft
parameters as well as ambient conditions.

2.6.1.6.3 Navigation log recording

This activity relates to the on-going process to record the flight evolvement. This is especially
important to comprehend differences between flight planning and execution and with that to provide
statistical information that can improve the flight efficiency and safety.

2.6.1.6.4 Flight wrap-up

This activity supports the wrap-up of a flight by compiling of all relevant information that can be used
to evaluate the flight conduction. It relates to the composition of flight reports by the flight crew with
the purpose to feedback to other functions within the FOC.

2.6.2 Functional analysis

This section outlines how the functions of the Functional Blocks of the Flight Operations Centre
system relate either to other functions of the same Functional Block or to functions of other Functional
Blocks of the Flight Operations Centre system.
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833

834

2.6.2.1 Flight Management

Flight and Trajectory Planning

Functional | Function Relation

Block

FOC-FM Flight Monitoring The Flight and Trajectory Planning provides the flight and
trajectory related information that builds the base for the monitoring
of the flights. This applies to the data monitoring as well as to the
trajectory adherence monitoring.

FOC-FM Flight Deck The Flight and Trajectory Planning provides the flight and

Support trajectory related information that builds the base of the information
that is used by the flight crew during the Briefing. Depending on
the trajectory the other briefing information is collected. Also the
Dynamic Data Provision depends on the trajectory concerning the
selection of the provided data.

FOC-OM Operations The Flight and Trajectory Planning provides the flight and

Control trajectory related information supporting the function Operations
Control in the management of the flight leg sequence on the day of
operations.

FOC-DM Data Access The Flight and Trajectory Planning uses the function Data Access
to retrieve all data required for the realisation of its functionality
and that is in the scope of the Functional Block Data Management.

FOC-CM G/IG The function Flight and Trajectory Planning uses the means of the

Communication function G/G Communication to provide external stakeholders with
flight plan information.

FOC-CM SWIM TI The function Flight and Trajectory Planning uses the means of the

function SWIM TI in the case that the external stakeholders offer
SWIM services for the provision of flight plan information.

Flight Monitoring

Functional | Function Relation
Block
FOC-FM Flight and In the case of an event (like affecting data or trajectory deviation)
Trajectory the function Flight Monitoring can request the revision of the
Planning trajectory via the function Flight and Trajectory Planning.
FOC-DSM | CDM Support In the case that the operation of the Airspace User is affected
beyond a particular flight the function Flight Monitoring can use the
function CDM Support to find a solution under consideration of the
needs of all affected internal and external stakeholders.
FOC-DSM | Impact In the case of an event (like affecting data or trajectory deviation)
Assessment the function Flight Monitoring can request the evaluation of the

impact of this event via the function Impact Assessment. The
results of the impact assessment are if a revision of the trajectory
is required or recommended and if the operation of the Airspace
User is affected beyond the particular flight.
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835

836
837

FOC-DM Data Access The Flight Monitoring uses the function Data Access to retrieve all
data required for the realisation of its functionality and that is in the
scope of the Functional Block Data Management.

FOC-CM G/IG The function Flight Monitoring uses the means of the function G/G

Communication Communication in the retrieval of additional data required for the
realisation of its functionality (e.g. aircraft positions).

FOC-CM SWIM TI The function Flight Monitoring uses the means of the function
SWIM TI in the case that SWIM services are available for the
retrieval of additional data required for the realisation of its
functionality (e.g. aircraft positions).

Flight Deck Support

Functional | Function Relation

Block

FOC-DM Data Access The Flight Deck Support uses the function Data Access to retrieve
all data required for the realisation of its functionality and that is in
the scope of the Functional Block Data Management.

FOC-CM G/IG The function Flight Deck Support uses the means of the function

Communication G/G Communication to provide the flight crew with all required data
(briefing and dynamic data) when the flight crew can access
corresponding ground systems.

FOC-CM AIG The function Flight Deck Support uses the means of the function

Communication A/G Communication to provide the flight crew with all required data
(briefing and dynamic data) when the flight crew has access to
aircraft systems only.

FOC-CM SWIM TI The function Flight Deck Support uses the means of the function
SWIM TI in the case that SWIM services are available to provide
the flight crew with all required data (briefing and dynamic data).

2.6.2.2 Operations Management

Flight Schedule Management

Functional | Function Relation
Block
FOC-OM Operations The Flight Schedule Management provides the plan of the flight leg
Control sequence that is the base for the flight leg sequence on the day of
operations to be managed by the function Operations Control.
FOC-DSM | CDM Support In the case that the operation of the Airspace User is affected

beyond a particular flight the function Flight Schedule Management
can use the function CDM Support to find a solution under
consideration of the needs of all affected internal and external
stakeholders.
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838

FOC-DSM | Impact In the case of an event that might influence the future flight leg
Assessment sequence the function Flight Schedule Management can request
the evaluation of the impact of this event via the function Impact
Assessment. The result of the impact assessment is how much the
operation of the Airspace User is affected.

FOC-DM Data Access The Flight Schedule Management uses the function Data Access
to retrieve all data required for the realisation of its functionality
and that is in the scope of the Functional Block Data Management.

FOC-CM G/IG The function Flight Schedule Management uses the means of the

Communication function G/G Communication in the retrieval of additional data
required for the realisation of its functionality that might influence
the future flight leg sequence.

FOC-CM SWIM TI The function Flight Schedule Management uses the means of the
function SWIM Tl in the case that SWIM services are available for
the retrieval of additional data required for the realisation of its
functionality that might influence the future flight leg sequence.

Operations Control

Functional | Function Relation

Block

FOC-FM Flight and The Operations Control provides the information about the flight

Trajectory legs where the function Flight and Trajectory Planning has to
Planning execute the corresponding planning tasks.

FOC-DSM | CDM Support In the case that the operation of the Airspace User is affected
beyond a particular flight the function Operations Control can use
the function CDM Support to find a solution under consideration of
the needs of all affected internal and external stakeholders.

FOC-DSM | Impact In the case of an event (like target time or UDPP information) the

Assessment function Operations Control can request the evaluation of the
impact of this event via the function Impact Assessment. The
results of the impact assessment are if a revision of the trajectory
is required or recommended and if the operation of the Airspace
User is affected beyond the particular flight.

FOC-DM Data Access The Operations Control uses the function Data Access to retrieve
all data required for the realisation of its functionality and that is in
the scope of the Functional Block Data Management.

FOC-CM G/IG The function Operations Control uses the means of the function

Communication G/G Communication in the retrieval of additional data required for
the realisation of its functionality (e.g. target times). Moreover the
function G/G Communication is used in the communication
concerning UDPP with external stakeholders.

FOC-CM SWIM TI The function Operations Control uses the means of the function

SWIM TI in the case that SWIM services are available for the
retrieval of additional data required for the realisation of its
functionality (e.g. target times). Moreover the function SWIM Tl is
used if the external stakeholders offer SWIM services for the
communication concerning UDPP.
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839 2.6.2.3 Decision Support Management

840 CDM Support

Functional | Function Relation
Block
FOC-DM Data Access The CDM Support uses the function Data Access to retrieve all

data required for the realisation of its functionality and that is in the
scope of the Functional Block Data Management.

FOC-CM G/IG The function CDM Support uses the means of the function G/G
Communication Communication in the communication with the external
stakeholders concerning the CDM processes (including UDPP).

FOC-CM AIG The function CDM Support uses the means of the function A/G
Communication Communication in the communication with the flight crew
concerning the CDM processes.

FOC-CM SWIM TI The function CDM Support uses the means of the function SWIM
TI if the external stakeholders offer SWIM services for the
communication concerning the CDM processes (including UDPP).

841 Impact Assessment

Functional | Function Relation
Block
FOC-DM Data Access The Impact Assessment uses the function Data Access to retrieve

all data required for the realisation of its functionality and that is in
the scope of the Functional Block Data Management.

842 2.6.2.4 Data Management

843 Data Processing and Notification

Functional | Function Relation
Block

FOC-FM Flight Monitoring The function Data Processing and Notification notifies the function
Flight Monitoring about changes related to the data required for the
realisation of its functionality and that is in the scope of the
Functional Block Data Management.

FOC-OM Flight Schedule The function Data Processing and Notification notifies the function
Management Flight Schedule Management about changes related to the data
required for the realisation of its functionality and that is in the
scope of the Functional Block Data Management.

FOC-OM Operations The function Data Processing and Notification notifies the function
Control Operations Control about changes related to the data required for
the realisation of its functionality and that is in the scope of the
Functional Block Data Management.
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844

845

FOC-CM G/IG The function Data Processing and Notification uses the means of
Communication the function G/G Communication in the retrieval of all data that are
in the scope of the Functional Block Data Management.

FOC-CM SWIM TI The function Data Processing and Notification uses the means of
the function SWIM Tl in the case that SWIM services are available
for the retrieval of all data that are in the scope of the Functional
Block Data Management.

Data Access

Functional | Function Relation

Block

N/A

Data Compilation

Functional | Function Relation

Block

FOC-FM Flight and The function Data Compilation accesses the data resulting from

Trajectory the activities related to flight and trajectory planning for a particular
Planning flight. The data is compiled with other flight related information into
a package used for instance for data analysis.

FOC-FM Flight Monitoring The function Data Compilation accesses the data resulting from
the activities related to flight monitoring for a particular flight. The
data is compiled with other flight related information into a package
used for instance for data analysis.

FOC-FM Flight Deck The function Data Compilation accesses the data resulting from

Support the activities related to flight deck support for a particular flight. The
data is compiled with other flight related information into a package
used for instance for data analysis.

FOC-OM Flight Schedule The function Data Compilation accesses the data resulting from

Management the activities related to flight schedule management for a particular
flight. The data is compiled with other flight related information into
a package used for instance for data analysis.
FOC-OM Operations The function Data Compilation accesses the data resulting from
Control the activities related to operations control for a particular flight. The
data is compiled with other flight related information into a package
used for instance for data analysis.

FOC-DM CDM Support The function Data Compilation accesses the data resulting from
the activities related to CDM support for a particular flight. The data
is compiled with other flight related information into a package
used for instance for data analysis.

FOC-DM Impact The function Data Compilation accesses the data resulting from

Assessment the activities related to impact assessment for a particular flight.
The data is compiled with other flight related information into a
package used for instance for data analysis.
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850
851

852

853

854

Project Number 11.01.03

Edition 02.00.00

D24 - D24 - D11 1 3-TS - Technical Specification Step 1 and Step 2 for FOC System - Edition

02.00.00

2.6.2.5 Communication Management

G/G Communication

Functional | Function
Block

Relation

N/A

A/G Communication

Functional | Function
Block

Relation

N/A

SWIM TI

Functional | Function
Block

Relation

N/A

2.6.2.6 Flight Deck Management

Fuel order

Functional | Function
Block

Relation

FOC-FM Flight Monitoring

The function Fuel order provides the function Flight Monitoring with
the information about the amount of fuel that has been ordered by
the flight crew.

Aircraft performance calculatio

Functional | Function
Block

Relation

FOC-DM Data Access

The function Aircraft performance calculation uses the function
Data Access to retrieve all data required for the realisation of its
functionality and that is in the scope of the Functional Block Data
Management.

Navigation log recording

Functional | Function
Block

Relation

FOC-FDM | Flight wrap-up

The function Navigation log recording provides the function Flight
wrap-up with the recorded navigation log information for compiling
of all relevant information.

Flight wrap-up

foaunding mambers
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855

856
857

858
859
860

Functional | Function Relation
Block
FOC-DM Data Compilation | The function Flight wrap-up provides the function Data Compilation

with all relevant information about the executed flight for the
compilation with all other flight-related information.

2.7 Service View

The Flight Operations Centre system currently does not provide any service to other systems outside

the Civil AU Operations Centre.

The description of the services is pending that realise the relation between the Functional Blocks of
the Flight Operations Centre system or to the Functional Blocks of other systems of the Civil AU
Operations Centre.
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861
862

863
864
865
866

867

868
869

870
871

872
873

874
875

Project Number 11.01.03 Edition 02.00.00
D24 - D24 - D11 1 3-TS - Technical Specification Step 1 and Step 2 for FOC System - Edition
02.00.00

3 Functional block Functional and non-Functional
Requirements

As mentioned already in Section 1.3, please note that the requirements from the WUF (Weather
Uplink FMS) TS [24] are not included in this document as Honeywell has agreed with SJU that no
further deliverables are required, therefore, the WUF TS is considered by Honeywell as not being a
subject of the overall common TS consolidation.

3.1 Capabilities

3.1.1 Flight Management

[REQ]

Identifier

REQ-11.01.03-TS-S1TS.1005

Requirement

The FOC shall generate flight trajectory data according to all PTR when
selected by the PTR selector.

Title PTR in trajectory generation

Status <In Progress>

Rationale The PTRs will be published by the NM manager to improve the trip fuel
generation in the FOC system. PTRs can be considered directly, by
adapting the generated vertical profile or indirectly by considering additional
fuel amount and not adapting the vertical profile. PTRs must not be
mandatorily considered in trajectory generation. If an FOC includes the PTR
functionality, it shall be possible to enable or disable it.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0050 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0040 <Partial>
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<ALLOCATED_TO> <Functional block> Flight Management N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S2TS.1005

Requirement

The FOC shall generate flight trajectory according to TTA constraints when
selected by the TTA constraint selector

Title TTA in Trajectory Generation

Status <In Progress>

Rationale The FOC system shall consider TTAs throughout the trajectory generation
process if enabled by the Airspace User.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0060 <Partial>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0070 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<ALLOCATED_TO> <Functional block> Flight Management N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
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876
877

878
879

880
881

882
883

884
885

<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]
Identifier REQ-11.01.03-TS-S2TS.1010

Requirement

The FOC shall generate flight trajectory according to CTA constraints when
selected by the CTA constraint selector.

Title CTA flight calculation

Status <In Progress>

Rationale If a flight is affected by a CTA a trajectory calculation will be needed to
consider this new input in the trajectory data. In case of an autonomous
running FOC system this action can be automatically started if selected.

Category <Functional>

Validation Method

<Live Trial><Shadow Mode>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0060 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0070 <Full>
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<ALLOCATED_TO> <Functional block> Flight Management N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S1FR.1005

Requirement

The FOC shall generate flight trajectory data according to the affecting Free
Routing Airspace availability when selected by the Free Route selector.

Title Trajectory generation according to FRA availability

Status <In Progress>

Rationale To make use of the flight planning opportunities that Free Routing offers, the
FOC must be able to plan valid trajectories in FRA by obeying the FRA
availability.

Category <Functional>

Validation Method <Fast Time Simulation><Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0010 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRFP.0105 <Full>
<SATISFIES> <Enabler> AOC-ATM-10 <Full>
<ALLOCATED_TO> <Functional block> Flight Management N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S1NR.1005

Requirement

The FOC shall generate flight trajectory data according to the affecting Free
Routing Airspace flight planning rules when selected by the Free Route
selector.

Title Trajectory generation according to FRA flight planning rules

Status <In Progress>

Rationale To make use of the flight planning opportunities that Free Routing offers, the
FOC must be able to plan valid trajectories in FRA by obeying all existing
flight planning rules in the FRA.

Category <Functional>

Validation Method

<Fast Time Simulation><Real Time Simulation>
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886
887

888
889

890
891

892
893

894
895

| Verification Method

| <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0010 <Partial>

<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRFP.0105 <Full>

<SATISFIES> <Enabler> AOC-ATM-10 <Full>

<ALLOCATED_TO> <Functional block> Flight Management N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

[REQ]

Identifier REQ-11.01.03-TS-S2NR.1005

Requirement The FOC system shall receive and store aircraft position data.

Title Receive Aircraft Position Data

Status <In Progress>

Rationale Aircraft Position Data is needed in order to monitor adherence to the RBT.
Valid sources are for example ADS-B, ADS-C EPP.

Category <Functional>

Validation Method

<Flight Trial><Fast Time Simulation><Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0130 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0140 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0160 <Full>
<SATISFIES> <Enabler> SWIM-APS-05b <Full>
<SATISFIES> <Enabler> FOC-006 <Full>
<SATISFIES> <Enabler> FOC-008 <Full>
<ALLOCATED TO> <Functional block> Flight Management N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S2NR.1010

Requirement

RBT recovery selector.

Upon deviation of the aircraft trajectory from the RBT the FOC system shall
generate a trajectory considering the aircraft position if selected with the

Title Trajectory generation from aircraft position

Status <In Progress>

Rationale If the FOC shall participate in an RBT revision it shall be able to generate a
trajectory from the current aircraft position, regardless whether the aircraft is
on the ground or in the air.

Category <Functional>

Validation Method

<Flight Trial><Fast Time Simulation><Real Time Simulation>

Verification Method

<Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>
<APPLIES_TO>
<APPLIES_TO>
<ALLOCATED_TO>

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0130 <Partial>
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0140 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0160 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0200 <Full>
<Enabler> FOC-006 <Full>
<Enabler> FOC-008 <Full>
<Functional block> Flight Management N/A
<Operational Focus Area> ENB03.01.01 N/A
<Operational Focus Area> OFA03.01.03 N/A
<Project> P11.01.03 N/A
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896
897

898
899

900
901

902
903

904
905

[REQ]

Identifier

REQ-11.01.03-TS-S1FR.1010

Requirement

Upon an update of the Free Routing Airspace availability the FOC shall
assess whether a flight is affected by the update of the Free Routing
Airspace availability.

Title Assessment of FRA availability update

Status <In Progress>

Rationale If there is an update in the Free Routing Airspace availability, the FOC shall
assess whether a new trajectory is required or beneficial.

Category <Functional>

Validation Method <Fast Time Simulation><Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0020 <Full>

<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRFP.0102 <Full>

<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRFP.0103 <Full>

<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRFP.1001 <Full>

<SATISFIES> <Enabler> AOM-ATM-10 <Full>

<SATISFIES> <Enabler> FOC-006 <Full>

<ALLOCATED_TO> <Functional block> Flight Management N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

[REQ]

Identifier REQ-11.01.03-TS-S1AF.1005

Requirement

Upon an update of the RTSA information the FOC shall assess whether a
flight is affected by the update of the RTSA information.

Title Assessment of RTSA information update

Status <In Progress>

Rationale If there is an update in the RTSA information, the FOC shall assess whether
a new trajectory is required or beneficial.

Category <Functional>

Validation Method <Fast Time Simulation><Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Regquirement> REQ-11.01.02-OSED-BMT1.0010 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0020 <Full>

<SATISFIES> <Enabler> FOC-002 <Full>

<SATISFIES> <Enabler> FOC-006 <Full>

<ALLOCATED TO> <Functional block> Flight Management N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

[REQ]

Identifier REQ-11.01.03-TS-S1NR.1010

Requirement

The FOC shall generate flight trajectory data according to the surface in/out
time when selected by a surface in/out time update selector.

Title Trajectory generation upon surface out time update

Status <In Progress>

Rationale The change of the surface time has an impact on the 4D trajectory which is
defined in SESAR as gate to gate trajectory. Hence a change of the surface
in or out time will have direct impact onto the planned trajectory.

Category <Functional>

Validation Method

<Fast Time Simulation><Real Time Simulation>
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Project Number 11.01.03

Edition 02.00.00

D24 - D24 - D11 1 3-TS - Technical Specification Step 1 and Step 2 for FOC System - Edition

02.00.00
| Verification Method | <Test>
906
907 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0080 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0130 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0140 <Full>
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<SATISFIES> <Enabler> FOC-009 <Full>
<ALLOCATED_TO> <Functional block> Flight Management N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
908
909 [REQ]
Identifier REQ-11.01.03-TS-S1TS.1010
Requirement The FOC shall generate EFPL based on FOC internal flight trajectory data
when selected with the EFPL selector.
Title EFPL generation
Status <Validated>
Rationale The EFPL data is based on the trajectory generated by the FOC system.
The flight plan transmission functionality shall be able to use this data as
input for the flight plan message
Category <Functional>
Validation Method <Shadow Mode>
Verification Method <Test>
910
911 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0010 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0040 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0200 <Full>
<SATISFIES> <Enabler> AOC-ATM-20 <Full>
<ALLOCATED_TO> <Functional block> Flight Management N/A
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>
<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0010 <Full>
Requirement>
<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0020 <Full>
Requirement>
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
912
913 [REQ]
Identifier REQ-11.01.03-TS-S1TS.1015

Requirement

The FOC system shall send the EFPL only to ATC Units that are selected
with the EFPL ATC Accept selector.

Title Use of EFPL
Status <Validated>
Rationale Not every ATC Authority or Network Manager is able to process a flight plan

in EFPL format. Therefore the EFPL shall only be send to ATC authorities/
Network Manager that request this type of flight plan. Furthermore the
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914
915

916
917

918
919

920
921

Airspace User shall have the capability to decide whether the EFPL is sent
to respective ATC Authorities/ Network Manager or not.

Category <Functional>
Validation Method <Shadow Mode>
Verification Method <Test>

[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0040 <Full>
<SATISFIES> <Enabler> AOC-ATM-13 <Full>
<SATISFIES> <Enabler> AOC-ATM-20 <Full>
<ALLOCATED_TO> <Functional block> Flight Management N/A
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]
Identifier REQ-11.01.03-TS-S1TS.1020

Requirement

The FOC shall generate and attach Flight Performance Data to the
Extended Flight Plan when the EFPL Flight Performance Data Selector is

selected.

Title Data Generation

Status <Validated>

Rationale Flight Performance Data is part of the Extended Flight Plan. The Flight
Performance Data must not necessarily be added to the Extended Flight
Plan. The Airspace User can decide whether Flight Performance Data is
exchanged with the Network Manager.

Category <Functional>

Validation Method <Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0010 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0020 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0070 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0020 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0030 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0070 <Full>

<SATISFIES> <Enabler> AOC-ATM-20 <Full>

<ALLOCATED _TO> <Functional block> Flight Management N/A

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0020 <Full>
Requirement>

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

[REQ]

Identifier REQ-11.01.03-TS-S1TS.1025

Requirement

The FOC shall generate and attach Gross Weight information to every point
of the 4D profile in the EFPL if the EFPL Flight Performance Data selector is
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922
923

924
925

926
927

not selected.

Title Gross Weight Information

Status <Validated>

Rationale Performance Data are part of the Extended Flight Plan. The Performance
Data must not necessarily be added to the Extended Flight Plan. The
Airspace User disables the exchange of Performance Data with the Network
Manager the Gross Weight must be added to every point of the 4D profile.

Category <Functional>

Validation Method

<Shadow Mode>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0010 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0020 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0070 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0020 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0030 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0070 <Full>

<SATISFIES> <Enabler> AOC-ATM-20 <Full>

<ALLOCATED_TO> <Functional block> Flight Management N/A

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0020 <Full>
Requirement>

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

[REQ]

Identifier REQ-11.01.03-TS-S1EF.1005

Requirement

The FOC system shall send EFPM message to the NOP/ NM, if the NM
EFPL validation service is triggered with the EFPL validation trigger.

Title EFPL based trajectory validation

Status <In Progress>

Rationale For a transition phase NM will deliver the 4D trajectory validation service in
two different variances. This is due to the fact that the current
implementation of the EFPL is based on an XML scheme that has been
developed by EUROCONTROL. It is planned to use FIXM as the standard
scheme for this EFPL data exchange. This might require a transition phase
from the one variant to the other. The FOC might be able to support both
variants during this transition phase.

Category <Functional><Interface>

Validation Method

<Live Trial><Shadow Mode>

Verification Method

<Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-11.01.02-OSED-BMT1.0010 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT1.0020 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT1.0060 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0020 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0040 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0070 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0090 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0100 <Full>
<ATMS Requirement> REQ-07.06.02-OSED-0001.0000 <Partial>
<ATMS Requirement> REQ-07.06.02-OSED-0001.0030 <Full>
<ATMS Requirement> REQ-07.06.02-OSED-0001.0040 <Full>
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928
929

930
931

932
933

<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<SATISFIES> <Enabler> AOC-ATM-20 <Full>
<ALLOCATED _TO> <Functional block> Flight Management N/A
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>
[REQ]
Identifier REQ-11.01.03-TS-S1EF.1010

Requirement

The FOC system shall send a FIXM EFPL message to the NOP/ NM, if the
NM EFPL FIXM validation service is triggered with the EFPL FIXM

validation trigger.

Title FIXM based trajectory validation

Status <In Progress>

Rationale For a transition phase NM will deliver the 4D trajectory validation service in
two different variances. This is due to the fact that the current
implementation of the EFPL is based on an XML scheme that has been
developed by EUROCONTROL. It is planned to use FIXM as the standard
scheme for this EFPL data exchange. This might require a transition phase
from the one variant to the other. The FOC might be able to support both
variants during this transition phase.

Category <Functional><Interface>

Validation Method

<Live Trial><Shadow Mode>

Verification Method

<Test>

[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0000 <Partial>
<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0040 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0010 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0060 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0040 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0090 <Full>
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<SATISFIES> <Enabler> SWIM-APS-04a <Full>
<ALLOCATED _TO> <Functional block> Flight Management N/A
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>
[REQ]
Identifier REQ-11.01.03-TS-S1EF.1015

Requirement

The FOC system shall send the EFPL as FIXM 4D message, if the
addressed ANSP or Network Manager is able and requires to receive it.

Title 4DT FIXM filing
Status <In Progress>
Rationale For the 4D trajectory filing and update two different types of services, EFPL

and FIXM, will be available in a transition phase. There is the choice to send
the flight plan to the FIXM or EFPL variant of the service. Apart from that it
must be checked whether the addressed recipient is able to receive the 4D
trajectory in the respective format.
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934
935

936
937

938
939

940
941

Category

<Functional><Interface>

Validation Method

<Live Trial><Shadow Mode>

Verification Method

<Test>

[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0000 <Partial>
<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0040 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0010 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0060 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0040 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0090 <Full>
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<SATISFIES> <Enabler> SWIM-APS-04a <Full>
<ALLOCATED _TO> <Functional block> Flight Management N/A
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>
[REQ]
Identifier REQ-11.01.03-TS-S1EF.1020

Requirement

The FOC system shall send the 4D trajectory to the EFPL validation service
if triggered with the EFPL validation trigger.

Title EFPL validation

Status <In Progress>

Rationale This requirement covers the validation of a FOC trajectory based on EFPL
data. Itis only used to confirm that a calculated trajectory is according to all
constraints and regulations and to get further information on offended
restrictions and constraints in case that the trajectory has been rejected by
NM.

Category <Functional>

Validation Method

<Live Trial><Shadow Mode>

Verification Method

<Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>
<SATISFIES>

<SATISFIES>
<APPLIES_TO>
<APPLIES_TO>

<ALLOCATED_TO>
<SATISFIES>

[REQ]

lounding mambers

Linked Element Type
<ATMS Requirement>
<ATMS Requirement>
<ATMS Requirement>
<ATMS Requirement>
<ATMS Requirement>
<ATMS Requirement>
<ATMS Requirement>
<Enabler>

<Enabler>

<Functional block>
<Information Exchange
Requirement>
<Information Exchange
Requirement>
<Operational Focus Area>
<Operational Focus Area>
<Project>

<Service>

Identifier
REQ-07.06.02-OSED-0001.0000
REQ-07.06.02-OSED-0001.0030
REQ-07.06.02-OSED-0001.0050
REQ-11.01.02-OSED-BMT1.0010
REQ-11.01.02-OSED-BMT1.0020
REQ-11.01.02-OSED-BMT2.0020
REQ-11.01.02-OSED-BMT2.0030
AOC-ATM-11

AOC-ATM-20

Flight Management
IER-07.06.02-OSED-EFPL.0010

IER-11.01.02-OSED-BMT1.0010

ENB03.01.01

OFA03.01.04

P11.01.03
ExtendedFlightPlanSubmission
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Compliance
<Partial>
<Full>
<Partial>
<Full>
<Full>
<Full>
<Full>
<Full>
<Full>
N/A
<Full>

<Full>
N/A
N/A

N/A
<Full>
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942
943

944
945

946
947

Identifier

REQ-11.01.03-TS-S1EF.1025

Requirement

The FOC system shall receive and store the content of the EFPL validation
reply.

Title Receive 4D trajectory validation reply data

Status <Validated>

Rationale If the validation of a 4D trajectory is done a reply will be received by the
FOC. This reply will include the status of the trajectory, which can be
“acknowledged” or “rejected”. Besides this trajectory status a number ‘n’
constraints with which the trajectory is in conflict. 1 < ‘n’ < « will be provided
in case the 4D trajectory is “rejected” and a number ‘m’ PTRs that are
applied to the 4D trajectory 0 < ‘m’ < « will be provided in case the 4D
trajectory is “acknowledged”.

Category <Functional>

Validation Method <Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0035 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0050 <Partial>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-SPR-FPS1.0021 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0040 <Partial>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0060 <Partial>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0110 <Partial>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<SATISFIES> <Enabler> AOC-ATM-20 <Full>

<ALLOCATED _TO> <Functional block> Flight Management N/A

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0020 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0021 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0030 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0030 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0060 <Full>
Requirement>

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

<SATISFIES> <Service> AeronauticallnformationFeature <Partial>

[REQ]

Identifier REQ-11.01.03-TS-S1EF.1030

Requirement

Constraints and the FPL validity status returned by NM/ NOP in EFPL reply
messages shall be stored in the FOC system.

Title EFPL reply storage

Status <Validated>

Rationale The constraints and the validity status might be used for further analysis
within the FOC. Therefore it must remain available in the FOC system.

Category <Functional>

Validation Method

<Shadow Mode>

Verification Method

<Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-11.01.02-SPR-D001.0002 <Full>
<ATMS Requirement> REQ-11.01.02-SPR-D001.0003 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT1.0020 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT1.0040 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT1.0070 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0020 <Full>
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948
949

950
951

952
953

954
955

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0060 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0070 <Full>
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<SATISFIES> <Enabler> AOC-ATM-20 <Full>
<ALLOCATED TO> <Functional block> Flight Management N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S1EF.1035

Requirement The FOC system shall receive and store PTRs returned by NM/ NOP in the

EFPL reply messages.

Title Receive PTR
Status <Validated>
Rationale The Network Manager will send out PTRs for trajectories that have been

filed to the NOP/ NM. The PTRs might be used for further analysis within
the FOC: The airspace user might use them to calculate an updated vertical
profile or to improve the fuel estimation for a certain flight. Therefore, they
must remain available in the FOC system.

Category <Functional>

Validation Method <Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0002 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0003 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0040 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0050 <Partial>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0035 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-SPR-FPS1.0021 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<SATISFIES> <Enabler> AOC-ATM-20 <Full>

<SATISFIES> <Enabler> SWIM-APS-04a <Full>

<SATISFIES> <Enabler> SWIM-APS-04b <Full>

<ALLOCATED_TO> <Functional block> Flight Management N/A

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0020 <Partial>

Requirement>
<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0030 <Full>
Requirement>

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

<SATISFIES> <Service> AeronauticallnformationFeature <Full>

[REQ]

Identifier REQ-11.01.03-TS-S1EF.1040

Requirement The FOC system shall be able to generate FIXM EFPL flight plans for flights
planned with the FOC system.

Title FIXM generation

Status <In Progress>

Rationale The flight plan filed to NM/ NOP will reflect the FOC trajectory that has been
planned by the AU for a certain flight. This FOC trajectory must be
converted to the FIXM format when filed to NM/ NOP when a filing or flight
plan validation service based on the FIXM flight plan format is used.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
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956
957

958
959

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0030 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0040 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-SPR-FPS1.0021 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<SATISFIES> <Enabler> SWIM-APS-04a <Full>

<ALLOCATED_TO> <Functional block> Flight Management N/A

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0060 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0070 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0020 <Full>
Requirement>

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

[REQ]

Identifier REQ-11.01.03-TS-S1NR.1015

Requirement

The FOC shall generate trajectories in accordance to all criteria that have
been selected by any selector and all flight planning boundary conditions if
triggered generate trajectory trigger.

Title Trajectory generation capabilities
Status <In Progress>
Rationale All trajectories that are used by the airspace user for operational flight
planning have to be as close as possible to the trajectory that is flown under
the actual flight planning conditions. Besides that the airspace user has the
possibility to enable or disable certain optional elements what can be set up
by using the appropriate selectors. Besides legacy selectors the new
selectors defined in this document can be used to tailor the trajectory
generation. Selectors are:
e PTR selector;
e TTA constraint selector;
e CTA constraint selector;
¢ Free Route selector;
e RBT recovery selector;
e AFUA/ ARES selector; and
e surface out time update selector.
Category <Functional>
Validation Method <Live Trial><Shadow Mode>
Verification Method <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0010 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>
<SATISFIES> <ATMS Regquirement> REQ-11.01.02-OSED-BMT1.0050 <Partial>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0050 <Partial>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0080 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0160 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0200 <Full>
<SATISFIES> <Enabler> AOC-ATM-10 <Full>
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<SATISFIES> <Enabler> FOC-003 <Full>
<SATISFIES> <Enabler> FOC-004 <Full>
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960
961

962

963

964
965

966
967

<SATISFIES> <Enabler> FOC-009 <Full>
<ALLOCATED_TO> <Functional block> Flight Management N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S1HT.1005

Requirement

The FOC system shall filter D-NOTAMs and D-METs according user
defined 4D criteria applicable for given flight plan.

Title D-NOTAM and D-MET filtering
Status <In Progress>
Rationale The system should be capable of displaying D-NOTAMs and D-METSs that
are relevant for the given flight plan, based on the 4D criteria:
o lateral filtering according to the flight plan (distance from route)
e vertical filtering above and under certain flight level
e time-based filtering
e airport filtering — departure, destination, alternate, en-route
alternate, ETOPS alternate, etc.
The user should be able to change the filtering criteria according to own
preferences, to see what are filtering criteria currently applied, and to switch
off the filtering function.
Category <Functional>
Validation Method <Real Time Simulation><Shadow Mode>
Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0090 <Full>
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<SATISFIES> <Enabler> FOC-007 <Full>
<SATISFIES> <Enabler> SWIM-APS-02b <Full>
<ALLOCATED_TO> <Functional block> Flight Management N/A
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S1HT.1010

Requirement

The FOC system should display the navigation information in the form of
aeronautical chart when the flight plan is available.

Title Navigation information for aeronautical chart
Status <In Progress>
Rationale The system allows the user to switch on or off any layer of the navigation
information in the aeronautical chart, when the flight plan is available. The
information should contain:
e Waypoints
¢ Navaids
e Airways
e Airspaces
e Airports
Category <HMI>
Validation Method <Real Time Simulation>
Verification Method <Test>

[REQ Trace]
Relationship
<SATISFIES>

lounding mambers

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-11.01.02-OSED-AIM3.0070 <Full>
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968
969

970
971

972
973

974
975

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0080 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0090 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<SATISFIES> <Enabler> FOC-007 <Full>
<SATISFIES> <Enabler> SWIM-APS-02b <Full>
<ALLOCATED_TO> <Functional block> Flight Management N/A
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
<SATISFIES> <Service> IntegratedDigitalBriefing <Full>
[REQ]

Identifier REQ-11.01.03-TS-S1TS.1030

Requirement

The FOC system shall have a Human Machine Interface (HMI) that is used

to enter Selectors and set Trigger to start FOC system functions.

Title Human Machine Interface

Status <In Progress>

Rationale The FOC system will be operated by human beings that will manually start
and stop different functions or define input parameters that are used for the
system automation.

Category <HMI>

Validation Method <Expert Group (Judgement Analysis)>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0040 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0080 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0090 <Full>
<SATISFIES> <Enabler> FOC-007 <Full>
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<ALLOCATED TO> <Functional block> Flight Deck Management N/A
<ALLOCATED_TO> <Functional block> Flight Management N/A
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
<SATISFIES> <Service> AeronauticallnformationNotification <Full>
<SATISFIES> <Service> IntegratedDigitalBriefing <Full>
[REQ]

Identifier REQ-11.01.03-TS-S1TS.1035

Requirement

The HMI shall include the following selectors:

e PTR selector
e TTA constraint selector
e CTA constraint selector
e Free Route selector
e RBT recovery selector
e AFUA/ ARES selector
e surface out time update selector
Title HMI Selector List
Status <In Progress>
Rationale This requirement defines the selector that shall be available in the FOC
system HMI.
Category <HMI>
Validation Method <Expert Group (Judgement Analysis)>
Verification Method <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
faunding mambers
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976
977

978
979

980
981

982
983

984
985

<SATISFIES> <ATMS Requirement> REQ-11.01.03-TS-S1NR.1015 <Full>

<SATISFIES> <Enabler> AOC-ATM-10 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<SATISFIES> <Enabler> FOC-003 <Full>

<SATISFIES> <Enabler> FOC-004 <Full>

<SATISFIES> <Enabler> FOC-009 <Full>

<ALLOCATED_TO> <Functional block> Flight Management N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

[REQ]

Identifier REQ-11.01.03-TS-S1NR.1020

Requirement The FOC system shall display all flights impacted by any change of data.

Title Affected Flight Display

Status <In Progress>

Rationale The user should be able to display all flights that are impacted by changed
information in order to allow the FOC system user to be in the loop. This
includes the comparison of the 4D trajectory planned by the FOC with the
4D trajectory provided by NM in reply to the EFPL provision.

Category <HMI>

Validation Method

<Real Time Simulation><Expert Group (Judgement Analysis)>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0040 <Partial>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0060 <Partial>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0080 <Full>
<SATISFIES> <Enabler> FOC-002 <Full>
<SATISFIES> <Enabler> FOC-006 <Full>
<SATISFIES> <Enabler> FOC-008 <Full>
<ALLOCATED _TO> <Functional block> Flight Management N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S1EF.1045

Requirement

The FOC system shall provide EFPL flight plans in a human readable
format to the users of the FOC system.

Title EFPL display

Status <In Progress>

Rationale The EFPL will be exchanged in the XML formats FIXM 4D and EFPM. Both
are very hard to read for human beings. Therefore the FOC system must be
able to provide the EFPL content in a way that the system users are able to
read them.

Category <HMI>

Validation Method

<Expert Group (Judgement Analysis)>

Verification Method

<Review of Design><Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<SATISFIES> <Enabler> AOC-ATM-20 <Full>
<ALLOCATED TO> <Functional block> Flight Management N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S1EF.1050

Requirement

The FOC system shall provide EFPL flight plan filing and validation replies
in a human readable format to the users of the FOC system.

“ £> Avenue de Cortenbergh 100 | B -1000 Bruxelles

- W Sesanu.eu

60 of 145

©OSESAR JOINT UNDERTAKING, 2015. Created by Lufthansa Systems, Sabre Airline Solutions, and Honeywell for the
SESAR Joint Undertaking within the frame of the SESAR Programme co-financed by the EU and EUROCONTROL. Reprint
with approval of publisher and the source properly acknowledged



986
987

988
989

990
991

992
993

994

Title EFPL reply display

Status <In Progress>

Rationale The EFPL filing and validation replies will be provided in the XML formats.
Both are very hard to read for human beings. Therefore the FOC system
must be able to provide the content included in those replies in a way that
the system users are able to read them.

Category <HMI>

Validation Method <Expert Group (Judgement Analysis)>

Verification Method <Review of Design><Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0035 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<SATISFIES> <Enabler> AOC-ATM-20 <Full>

<ALLOCATED_TO> <Functional block> Flight Management N/A

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0030 <Full>

Requirement>

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

3.1.2 Operations Management

[REQ]

Identifier REQ-11.01.03-TS-S1ST.2005

Requirement The FOC should be capable of transmitting FDA priority to the DCB (NMF).

Title Send FDA Priority

Status <In Progress>

Rationale FOC UDPP tool should be able to send the initial and subsequent FDA
priority to the DCB (NMF) so that the flight sequence and delays can be
calculated based on the AU priority.

Category <Functional>

Validation Method <Fast Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-07.02-DOD-0002.0091 <Partial>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-UDP3.0030 <Full>

<SATISFIES> <Enabler> AOC-ATM-17 <Full>

<SATISFIES> <Enabler> AOC-ATM-18 <Full>

<SATISFIES> <Enabler> FOC-005 <Full>

<ALLOCATED_TO> <Functional block> Operations Management N/A

<SATISFIES> <Information Exchange IER-11.01.02-OSED-UDP2.0020 <Full>

Requirement>

<APPLIES_TO> <Operational Focus Area> OFA05.03.06 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

[REQ]

Identifier REQ-11.01.03-TS-S1ST.2010

Requirement

The FOC should be capable of reading CCS information including Ol and
Duration published by the DCB (NMF).

Title Read CCS Information

Status <In Progress>

Rationale FOC UDPP tool should be able to get the updated CCS information
including Ol and Duration from the DCB (NMF).

Category <Functional>

Validation Method <Fast Time Simulation>

Verification Method <Test>
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995

996
997

998
999

1000
1001

1002
1003

1004

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-07.02-DOD-0002.0091 <Partial>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-UDP3.0010 <Full>

<SATISFIES> <Enabler> AOC-ATM-17 <Full>

<SATISFIES> <Enabler> AOC-ATM-18 <Full>

<SATISFIES> <Enabler> FOC-005 <Full>

<ALLOCATED_TO> <Functional block> Operations Management N/A

<SATISFIES> <Information Exchange IER-11.01.02-OSED-UDP2.0020 <Full>

Requirement>

<APPLIES_TO> <Operational Focus Area> OFA05.03.06 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

[REQ]

Identifier REQ-11.01.03-TS-S1ST.2015

Requirement The FOC should be capable of transmitting OC to the DCB (NMF).

Title Send OC

Status <In Progress>

Rationale FOC UDPP tool should be able to send the initial and subsequent OC'’s to
the DCB (NMF) so that the flight sequence and delays can be calculated
based on the OC's.

Category <Functional>

Validation Method <Fast Time Simulation>

Verification Method <Test>

[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-07.02-DOD-0002.0091 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-UDP3.0040 <Full>
<SATISFIES> <Enabler> AOC-ATM-17 <Full>
<SATISFIES> <Enabler> AOC-ATM-18 <Full>
<SATISFIES> <Enabler> FOC-005 <Full>
<ALLOCATED_TO> <Functional block> Operations Management N/A
<SATISFIES> <Information Exchange IER-11.01.02-OSED-UDP2.0020 <Full>
Requirement>
<APPLIES_TO> <Operational Focus Area> OFA05.03.06 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]
Identifier REQ-11.01.03-TS-S1ST.2020

Requirement

The FOC should be capable of reading baseline delay information published

by the DCB (NMF).

Title Read Delay EOBT Information

Status <In Progress>

Rationale FOC UDPP tool should be able to get the updated EOBT information based
on the FDA priority and OC’s provided by AU’s from the DCB (NMF).

Category <Functional>

Validation Method

<Fast Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-07.02-DOD-0002.0091 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-UDP3.0010 <Full>
<SATISFIES> <Enabler> AOC-ATM-17 <Full>
<SATISFIES> <Enabler> AOC-ATM-18 <Full>
<SATISFIES> <Enabler> FOC-005 <Full>
<ALLOCATED_TO> <Functional block> Operations Management N/A
<SATISFIES> <Information Exchange IER-11.01.02-OSED-UDP2.0030 <Full>

Requirement>

<APPLIES_TO> <Operational Focus Area> OFA05.03.06 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
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1006
1007

1008
1009

1010
1011

1012
1013

[REQ]

Identifier

REQ-11.01.03-TS-S1TS.2005

Requirement

The FOC system shall receive and store TTA and CTA from the Network
Manager.

Title Receive TTA and CTA

Status <In Progress>

Rationale Operations Management is responsible for evaluating, processing and
distributing up-to date flight data. Once a flight plan is filed to NM it could be
that NM returns a TTA or CTA. The system must be able to receive such a
Target Time Constraint message.

Category <Functional>

Validation Method <Shadow Mode>

Verification Method <Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>
<SATISFIES>

<APPLIES_TO>
<APPLIES_TO>
<ALLOCATED_TO>

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-11.01.02-OSED-BMT1.0040 <Partial>
<ATMS Requirement> REQ-11.01.02-OSED-BMT1.0070 <Full>
<Enabler> AOC-ATM-11 <Full>
<Enabler> SWIM-APS-04a <Full>
<Enabler> SWIM-APS-02a <Full>
<Enabler> SWIM-APS-02b <Full>
<Enabler> SWIM-APS-04b <Full>
<Enabler> FOC-006 <Full>
<Functional block> Operations Management N/A
<Information Exchange IER-11.01.02-OSED-BMT1.0030 <Full>
Requirement>

<Operational Focus Area> ENB03.01.01 N/A
<Operational Focus Area> OFA03.01.04 N/A
<Project> P11.01.03 N/A

3.1.3 Decision Support Management

[REQ]

Identifier

REQ-11.01.03-TS-S1NR.3005

Requirement

The FOC shall provide cost information on delays caused by ATM restriction
to analyse its impact (cost vs. delay).

Title Operations Cost Management

Status <In Progress>

Rationale Enable AUs to make best use of the UDPP process in order to recover from
ATM disturbances.

Category <Functional>

Validation Method <Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-UDP3.0050 <Full>
<SATISFIES> <Enabler> AOC-ATM-17 <Full>
<SATISFIES> <Enabler> AOC-ATM-18 <Full>
<SATISFIES> <Enabler> FOC-005 <Full>
<ALLOCATED_TO> <Functional block> Decision Support Management N/A
<APPLIES_TO> <Operational Focus Area> OFA05.03.06 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S1NR.3010

Requirement

The FOC shall generate flight trajectory data according to the affecting
RTSA information when selected by the AFUA/ARES selector.

Title

Trajectory generation according to RTSA information

Status

<In Progress>
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Rationale To assess the impact of an airspace release or booking, concerned
trajectories shall be re-calculated to collect the information required by the
FOC to make decisions. For flights too close to the released airspace
(according to the parameters set by the individual airspace user) the
trajectory revision might not apply. Therefore such condition must be
recognized to avoid unintended workload on AU side.
Category <Functional>
Validation Method <Fast Time Simulation><Real Time Simulation>
Verification Method <Test>
1014
1015 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0140 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0160 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0200 <Full>
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<SATISFIES> <Enabler> FOC-006 <Full>
<ALLOCATED_TO> <Functional block> Decision Support Management N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
1016
1017 [REQ]
Identifier REQ-11.01.03-TS-S2NR.3005
Requirement The FOC shall receive and store AA2A data.
Title AA2A reception and storage
Status <In Progress>
Rationale In order to use AA2A data in the trajectory generation, the AA2A data must
be received and stored.
Category <Functional>
Validation Method <Live Trial><Shadow Mode>
Verification Method <Test>
1018
1019 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0060 <Partial>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0110 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0130 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0140 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0160 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0180 <Partial>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0200 <Full>
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<SATISFIES> <Enabler> SWIM-APS-04a <Full>
<SATISFIES> <Enabler> SWIM-APS-02a <Full>
<SATISFIES> <Enabler> SWIM-APS-02b <Full>
<SATISFIES> <Enabler> SWIM-APS-04b <Full>
<SATISFIES> <Enabler> FOC-006 <Full>
<ALLOCATED_TO> <Functional block> Decision Support Management N/A
<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0030 <Full>
Requirement>
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
1020
1021 [REQ]
Identifier REQ-11.01.03-TS-S2BT.3005

Requirement

The FOC shall receive and store ATC-to-FOC-RBT-Conflict-Advisory from

ATC.
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1022
1023

1024
1025

1026
1027

1028
1029

Title Reception of ATC Area to Avoid data
Status <In Progress>
Rationale The system shall store the data included in the ATC-to-FOC-RBT-Conflict-
Advisory message internally to make it available for other functionalities.
The ATC-to-FOC-RBT-Conflict-Advisory message will include:
e An EFPL representing the trajectory that conflicts with other traffic
e And one or several ATC Area(s) to Avoid.
Category <Functional>
Validation Method <Live Trial><Shadow Mode>
Verification Method <Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>
<APPLIES_TO>
<APPLIES_TO>
<ALLOCATED_TO>

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0060 <Full>
<Enabler> AOC-ATM-11 <Full>
<Enabler> FOC-006 <Full>
<Functional block> Decision Support Management N/A
<Operational Focus Area> ENB03.01.01 N/A
<Operational Focus Area> OFA03.01.04 N/A
<Project> P11.01.03 N/A

3.1.4 Data Management

[REQ]

Identifier

REQ-11.01.03-TS-S1TS.4005

Requirement

The FOC System shall receive and store ATM constraints from the Network
Manager.

Title Receive ATM constraints

Status <In Progress>

Rationale The FOC system stores received ATM constraints/restrictions in its internal
database where it is available for retrieval by other FOC system
components (e.g. Trajectory Generator)

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0060 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0080 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0110 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0180 <Partial>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0190 <Partial>
<SATISFIES> <Enabler> AOC-ATM-11 <Partial>
<SATISFIES> <Enabler> FOC-006 <Full>
<SATISFIES> <Enabler> SWIM-APS-04a <Full>
<SATISFIES> <Enabler> SWIM-APS-04b <Full>
<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0030 <Full>
Requirement>
<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0060 <Full>
Requirement>
<ALLOCATED TO> <Functional block> Data Management N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]
Identifier REQ-11.01.03-TS-S1FR.4005

Requirement

The FOC system shall receive and store the Free Routing Airspace volume
availability

Title

Receive FRA volume availability information
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Status

<In Progress>

Rationale In order to be able to plan valid trajectories in FRA the FOC must know
about the FRA volume availability.

Category <Functional>

Validation Method <Fast Time Simulation><Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-FRA3.0010 <Full>

<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRFP.0102 <Full>

<SATISFIES> <Enabler> AOC-ATM-10 <Full>

<ALLOCATED_TO> <Functional block> Data Management N/A

<SATISFIES> <Information Exchange IER-11.01.02-OSED-FRA1.0010 <Full>

Requirement>

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

<SATISFIES> <Service> AeronauticallnformationFeature <Full>

<SATISFIES> <Service> AeronauticallnformationNotification <Full>

[REQ]

Identifier REQ-11.01.03-TS-S1FR.4010

Requirement The FOC system shall receive and store the Free Routing Airspace time
availability

Title Receive FRA time availability information

Status <In Progress>

Rationale In order to be able to plan valid trajectories in FRA the FOC must know
about the FRA time availability.

Category <Functional>

Validation Method <Fast Time Simulation><Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-FRA3.0020 <Full>

<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRFP.0103 <Full>

<SATISFIES> <Enabler> AOC-ATM-10 <Full>

<ALLOCATED _TO> <Functional block> Data Management N/A

<SATISFIES> <Information Exchange IER-11.01.02-OSED-FRA1.0020 <Full>

Requirement>

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

<SATISFIES> <Service> AeronauticallnformationFeature <Full>

<SATISFIES> <Service> AeronauticallnformationNotification <Full>

[REQ]

Identifier REQ-11.01.03-TS-S1FR.4015

Requirement

The FOC system shall receive and store the Free Routing Airspace
Horizontal Entry/Exit Features

Title Receive FRA horizontal entry/exit features information

Status <In Progress>

Rationale In order to be able to plan valid trajectories in FRA the FOC must know
about the horizontal entry/exit features.

Category <Functional>

Validation Method

<Fast Time Simulation><Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-FRA3.0030 <Full>
launding mambers
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<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRFP.0104 <Full>
<SATISFIES> <Enabler> AOC-ATM-10 <Full>
<ALLOCATED _TO> <Functional block> Data Management N/A
<SATISFIES> <Information Exchange IER-11.01.02-OSED-FRA1.0030 <Full>
Requirement>
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
<SATISFIES> <Service> AeronauticallnformationFeature <Full>
<SATISFIES> <Service> AeronauticallnformationNotification <Full>
[REQ]
Identifier REQ-11.01.03-TS-S1FR.4020

Requirement

The FOC system shall receive and store the Free Routing Airspace Vertical
Entry/Exit Features

Title Receive FRA vertical entry/exit features information

Status <In Progress>

Rationale In order to be able to plan valid trajectories in FRA the FOC must know
about the vertical entry/exit features.

Category <Functional>

Validation Method <Fast Time Simulation><Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-FRA3.0030 <Full>

<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRFP.0104 <Full>

<SATISFIES> <Enabler> AOC-ATM-10 <Full>

<ALLOCATED_TO> <Functional block> Data Management N/A

<SATISFIES> <Information Exchange IER-11.01.02-OSED-FRA1.0030 <Full>

Requirement>

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

<SATISFIES> <Service> AeronauticallnformationFeature <Full>

<SATISFIES> <Service> AeronauticallnformationNotification <Full>

[REQ]

Identifier REQ-11.01.03-TS-S1FR.4025

Requirement

The FOC system shall receive and store the Free Routing Airspace Allowed
Intermediate Points

Title Receive FRA allowed intermediate points information

Status <In Progress>

Rationale In order to be able to plan valid trajectories in FRA the FOC must know
about the allowed intermediate points for flight planning. These points can
be currently published points or user-defined lat/long points.

Category <Functional>

Validation Method <Fast Time Simulation><Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-FRA3.0030 <Full>

<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRFP.0104 <Full>

<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRFP.1002 <Full>

<SATISFIES> <Enabler> AOC-ATM-10 <Full>

<ALLOCATED _TO> <Functional block> Data Management N/A

<SATISFIES> <Information Exchange IER-11.01.02-OSED-FRA1.0030 <Full>

Requirement>

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A

<ALLOCATED TO> <Project> P11.01.03 N/A

<SATISFIES> <Service> AeronauticallnformationFeature <Full>
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<SATISFIES> <Service> AeronauticallnformationNotification <Full>

[REQ]

Identifier REQ-11.01.03-TS-S1FR.4030

Requirement The FOC system shall receive and store the Free Routing Airspace
minimum/maximum segment length

Title Receive FRA allowed minimum/maximum segment length information

Status <In Progress>

Rationale In order to be able to plan valid trajectories in FRA the FOC must know
about the allowed minimum/maximum segment length.

Category <Functional>

Validation Method <Fast Time Simulation><Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-FRA3.0030 <Full>

<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRFP.0104 <Full>

<SATISFIES> <Enabler> AOC-ATM-10 <Full>

<ALLOCATED TO> <Functional block> Data Management N/A

<SATISFIES> <Information Exchange IER-11.01.02-OSED-FRA1.0030 <Full>

Requirement>

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

<SATISFIES> <Service> AeronauticallnformationFeature <Full>

<SATISFIES> <Service> AeronauticallnformationNotification <Full>

[REQ]

Identifier REQ-11.01.03-TS-S1AF.4005

Requirement The FOC system shall receive and store the RTSA information.

Title Receive RTSA Information

Status <In Progress>

Rationale Getting RTSA information (i.e. checking whether an ARES has been
released or booked)) is the main trigger for the whole RTSA-related process
of each individual FOC.

Category <Functional>

Validation Method <Fast Time Simulation><Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-FUA3.0010 <Full>

<SATISFIES> <Enabler> FOC-002 <Full>

<SATISFIES> <Enabler> SWIM.INFR-05a <Full>

<ALLOCATED_TO> <Functional block> Data Management N/A

<SATISFIES> <Information Exchange IER-11.01.02-OSED-FUA1.0010 <Full>

Requirement>

<APPLIES_TO> <Operational Focus Area> OFA05.03.01 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

<SATISFIES> <Service> AeronauticallnformationFeature <Full>

<SATISFIES> <Service> AeronauticallnformationNotification <Full>

<SATISFIES> <Service> ARESQuery <Full>

[REQ]

Identifier REQ-11.01.03-TS-S1HT.4005

Requirement For each airspace there shall be information about the airspace identifier,
the type of airspace, vertical limitations and validity times displayed on
request.

Title Airspace information

Status <In Progress>
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Rationale The user needs access to information about each airspace, containing the
airspace identifier, the type of airspace, vertical limitations and validity
times, to safely perform the flight.

Category <HMI>

Validation Method <Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0050 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0080 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0090 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<SATISFIES> <Enabler> FOC-007 <Full>
<ALLOCATED_TO> <Functional block> Data Management N/A
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
<SATISFIES> <Service> IntegratedDigitalBriefing <Full>
[REQ]

Identifier REQ-11.01.03-TS-S1HT.4010

Requirement

The FOC system shall display the airspace information in horizontal (lateral
view) map projection.

Title Airspaces projected in map

Status <In Progress>

Rationale To allow user to clearly identify the airspace shape, the airspace is
presented in lateral graphical form as an object on the map.

Category <HMI>

Validation Method

<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0080 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0090 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<SATISFIES> <Enabler> FOC-007 <Full>
<SATISFIES> <Enabler> SWIM-APS-02b <Full>
<ALLOCATED _TO> <Functional block> Data Management N/A
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
<SATISFIES> <Service> IntegratedDigitalBriefing <Full>
[REQ]

Identifier REQ-11.01.03-TS-S1HT.4015

Requirement

The design of the graphical presentation of airspaces should allow the user
to clearly interpret multiple overlapping airspaces, and to distinguish
between them.

Title Multiple airspaces

Status <In Progress>

Rationale It should be obvious from the design that there are multiple airspaces one
on top of another.

Category <HMI>

Validation Method <Real Time Simulation>

Verification Method <Test>
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[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0080 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0090 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<SATISFIES> <Enabler> FOC-007 <Full>
<ALLOCATED_TO> <Functional block> Data Management N/A
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
<SATISFIES> <Service> IntegratedDigitalBriefing <Full>
[REQ]

Identifier REQ-11.01.03-TS-S1NR.4005

Requirement

All changes to data stored in the FOC shall be indicated on a display if
triggered by the FOC system user.

Title Display of changes

Status <In Progress>

Rationale The user should be informed about all changed information related to the
FOC, for example to indicate whether an airspace, which was not active on
the briefing, becomes active, and also vice versa.

Category <HMI>

Validation Method

<Real Time Simulation><Expert Group (Judgement Analysis)>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0040 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0050 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0060 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<SATISFIES> <Enabler> FOC-007 <Full>
<SATISFIES> <Enabler> SWIM-APS-02b <Full>
<SATISFIES> <Functional block> Data Management N/A
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
<SATISFIES> <Service> AeronauticallnformationNotification <Full>
<SATISFIES> <Service> IntegratedDigitalBriefing <Full>
[REQ]

Identifier REQ-11.01.03-TS-S1HT.4020

Requirement

The FOC system shall be able to import D-NOTAM and D-MET information
from external sources.

Title D-NOTAM and D-MET import

Status <In Progress>

Rationale Import from external sources and internal processing will provide consistent
information in time that will avoid inconsistent situational awareness and
decision making.

Category <Functional>

Validation Method <Real Time Simulation>

Verification Method <Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>

foaunding mambers

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-11.01.02-OSED-AIM3.0020 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-AIM3.0050 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-AIM3.0060 <Full>
<ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
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<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>
<APPLIES_TO>
<ALLOCATED_TO>
<SATISFIES>
<SATISFIES>

<Enabler> AIMS-06 <Full>
<Enabler> AIMS-19a <Full>
<Enabler> SWIM-APS-02a <Full>
<Enabler> SWIM-APS-02b <Full>
<Functional block> Data Management N/A
<Operational Focus Area> ENB02.01.02 N/A
<Project> P11.01.03 N/A
<Service> AeronauticallnformationNotification <Full>
<Service> IntegratedDigitalBriefing <Full>

3.1.5 Communication Management

[REQ]

Identifier

REQ-11.01.03-TS-S1HT.5005

Requirement

The FOC system shall import the EAUP/EUUP from the Network Manager
via B2B in AIXM (SWIM).

Title EAUP/EUUP import via SWIM

Status <In Progress>

Rationale The Functional Block “Communication Management” of the FOC system
needs to import the EAUP/EUUP information from Network Manager (NM)
via B2B in AIXM format (SWIM).

Category <Functional><Interface>

Validation Method

<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>
<SATISFIES>

<APPLIES_TO>
<ALLOCATED_TO>

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-11.01.02-OSED-FUA3.0010 <Full>
<ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<Enabler> AIMS-06 <Full>
<Enabler> AIMS-19a <Full>
<Enabler> SWIM-APS-02a <Full>
<Enabler> SWIM-APS-02b <Full>
<Functional block> Communication Management N/A
<Information Exchange IER-11.01.02-OSED-FUA1.0010 <Full>
Requirement>

<Operational Focus Area> ENB02.01.02 <Full>
<Project> P11.01.03 N/A

3.1.6 Flight Deck Management

N/A

3.2 Adaptability

3.2.1 Flight Management

[REQ]

Identifier

REQ-11.01.03-TS-S1FR.1015

Requirement

If the ATS route network remains available in the Free Routing Airspace, the
FOC shall allow the airspace user to trigger whether a trajectory is planned
using the ATS route network only or using all possibilities in the Free
Routing Airspace.

Title Flight Planning Options in FRA

Status <In Progress>

Rationale The airspace user may decide to only use the ATS route network for flight
planning if it remains available in Free Routing Airspace and not to make
use of all new flight planning options.

Category <Functional>

Validation Method

<Fast Time Simulation><Real Time Simulation>
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| Verification Method | <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0010 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0020 <Full>
<SATISFIES> <Enabler> AOC-ATM-10 <Full>
<ALLOCATED _TO> <Functional block> Flight Management N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]
Identifier REQ-11.01.03-TS-S1EF.1055

Requirement

The FOC system shall allow the system user to trigger whether an ICAO
FPL or EFPL is generated for a flight.

Title Flight plan type options
Status <Validated>
Rationale Flight plan information can include two different types of content. The first
option only includes the flight plan according ICAO PANS-ATM doc 4444,
the other type includes information as defined by Eurocontrol as Extended
Flight plan. The FOC system must be adaptable in regard whether the ICAO
FPL or the EFPL is used.
Category <Functional>
Validation Method <Shadow Mode>
Verification Method <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0010 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0030 <Full>
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<SATISFIES> <Enabler> AOC-ATM-20 <Full>
<ALLOCATED_TO> <Functional block> Flight Management N/A
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0060 <Full>
Requirement>
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0070 <Full>
Requirement>
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

3.2.2 Operations Management

[REQ]

Identifier

REQ-11.01.03-TS-S2NR.2005

Requirement

The AU shall be able to change and update prioritisation information during
a UDPP time window of action given by DCB, according to the constraint
and organisation.

Title UDPP Reprioritisation

Status <In Progress>

Rationale The AU should have enough flexibility to update FDA / SFP Prioritisation
during UDPP time window.

Category <Functional>

Validation Method

<Real Time Simulation><Shadow Mode>
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1093
1094

1095
1096

1097
1098

1099
1100

1101
1102

1103
1104

| Verification Method | <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-UDP3.0070 <Full>
<SATISFIES> <Enabler> AOC-ATM-17 <Full>
<SATISFIES> <Enabler> AOC-ATM-18 <Full>
<SATISFIES> <Enabler> FOC-005 <Full>
<ALLOCATED _TO> <Functional block> Operations Management N/A
<SATISFIES> <Information Exchange IER-11.01.02-OSED-UDP2.0020 <Full>

Requirement>

<APPLIES_TO> <Operational Focus Area> OFA05.03.06 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A

3.2.3 Decision Support Management

N/A

3.2.4 Data Management

N/A

3.2.5 Communication Management

[REQ]

Identifier

REQ-11.01.03-TS-S1EF.5005

Requirement

The FOC system shall allow the system user to trigger whether the ICAO
FPL is transmitted to NM/ NOP using ICAO TXT data transmission, ICAO
XML or ICAO FIXM based services.

Title ICAO FPL format selection
Status <In Progress>
Rationale Depending on the way how the ICAO FPL is send NM/ NOP different type of
ICAO FPL message formats are applicable. It must be possible to select
how the flight plan is send to NM/ NOP. The respective selected way will
define in which format the flight plan will be transmitted.
Category <Functional>
Validation Method <Live Trial><Shadow Mode>
Verification Method <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0030 <Full>
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<ALLOCATED_TO> <Functional block> Communication Management N/A
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0060 <Full>
Requirement>
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0070 <Full>
Requirement>
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>
[REQ]
Identifier REQ-11.01.03-TS-S1EF.5010

Requirement

The FOC system shall allow the system user to trigger whether the EFPL is
transmitted to NM/ NOP using EFPM or FIXM 4D message based services.

Title

EFPL format selection
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1105
1106

1107
1108

1109

1110
1111

1112
1113

Status

<In Progress>

Rationale Depending on the way how the EFPL is send NM/ NOP different type of
EFPL message formats are applicable. It must be possible to select how the
flight plan is send to NM/ NOP. The respective selected way will define in
which format the flight plan will be transmitted.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>
<SATISFIES>

<SATISFIES>
<SATISFIES>
<APPLIES_TO>
<APPLIES_TO>

<ALLOCATED_TO>
<SATISFIES>

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0030 <Full>
<Enabler> AOC-ATM-11 <Full>
<Enabler> AOC-ATM-20 <Full>
<Enabler> SWIM-APS-04a <Full>
<Functional block> Communication Management N/A
<Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>

<Information Exchange IER-07.06.02-OSED-EFPL.0060 <Full>
Requirement>

<Information Exchange IER-07.06.02-OSED-EFPL.0070 <Full>
Requirement>

<Operational Focus Area> ENB03.01.01 N/A
<Operational Focus Area> OFA03.01.04 N/A
<Project> P11.01.03 N/A
<Service> ExtendedFlightPlanSubmission <Full>

3.2.6 Flight Deck Management

N/A

3.3 Performance Characteristics

3.3.1 Flight Management

[REQ]

Identifier

REQ-11.01.03-TS-S2NR.1015

Requirement

Any reaction to updated data shall be done in a time window that allows
executing the trajectory changes.

Title Trajectory update assessment

Status <In Progress>

Rationale If there are new options or requirements to plan a trajectory, the airspace
user must react in a given time window. This time window is determined by
the current location of the aircraft and the point where the trajectory has to
be changed at the latest.

Category <Performance>

Validation Method <Expert Group (Judgement Analysis)>

Verification Method <Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>
<APPLIES_TO>
<APPLIES_TO>
<ALLOCATED_TO>

lounding mambers

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0070 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0160 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0200 <Full>
<ATMS Requirement> REQ-04.07.02-SPR-FRFP.1001 <Full>
<Enabler> AOC-ATM-11 <Full>
<Functional block> Flight Management N/A
<Operational Focus Area> ENB03.01.01 N/A
<Operational Focus Area> OFA03.01.04 N/A
<Project> P11.01.03 N/A
£> Avenue de Cortenbergh 100 | B -1000 Bruxelles
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1114
1115

1116
1117

1118
1119

1120
1121

1122
1123

[REQ]

Identifier

REQ-11.01.03-TS-S1EF.1060

Requirement

The generation of the extended flight plan shall not affect the system
performance in a negative way.

Title EFPL performance impact

Status <Validated>

Rationale The provision of the EFPL is additional work that has to be done by the
FOC. As the main purpose of the FOC is the planning of the flight
operations and filing of a flight plan is only an interface function needed to
ensure interoperability with all ATM stakeholders, it shall not influence the
performance of the flight planning in a negative way.

Category <Performance>

Validation Method <Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0002 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0003 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<SATISFIES> <Enabler> AOC-ATM-20 <Full>

<ALLOCATED_TO> <Functional block> Flight Management N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

[REQ]

Identifier REQ-11.01.03-TS-S2BT.1005

Requirement The FOC shall steadily monitor the adherence to the RBT during all phases
of the flight.

Title On-going RBT monitoring

Status <In Progress>

Rationale To ensure an assessment of changing planning conditions or on a deviation
from the planned route at all stages of a flight (especially in the in-flight
phase) a continuous monitoring must be ensured.

Category <Performance>

Validation Method

<Flight Trial><Live Trial><Shadow Mode>

Verification Method

<Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>
<APPLIES_TO>
<APPLIES_TO>
<ALLOCATED_TO>

Linked Element Type
<ATMS Requirement>
<ATMS Requirement>
<ATMS Requirement>
<ATMS Requirement>
<ATMS Requirement>
<Enabler>

<Enabler>

<Enabler>

<Functional block>
<Operational Focus Area>
<Operational Focus Area>
<Project>

3.3.2 Operations Management

N/A

Identifier
REQ-11.01.02-OSED-BMT2.0110
REQ-11.01.02-OSED-BMT2.0130
REQ-11.01.02-OSED-BMT2.0160
REQ-11.01.02-OSED-BMT2.0180
REQ-11.01.02-OSED-BMT2.0190
FOC-006

FOC-008

SWIM-APS-05b

Flight Management

ENB03.01.01

OFA03.01.04

P11.01.03
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Compliance
<Full>
<Full>
<Full>
<Partial>
<Partial>
<Full>
<Full>
<Full>
N/A

N/A

N/A

N/A
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1124
1125

1126
1127

1128
1129

1130
1131

1132

1133
1134

1135
1136

1137
1138

1139
1140

1141
1142

Project Number 11.01.03
D24 - D24 - D11 1 3-TS - Technical Specification Step 1 and Step 2 for FOC System - Edition

02.00.00

3.3.3 Decision Support Management

N/A

3.3.4 Data Management

N/A

3.3.5 Communication Management

N/A

3.3.6 Flight Deck Management

N/A

3.4 Safety & Security

3.4.1 Flight Management

Edition 02.00.00

[REQ]

Identifier REQ-11.01.03-TS-S1NR.1025

Requirement The FOC shall use the RBT agreed with all other ATM stakeholders for flight
monitoring.

Title Seamless use of trajectory.

Status <In Progress>

Rationale The RBT is the trajectory that is agreed by all ATM stakeholders to be used
as a reference.

Category <Functional>

Validation Method <Real Time Simulation><Shadow Mode>

Verification Method <Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>
<APPLIES_TO>
<APPLIES_TO>
<ALLOCATED_TO>

Identifier
REQ-11.01.01-DOD-2100.0055
REQ-11.01.02-OSED-BMT1.0060
REQ-11.01.02-OSED-BMT2.0140
REQ-11.01.02-OSED-BMT2.0160

Linked Element Type

<ATMS Requirement>
<ATMS Requirement>
<ATMS Requirement>
<ATMS Requirement>

<Enabler> FOC-006
<Functional block> Flight Management
<Operational Focus Area> ENB03.01.01
<Operational Focus Area> OFA03.01.04
<Project> P11.01.03

3.4.2 Operations Management

N/A

3.4.3 Decision Support Management

N/A

3.4.4 Data Management

N/A
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<Full>
<Full>
<Full>
<Full>
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Project Number 11.01.03 Edition 02.00.00
D24 - D24 - D11 1 3-TS - Technical Specification Step 1 and Step 2 for FOC System - Edition
02.00.00

1143 3.4.5 Communication Management
1144  NIA

1145 3.4.6 Flight Deck Management
1146 N/A

1147 3.5 Maintainability

1148  3.5.1 Flight Management
1149  N/A

1150 3.5.2 Operations Management
1151 N/A

1152 3.5.3 Decision Support Management
1153 N/A

1154 3.5.4 Data Management
1155  N/A

1156 3.5.5 Communication Management
1157 N/A

1158 3.5.6 Flight Deck Management
1159  N/A

1160 3.6 Reliability

1161 3.6.1 Flight Management
1162 N/A

1163 3.6.2 Operations Management

1164 N/A

1165 3.6.3 Decision Support Management
1166 N/A
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1167
1168

1169
1170

1171
1172

1173

1174
1175

1176
1177

1178
1179

1180
1181

Project Number 11.01.03 Edition 02.00.00
D24 - D24 - D11 1 3-TS - Technical Specification Step 1 and Step 2 for FOC System - Edition
02.00.00

3.6.4 Data Management
N/A

3.6.5 Communication Management
N/A

3.6.6 Flight Deck Management
N/A

3.7 Functional block Internal Data Requirements

3.7.1 Flight Management
N/A

3.7.2 Operations Management
N/A

3.7.3 Decision Support Management

[REQ]

Identifier REQ-11.01.03-TS-S1NR.3015

Requirement The FOC system shall store all data that is either directly linked to a flight or
that has been assessed to affect that flight for at least the duration of the
trajectory negotiation for this flight.

Title Storage duration of flight relevant data

Status <In Progress>

Rationale In order to enable an efficient trajectory negotiation process, the FOC must
have all relevant data available, even if received for example in a previous
reject message.

Category <Functional>

Validation Method <Real Time Simulation><Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0020 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0040 <Partial>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0060 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0070 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0060 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0070 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0080 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0130 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0140 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0200 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<SATISFIES> <Enabler> FOC-003 <Full>

<SATISFIES> <Enabler> FOC-005 <Full>

<SATISFIES> <Enabler> FOC-006 <Full>

<ALLOCATED_TO> <Functional block> Decision Support Management N/A

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0030 <Full>

Requirement>
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1182
1183

1184
1185

1186
1187

1188
1189

1190

1191
1192

1193
1194

1195
1196

Project Number 11.01.03

Edition 02.00.00

D24 - D24 - D11 1 3-TS - Technical Specification Step 1 and Step 2 for FOC System - Edition

02.00.00
<SATISFIES>

<APPLIES_TO>
<APPLIES_TO>
<ALLOCATED_TO>

<Information Exchange IER-11.01.02-OSED-BMT1.0060 <Full>
Requirement>

<Operational Focus Area> ENB03.01.01 N/A
<Operational Focus Area> OFA03.01.04 N/A
<Project> P11.01.03 N/A

3.7.4 Data Management

N/A

3.7.5 Communication Management

[REQ]

Identifier

REQ-11.01.03-TS-S1HT.5010

Requirement

The FOC shall store track record about all information received from other
systems and all updates performed by users in order to provide track of
such information. The track record shall capture the source and the time of
the change.

Title FOC track record

Status <In Progress>

Rationale With the track record the FOC system will ensure all actors are working with
the same set of information available to avoid negative impact on situational
awareness and decision making caused by inconsistent information.

Category <Functional>

Validation Method

<Real Time Simulation><Expert Group (Judgement Analysis)>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0040 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0050 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-AIM3.0060 <Full>
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<ALLOCATED_TO> <Functional block> Communication Management N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
3.7.6 Flight Deck Management

N/A

3.8 Design and Construction Constraints

3.8.1 Flight Management

N/A

3.8.2 Operations Management

N/A

3.8.3 Decision Support Management

N/A
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1197
1198

1199
1200

1201
1202

1203
1204

1205
1206
1207

1208
1209

1210
1211

Project Number 11.01.03

Edition 02.00.00

D24 - D24 - D11 1 3-TS - Technical Specification Step 1 and Step 2 for FOC System - Edition

02.00.00

3.8.4 Data Management

[REQ]

Identifier REQ-11.01.03-TS-S1TS.4010

Requirement The FOC system shall use UTC time as reference.

Title Align air and ground times

Status <In Progress>

Rationale The time reference for the air and the ground systems may vary. To ensure
that the data obtained from the a/c can be mixed with the ground data for
other flights there is a need to ensure that UTC time reference is used by all
air and ground systems.

Category <Design>

Validation Method <Expert Group (Judgement Analysis)>

Verification Method <Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>
<APPLIES_TO>
<APPLIES_TO>
<ALLOCATED_TO>

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>
<Enabler> AOC-ATM-13 <Full>
<Functional block> Data Management N/A
<Operational Focus Area> ENB03.01.01 N/A
<Operational Focus Area> OFA03.01.04 N/A
<Project> P11.01.03 N/A

3.8.5 Communication Management

N/A

3.8.6 Flight Deck Management

N/A

3.9 Functional block Interface Requirements

Please note, that the interface requirements for AIM can be found in a separate IRS document
produced by Honeywell [27]. For the requirements therein no need for an update has been identified.

3.9.1 Flight Management

[REQ]

Identifier

REQ-11.01.03-TS-S1BT.1005

Requirement

The FOC shall send trajectory proposals in the EFPL format to the ATC
system.

Title Trajectory proposal format

Status <In Progress>

Rationale For the time being the EFPL format as used by NM for the EFPL creation
B2B web service shall be used for the trajectory exchange between FOC
and ATC. This requirement is driven by the need to align and standardize
basic data that is exchanged between all ATM stakeholders.

Category <Functional><Interface>

Validation Method

<Live Trial><Shadow Mode>

Verification Method

<Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
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Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-BMT2.0030 <Full>
<Enabler> AOC-ATM-20 <Full>
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1212
1213

1214
1215

1216
1217

1218
1219

<ALLOCATED _TO> <Functional block> Flight Management N/A

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0020 <Full>
Requirement>

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

[REQ]

Identifier REQ-11.01.03-TS-S1EF.1065

Requirement

The information provided by the Extended Flight Plan Filing request
message shall be in accordance with WS-N WSDL and XSD format.

Title EFPL filing via SWIM

Status <In Progress>

Rationale SWIM-TI binding: REQ-14.01.04-TS-0901.0304
Category <Interface>

Validation Method

<Expert Group (Judgement Analysis)>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0030 <Full>

<SATISFIES> <Enabler> AOC-ATM-20 <Full>

<SATISFIES> <Enabler> SWIM-APS-04a <Full>

<ALLOCATED _TO> <Functional block> Flight Management N/A

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0060 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0070 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0020 <Full>
Requirement>

<ALLOCATED_TO> <Project> P11.01.03 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

[REQ]

Identifier REQ-11.01.03-TS-S1EF.1070

Requirement

The information provided by the Extended Flight Plan Update request
message shall be in accordance with WS-N WSDL and XSD format.

Title EFPL update via SWIM

Status <In Progress>

Rationale SWIM-TI binding: REQ-14.01.04-TS-0901.0304
Category <Interface>

Validation Method

<Expert Group (Judgement Analysis)>

Verification Method

<Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>
<SATISFIES>

<SATISFIES>

Linked Element Type
<ATMS Requirement>
<ATMS Requirement>
<Enabler>

<Enabler>

<Functional block>
<Information Exchange
Requirement>
<Information Exchange
Requirement>

Identifier
REQ-11.01.02-OSED-BMT1.0030
REQ-11.01.02-OSED-BMT2.0030
AOC-ATM-20

SWIM-APS-04a

Flight Management
IER-07.06.02-OSED-EFPL.0010

IER-07.06.02-OSED-EFPL.0060
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Compliance
<Full>
<Full>
<Full>
<Full>

N/A

<Full>

<Full>
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1221

1222
1223

1224
1225

1226
1227

<SATISFIES>

<Information Exchange IER-07.06.02-OSED-EFPL.0070 <Full>
Requirement>

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>
[REQ]

Identifier REQ-11.01.03-TS-S1EF.1075

Requirement

The information provided by the Extended Flight Plan Validation request
message shall be in accordance with WS-N WSDL and XSD format.

Title EFPL validation via SWIM

Status <In Progress>

Rationale SWIM-TI binding: REQ-14.01.04-TS-0901.0304

Category <Interface>

Validation Method <Expert Group (Judgement Analysis)>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0030 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0030 <Full>

<SATISFIES> <Enabler> AOC-ATM-20 <Full>

<SATISFIES> <Enabler> SWIM-APS-04a <Full>

<ALLOCATED_TO> <Functional block> Flight Management N/A

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0060 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0070 <Full>
Requirement>

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

[REQ]

Identifier REQ-11.01.03-TS-S1BT.1010

Requirement The FOC system shall receive ATC Reply messages from the ATC system.

Title Reception of ATC reply

Status <In Progress>

Rationale Upon publication of a trajectory proposal to the ATC system it is expected to

get an ATC Reply message in return. This data is directly linked to the flight
for which a trajectory has been send to the ATC system.

Category <Interface>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0040 <Partial>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0060 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0110 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0180 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT1.0040 <Partial>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0060 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0110 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-BMT2.0180 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<SATISFIES> <Enabler> AOC-ATM-20 <Full>

<ALLOCATED_TO> <Functional block> Flight Management N/A

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0020 <Full>
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Requirement>

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A

3.9.2 Operations Management
N/A

3.9.3 Decision Support Management

N/A

3.9.4 Data Management

N/A

3.9.5 Communication Management

N/A

3.9.6 Flight Deck Management

N/A
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1245
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1247
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4 Assumptions

As already mentioned in Section 1.5, this Technical Specification has been produced in parallel to the
WP11.01 Step 1 and Step 2 (as available) OSED [29] and before a mature draft of the WP11.01 Step
1 and Step 2 (as available) INTEROP [30] was available. This is however not seen as a major issue,
as all documents are produced by the same team of authors, therefore, it is ensured that the content
is synchronized and that within the individual documents references and traces to the respective other
documents are made in line with SJU guidelines wherever possible.

However, of course, there is a slight risk that during the review and/or assessment period some
changes in the OSED and/or the INTEROP might become necessary. In that case, these changes
could then not be respected in the Technical Specification anymore due to the deliverable schedule,
which foresees a handover date for the OSED and the INTEROP after the handover date for this TS.

“ £> Avenue de Cortenbergh 100 | B -1000 Bruxelles

"ﬂ‘ WwWW Sesarnu.eu 84 of 145

©OSESAR JOINT UNDERTAKING, 2015. Created by Lufthansa Systems, Sabre Airline Solutions, and Honeywell for the
SESAR Joint Undertaking within the frame of the SESAR Programme co-financed by the EU and EUROCONTROL. Reprint
with approval of publisher and the source properly acknowledged



1249

1250
1251

1252
1253
1254

1255
1256
1257

1258
1259

1260
1261

1262

1263
1264
1265
1266

1267
1268
1269
1270
1271
1272

1273
1274
1275
1276

1277
1278
1279
1280
1281

1282
1283
1284
1285
1286
1287

1288
1289
1290
1291

Project Number 11.01.03 Edition 02.00.00
D24 - D24 - D11 1 3-TS - Technical Specification Step 1 and Step 2 for FOC System - Edition
02.00.00

5 References

[1]

(2]

(3]

[4]

(5]

[6]
[7]

8]

[9]

Template Toolbox 03.00.00
https://extranet.sesarju.eu/Programme%20Library/SESAR%20Template%20Toolbox.dot

Requirements and V&V Guidelines 03.00.00
https://extranet.sesarju.eu/Programme%20Library/Requirements%20and%20VV%20Guidelin
es.doc

Templates and Toolbox User Manual 03.00.00
https://extranet.sesarju.eu/Programme%20Library/Templates%20and%20Toolbox%20User%
20Manual.doc

EUROCONTROL ATM Lexicon
https://extranet.eurocontrol.int/http://atmlexicon.eurocontrol.int/en/index.php/SESAR

SESAR Definition Phase — Task 2.4.x Milestone 3 — System Architecture (DLT-0612-244-00-
10), September 2007

IEEE / MIL Standards

P11.01.03 - D19 - Civil AU Operations Centre Technical Architecture Description (TAD),
Edition 00.01.00

https://extranet.sesarju.eu/WP_11FW/Project 11.01.03/Project%20PIlan/Deliverables/P11.01.
03%20-%20D19%20-%20Civil%20AU%200perations%20Centre%20TAD 00.01.00.doc

PB.04.02 - D106 - Transition ConOps SESAR 2020 - Consolidated deliverable with
contribution from Operational Federating Projects, Edition 00.01.00
https://extranet.sesarju.eu/WP_B/Project B.04.02/Project%20PIlan/ConOps/ConOps/Transitio
N%20Con0Ops%20SESAR%202020%20-
%20Consolidated%20deliverable%20with%20contribution%20from%200perational%20Feder
ating%20Projects.docx

PB.04.03 - D98 - ADD SESAR 2020 Transition edition, Edition 00.04.02
https://extranet.sesarju.eu/WP_B/Project B.04.03/Project%20Plan/ADD%20SESAR2020%20
Transition%20edition/D98--ADD%20SESAR%202020%20Transition%20edition%20-
%20V00.04.02.doc

[10]P04.07.02 - D37 - Free Route Operational Service and Environment Definition (OSED) for

Step 1 - Iteration 2, Edition 00.02.00

https://extranet.sesarju.eu/WP_04/Project 04.07.02/Project%20Plan/Submitted%20Deliverabl
es/P04.07.02%20Free%20Route%200SED%20Iteration%202/04.07.02-
D37%20Free%20Route%200SED 2 v00.02.01a clean.docx

[11]P04.07.02 - D63 - Free Route Safety and Performance Requirements (SPR) for Step 1,

Edition 00.00.06¢
https://extranet.sesarju.eu/releasehome/OFA03.01.03/Working%20Library/OFA%2003.01.03
%20Deliverables/OFA%20SPR%20Step%201/04.07.02-
D63%20Free%20Route%20Safety%20and%20Performances%20Requirements%20(SPR)%
20for%20Step%201%20v00.00.06c.docx

[12]P07.06.02 - D45 - Step 1 Business trajectory OSED 2015 update, Edition 00.04.00

https://extranet.sesarju.eu/WP_07/Project 07.06.02/Project%20Plan/Trajectory-
Step%201/BT%200SED/Edition%204.0%20-%20D45/07%2006%2002%20-D45-
Step%201%20Business%20trajectory%200SED%202015%20update.docx

foaunding mambers

ELERAPLRS (s

&> Avenue de Cortenbergh 100 | B -1000 Bruxelles
W SESANU. e 85 of 145

©OSESAR JOINT UNDERTAKING, 2015. Created by Lufthansa Systems, Sabre Airline Solutions, and Honeywell for the
SESAR Joint Undertaking within the frame of the SESAR Programme co-financed by the EU and EUROCONTROL. Reprint
with approval of publisher and the source properly acknowledged


https://extranet.sesarju.eu/Programme%20Library/SESAR%20Template%20Toolbox.dot
https://extranet.sesarju.eu/Programme%20Library/Requirements%20and%20VV%20Guidelines.doc
https://extranet.sesarju.eu/Programme%20Library/Requirements%20and%20VV%20Guidelines.doc
https://extranet.sesarju.eu/Programme%20Library/Templates%20and%20Toolbox%20User%20Manual.doc
https://extranet.sesarju.eu/Programme%20Library/Templates%20and%20Toolbox%20User%20Manual.doc
https://extranet.eurocontrol.int/http:/atmlexicon.eurocontrol.int/en/index.php/SESAR
https://extranet.sesarju.eu/WP_11FW/Project_11.01.03/Project%20Plan/Deliverables/P11.01.03%20-%20D19%20-%20Civil%20AU%20Operations%20Centre%20TAD_00.01.00.doc
https://extranet.sesarju.eu/WP_11FW/Project_11.01.03/Project%20Plan/Deliverables/P11.01.03%20-%20D19%20-%20Civil%20AU%20Operations%20Centre%20TAD_00.01.00.doc
https://extranet.sesarju.eu/WP_B/Project_B.04.02/Project%20Plan/ConOps/ConOps/Transition%20ConOps%20SESAR%202020%20-%20Consolidated%20deliverable%20with%20contribution%20from%20Operational%20Federating%20Projects.docx
https://extranet.sesarju.eu/WP_B/Project_B.04.02/Project%20Plan/ConOps/ConOps/Transition%20ConOps%20SESAR%202020%20-%20Consolidated%20deliverable%20with%20contribution%20from%20Operational%20Federating%20Projects.docx
https://extranet.sesarju.eu/WP_B/Project_B.04.02/Project%20Plan/ConOps/ConOps/Transition%20ConOps%20SESAR%202020%20-%20Consolidated%20deliverable%20with%20contribution%20from%20Operational%20Federating%20Projects.docx
https://extranet.sesarju.eu/WP_B/Project_B.04.02/Project%20Plan/ConOps/ConOps/Transition%20ConOps%20SESAR%202020%20-%20Consolidated%20deliverable%20with%20contribution%20from%20Operational%20Federating%20Projects.docx
https://extranet.sesarju.eu/WP_B/Project_B.04.03/Project%20Plan/ADD%20SESAR2020%20Transition%20edition/D98--ADD%20SESAR%202020%20Transition%20edition%20-%20V00.04.02.doc
https://extranet.sesarju.eu/WP_B/Project_B.04.03/Project%20Plan/ADD%20SESAR2020%20Transition%20edition/D98--ADD%20SESAR%202020%20Transition%20edition%20-%20V00.04.02.doc
https://extranet.sesarju.eu/WP_B/Project_B.04.03/Project%20Plan/ADD%20SESAR2020%20Transition%20edition/D98--ADD%20SESAR%202020%20Transition%20edition%20-%20V00.04.02.doc
https://extranet.sesarju.eu/WP_04/Project_04.07.02/Project%20Plan/Submitted%20Deliverables/P04.07.02%20Free%20Route%20OSED%20Iteration%202/04.07.02-D37%20Free%20Route%20OSED_2_v00.02.01a_clean.docx
https://extranet.sesarju.eu/WP_04/Project_04.07.02/Project%20Plan/Submitted%20Deliverables/P04.07.02%20Free%20Route%20OSED%20Iteration%202/04.07.02-D37%20Free%20Route%20OSED_2_v00.02.01a_clean.docx
https://extranet.sesarju.eu/WP_04/Project_04.07.02/Project%20Plan/Submitted%20Deliverables/P04.07.02%20Free%20Route%20OSED%20Iteration%202/04.07.02-D37%20Free%20Route%20OSED_2_v00.02.01a_clean.docx
https://extranet.sesarju.eu/releasehome/OFA03.01.03/Working%20Library/OFA%2003.01.03%20Deliverables/OFA%20SPR%20Step%201/04.07.02-D63%20Free%20Route%20Safety%20and%20Performances%20Requirements%20(SPR)%20for%20Step%201%20v00.00.06c.docx
https://extranet.sesarju.eu/releasehome/OFA03.01.03/Working%20Library/OFA%2003.01.03%20Deliverables/OFA%20SPR%20Step%201/04.07.02-D63%20Free%20Route%20Safety%20and%20Performances%20Requirements%20(SPR)%20for%20Step%201%20v00.00.06c.docx
https://extranet.sesarju.eu/releasehome/OFA03.01.03/Working%20Library/OFA%2003.01.03%20Deliverables/OFA%20SPR%20Step%201/04.07.02-D63%20Free%20Route%20Safety%20and%20Performances%20Requirements%20(SPR)%20for%20Step%201%20v00.00.06c.docx
https://extranet.sesarju.eu/releasehome/OFA03.01.03/Working%20Library/OFA%2003.01.03%20Deliverables/OFA%20SPR%20Step%201/04.07.02-D63%20Free%20Route%20Safety%20and%20Performances%20Requirements%20(SPR)%20for%20Step%201%20v00.00.06c.docx
https://extranet.sesarju.eu/WP_07/Project_07.06.02/Project%20Plan/Trajectory-Step%201/BT%20OSED/Edition%204.0%20-%20D45/07%2006%2002%20-D45-Step%201%20Business%20trajectory%20OSED%202015%20update.docx
https://extranet.sesarju.eu/WP_07/Project_07.06.02/Project%20Plan/Trajectory-Step%201/BT%20OSED/Edition%204.0%20-%20D45/07%2006%2002%20-D45-Step%201%20Business%20trajectory%20OSED%202015%20update.docx
https://extranet.sesarju.eu/WP_07/Project_07.06.02/Project%20Plan/Trajectory-Step%201/BT%20OSED/Edition%204.0%20-%20D45/07%2006%2002%20-D45-Step%201%20Business%20trajectory%20OSED%202015%20update.docx

1292
1293
1294
1295

1296
1297
1298
1299
1300
1301
1302

1303
1304
1305
1306
1307

1308
1309
1310
1311

1312
1313
1314

1315
1316
1317

1318
1319
1320
1321

1322
1323
1324

1325
1326
1327
1328

1329
1330
1331

1332
1333
1334
1335

1336
1337

Project Number 11.01.03 Edition 02.00.00
D24 - D24 - D11 1 3-TS - Technical Specification Step 1 and Step 2 for FOC System - Edition
02.00.00
[13]P07.06.02 - D74 - User Driven Prioritisation Process (UDPP) Step 2 V2 Interim OSED,
Edition 00.01.00
https://extranet.sesarju.eu/WP_07/Project 07.06.02/Project%20Plan/UDPP-
Step%202/0SED/07-06-02-D74-UDPP%20Step%202%20V2-Interim%200SED.docx

[14]P09.01 - DO1 - Aircraft and System Performance and Functional requirements -step 1 (WAL1),
Edition 1.3
https://extranet.sesarju.eu/WP_09/Project 09.01/Project%20Plan/05%20-
9%20Deliverables/09.01.D01%20Aircraft%20and%20System%20Performance%20and%20Fu
nctional%20requirements/09.01.D01-
Aircraft%20and%20System%20Peformance%20and%20Functional%20requirements%20-
step%201%20(WA1).doc

[15]P09.48 - DO5 - Validation Report for AIS/MET Services and Data distribution, Edition 02.00.00
https://extranet.sesarju.eu/WP_09/Project 09.48/Project%20Plan/Deliverables%20final%20v
ersions/09.48-D05-
Validation%20Report%20for%20AIS%20MET%20Services%20and%20Data%20Distribution.
doc

[16]P09.48 - D08 - Functional Requirement Document on AIS/MET Services and Data
Distribution, Edition 02.00.00
https://extranet.sesarju.eu/WP_09/Project 09.48/Project%20Plan/Deliverables%20final%20v
ersions/09.48-D08-Functional%20Requirements%20Document%20Update.docx

[17]P09.48 - DO9 - High Level Architecture Document, Edition 02.00.00
https://extranet.sesarju.eu/WP_09/Project 09.48/Project%20Plan/Deliverables%20final%20v
ersions/09.48-D09-High%20Level%20Architecture.docx

[18]P13.02.02 - D118 - OSED - Digital Integrated Briefing, Edition 00.00.01
https://extranet.sesarju.eu/WP_13/Project 13.02.02/Project%20Plan/Final%20Deliverables/1
3.02.02-D118-OSED v0.1.doc

[19]P11.01.03 - DO1 - Step 1 Use Cases and System requirements for FOC system, Edition
00.00.21
https://extranet.sesarju.eu/WP_11FW/Project 11.01.03/Project%20Plan/Deliverables/D11%2
001%2003-1-20130321.doc

[20]P11.01.03 - DO7 - BMT (FOC) Step 2 Technical Specification, Edition 01.00.00
https://extranet.sesarju.eu/WP_11FW/Project 11.01.03/Project%20PIlan/Deliverables/D07%2
0-%20D11.1.3-2ca-BMT%20-%20Edition%2001.00.00%20Technical%20Specification.docx

[21]P11.01.03 - D10 - EFPL (FOC) Step 1 Technical Specification, Edition 00.01.02
https://extranet.sesarju.eu/WP_11FW/Project 11.01.03/Project%20PIlan/Deliverables/D10%2
0-%20D11.1.3-2ca-EFPL%20-
%20EFPL%20(FOC)%20Step%201%20Technical%20Specification v00.01.02.doc

[22]P11.01.03 - D13 - FR (FOC) Step 1 Technical Specification, Edition 00.00.04
https://extranet.sesarju.eu/WP_11FW/Project 11.01.03/Project%20PIlan/Deliverables/D11%2
01%203-2ca-FR%20-%20FR%20(FOC)%20Step%201%20Technical%20Specification.doc

[23]P11.01.03 - D06 - AFUA (FOC) Step 1 Technical Specification, Edition 00.02.00
https://extranet.sesarju.eu/WP_11FW/Project 11.01.03/Project%20Plan/Deliverables/D06%2
0-%20D11%201%203-2ca-AFUA%20-
%20Edition%2000.02.00%20Technical%20Specification.doc

[24]P11.01.03 - D22 - FMS Weather Uplink Step 1 Technical Specification, Edition 00.01.00
https://extranet.sesarju.eu/WP_11FW/Project 11.01.03/Project%20Plan/Deliverables/D11%2

foaunding mambers

“ &> Avenue de Cortenbergh 100 | B -1000 Bruxelles

WWW . Sesa "jl].l.'"."l.J 86 of 145

©OSESAR JOINT UNDERTAKING, 2015. Created by Lufthansa Systems, Sabre Airline Solutions, and Honeywell for the
SESAR Joint Undertaking within the frame of the SESAR Programme co-financed by the EU and EUROCONTROL. Reprint
with approval of publisher and the source properly acknowledged


https://extranet.sesarju.eu/WP_07/Project_07.06.02/Project%20Plan/UDPP-Step%202/OSED/07-06-02-D74-UDPP%20Step%202%20V2-Interim%20OSED.docx
https://extranet.sesarju.eu/WP_07/Project_07.06.02/Project%20Plan/UDPP-Step%202/OSED/07-06-02-D74-UDPP%20Step%202%20V2-Interim%20OSED.docx
https://extranet.sesarju.eu/WP_09/Project_09.01/Project%20Plan/05%20-%20Deliverables/09.01.D01%20Aircraft%20and%20System%20Performance%20and%20Functional%20requirements/09.01.D01-Aircraft%20and%20System%20Peformance%20and%20Functional%20requirements%20-step%201%20(WA1).doc
https://extranet.sesarju.eu/WP_09/Project_09.01/Project%20Plan/05%20-%20Deliverables/09.01.D01%20Aircraft%20and%20System%20Performance%20and%20Functional%20requirements/09.01.D01-Aircraft%20and%20System%20Peformance%20and%20Functional%20requirements%20-step%201%20(WA1).doc
https://extranet.sesarju.eu/WP_09/Project_09.01/Project%20Plan/05%20-%20Deliverables/09.01.D01%20Aircraft%20and%20System%20Performance%20and%20Functional%20requirements/09.01.D01-Aircraft%20and%20System%20Peformance%20and%20Functional%20requirements%20-step%201%20(WA1).doc
https://extranet.sesarju.eu/WP_09/Project_09.01/Project%20Plan/05%20-%20Deliverables/09.01.D01%20Aircraft%20and%20System%20Performance%20and%20Functional%20requirements/09.01.D01-Aircraft%20and%20System%20Peformance%20and%20Functional%20requirements%20-step%201%20(WA1).doc
https://extranet.sesarju.eu/WP_09/Project_09.01/Project%20Plan/05%20-%20Deliverables/09.01.D01%20Aircraft%20and%20System%20Performance%20and%20Functional%20requirements/09.01.D01-Aircraft%20and%20System%20Peformance%20and%20Functional%20requirements%20-step%201%20(WA1).doc
https://extranet.sesarju.eu/WP_09/Project_09.48/Project%20Plan/Deliverables%20final%20versions/09.48-D05-Validation%20Report%20for%20AIS%20MET%20Services%20and%20Data%20Distribution.doc
https://extranet.sesarju.eu/WP_09/Project_09.48/Project%20Plan/Deliverables%20final%20versions/09.48-D05-Validation%20Report%20for%20AIS%20MET%20Services%20and%20Data%20Distribution.doc
https://extranet.sesarju.eu/WP_09/Project_09.48/Project%20Plan/Deliverables%20final%20versions/09.48-D05-Validation%20Report%20for%20AIS%20MET%20Services%20and%20Data%20Distribution.doc
https://extranet.sesarju.eu/WP_09/Project_09.48/Project%20Plan/Deliverables%20final%20versions/09.48-D05-Validation%20Report%20for%20AIS%20MET%20Services%20and%20Data%20Distribution.doc
https://extranet.sesarju.eu/WP_09/Project_09.48/Project%20Plan/Deliverables%20final%20versions/09.48-D08-Functional%20Requirements%20Document%20Update.docx
https://extranet.sesarju.eu/WP_09/Project_09.48/Project%20Plan/Deliverables%20final%20versions/09.48-D08-Functional%20Requirements%20Document%20Update.docx
https://extranet.sesarju.eu/WP_09/Project_09.48/Project%20Plan/Deliverables%20final%20versions/09.48-D09-High%20Level%20Architecture.docx
https://extranet.sesarju.eu/WP_09/Project_09.48/Project%20Plan/Deliverables%20final%20versions/09.48-D09-High%20Level%20Architecture.docx
https://extranet.sesarju.eu/WP_13/Project_13.02.02/Project%20Plan/Final%20Deliverables/13.02.02-D118-OSED_v0.1.doc
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https://extranet.sesarju.eu/WP_11FW/Project_11.01.03/Project%20Plan/Deliverables/D11%2001%2003-1-20130321.doc
https://extranet.sesarju.eu/WP_11FW/Project_11.01.03/Project%20Plan/Deliverables/D11%2001%2003-1-20130321.doc
https://extranet.sesarju.eu/WP_11FW/Project_11.01.03/Project%20Plan/Deliverables/D07%20-%20D11.1.3-2ca-BMT%20-%20Edition%2001.00.00%20Technical%20Specification.docx
https://extranet.sesarju.eu/WP_11FW/Project_11.01.03/Project%20Plan/Deliverables/D07%20-%20D11.1.3-2ca-BMT%20-%20Edition%2001.00.00%20Technical%20Specification.docx
https://extranet.sesarju.eu/WP_11FW/Project_11.01.03/Project%20Plan/Deliverables/D10%20-%20D11.1.3-2ca-EFPL%20-%20EFPL%20(FOC)%20Step%201%20Technical%20Specification_v00.01.02.doc
https://extranet.sesarju.eu/WP_11FW/Project_11.01.03/Project%20Plan/Deliverables/D10%20-%20D11.1.3-2ca-EFPL%20-%20EFPL%20(FOC)%20Step%201%20Technical%20Specification_v00.01.02.doc
https://extranet.sesarju.eu/WP_11FW/Project_11.01.03/Project%20Plan/Deliverables/D10%20-%20D11.1.3-2ca-EFPL%20-%20EFPL%20(FOC)%20Step%201%20Technical%20Specification_v00.01.02.doc
https://extranet.sesarju.eu/WP_11FW/Project_11.01.03/Project%20Plan/Deliverables/D11%201%203-2ca-FR%20-%20FR%20(FOC)%20Step%201%20Technical%20Specification.doc
https://extranet.sesarju.eu/WP_11FW/Project_11.01.03/Project%20Plan/Deliverables/D11%201%203-2ca-FR%20-%20FR%20(FOC)%20Step%201%20Technical%20Specification.doc
https://extranet.sesarju.eu/WP_11FW/Project_11.01.03/Project%20Plan/Deliverables/D06%20-%20D11%201%203-2ca-AFUA%20-%20Edition%2000.02.00%20Technical%20Specification.doc
https://extranet.sesarju.eu/WP_11FW/Project_11.01.03/Project%20Plan/Deliverables/D06%20-%20D11%201%203-2ca-AFUA%20-%20Edition%2000.02.00%20Technical%20Specification.doc
https://extranet.sesarju.eu/WP_11FW/Project_11.01.03/Project%20Plan/Deliverables/D06%20-%20D11%201%203-2ca-AFUA%20-%20Edition%2000.02.00%20Technical%20Specification.doc
https://extranet.sesarju.eu/WP_11FW/Project_11.01.03/Project%20Plan/Deliverables/D11%201%203-2ca-WUF%20FMS%20Weather%20Uplink%20Step%201%20Technical%20Specification.doc

1338
1339

1340
1341
1342
1343
1344

1345
1346
1347
1348
1349
1350

1351
1352
1353
1354
1355
1356

1357
1358
1359

1360
1361
1362
1363
1364
1365
1366

1367
1368
1369
1370
1371

1372
1373

1374
1375

1376

1377
1378

Project Number 11.01.03 Edition 02.00.00
D24 - D24 - D11 1 3-TS - Technical Specification Step 1 and Step 2 for FOC System - Edition
02.00.00

01%203-2ca-

WUF%20FMS%20W eather%20Uplink%20Step%201%20Technical%20Specification.doc

[25]P11.01.03 - D21 - TS Stepl and Step 2 as available for FOC system Sabre, Edition 00.00.30
https://extranet.sesarju.eu/WP_11FW/Project 11.01.03/Project%20PIlan/Deliverables/D11%2
01%203-2ca-EFPL-AIM-UDPP-
FR%20TS%20Step1%20and%20Step%202%20as%20available%20for%20FOC%20system
Sabre.doc

[26]P11.01.03 - D21 - TS Stepl and Step 2 as available for FOC system Honeywell, Edition
00.00.05
https://extranet.sesarju.eu/WP_11FW/Project 11.01.03/Project%20Plan/Deliverables/D11%2
019%203-2ca-EFPL-AIM-UDPP-
FR%20TS%20Step1%20and%20Step%202%20as%20available%20for%20FOC%20system
HWY.docx

[27]P11.01.03 - D17 - System Interface Requirements Step 1 and 2 as available (AIM), Edition
00.00.03
https://extranet.sesarju.eu/WP_11FW/Project 11.01.03/Project%20PIlan/Deliverables/D11%2
01%203-3ca-
FOC%20System%20Interface%20Requirements%20Step%201%20and%202%20as%20avail
able%20(AIM).doc

[28]P11.01.01 - DO1 - DOD - Step 1 - Definition of trajectory requirements for step 1, Edition
00.00.04 https://extranet.sesarju.eu/WP_11FW/Project 11.01.01/Project%20Plan/03%20-
%20Deliverables/D11.01.01-1%20Edition%204.doc

[29]P11.01.02 - DO8 - Final FOC Step 1 and Step 2, as available, OSED
Note: This document is still in production at time of writing, link to version sent out for external
review:
https://extranet.sesarju.eu/WP_11FW/Project 11.01.02/Project%20Plan/03%20-
%20Deliverables/FOC/Step%202/D11.01.02-1cb-D08-
Final%20FOC%20Step%201%20and%20Step%202,%20as%20available,%200SED%20DC.
doc

[30]P11.01.02 - DO8 - Final FOC Step 1 and Step 2, as available, INTEROP
Note: This document is still in production at time of writing, link to latest version:
https://extranet.sesarju.eu/WP_11FW/Project 11.01.02/Project%20PIlan/03%20-
%20Deliverables/FOC/Step%202/D11.01.02-1¢cb-D0O8-
Final%20FOC%20Step%201%20and%20Step%202,%20as%20available,%20INTEROP.doc

[31]P11.01.02 - DO1 - FOC Safety and Performance Requirements (SPR) Step 1, Edition
00.01.00
https://extranet.sesarju.eu/WP_11FW/Project 11.01.02/Project%20Plan/03%20-
%20Deliverables/FOC/Step%201/D11.1.2-1%20SPR.doc

5.1 Use of copyright / patent material /classified material

5.1.1 Classified Material

There is no classified material included in this document.
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Appendix A Allocation of Requirements to Topics
A.1 Requirements for AFUA (Advanced Flexible Use of
Airspace)
e REQ-11.01.03-TS-S1AF.1005
e REQ-11.01.03-TS-S1NR.3010

e REQ-11.01.03-TS-S1AF.4005

A.2 Requirements for BMT (Business/Mission Trajectory)

e REQ-11.01.03-TS-S1TS.1005
e REQ-11.01.03-TS-S2TS.1005
e REQ-11.01.03-TS-S2TS.1010
e REQ-11.01.03-TS-S2NR.1005
e REQ-11.01.03-TS-S2NR.1010
e REQ-11.01.03-TS-S1NR.1010
e REQ-11.01.03-TS-S1TS.1010
e REQ-11.01.03-TS-S1TS.1015
e REQ-11.01.03-TS-S1TS.1020
e REQ-11.01.03-TS-S1TS.1025
e REQ-11.01.03-TS-S1EF.1005
e REQ-11.01.03-TS-S1EF.1010
e REQ-11.01.03-TS-S1EF.1015
e REQ-11.01.03-TS-S1EF.1020
e REQ-11.01.03-TS-S1EF.1025
e REQ-11.01.03-TS-S1EF.1030
e REQ-11.01.03-TS-S1EF.1035
e REQ-11.01.03-TS-S1EF.1040
e REQ-11.01.03-TS-S1INR.1015

e REQ-11.01.03-TS-S1TS.2005
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A.3 Requirements for EFPL (Extended Flight Plan)

REQ-11.01.03-TS-S1NR.3010
REQ-11.01.03-TS-S2NR.3005
REQ-11.01.03-TS-S2BT.3005
REQ-11.01.03-TS-S1TS.4005
REQ-11.01.03-TS-S1FR.1015
REQ-11.01.03-TS-S1EF.1055
REQ-11.01.03-TS-S1EF.5005
REQ-11.01.03-TS-S1EF.5010
REQ-11.01.03-TS-S2NR.1015
REQ-11.01.03-TS-S2BT.1005
REQ-11.01.03-TS-S1NR.1025
REQ-11.01.03-TS-S1NR.3015
REQ-11.01.03-TS-S1HT.5010
REQ-11.01.03-TS-S1BT.1005
REQ-11.01.03-TS-S1BT.1010
REQ-11.01.03-TS-S1EF.1065
REQ-11.01.03-TS-S1EF.1070

REQ-11.01.03-TS-S1EF.1075

REQ-11.01.03-TS-S1T7S.1010
REQ-11.01.03-TS-S1TS.1015
REQ-11.01.03-TS-S1TS.1020
REQ-11.01.03-TS-S1TS.1025
REQ-11.01.03-TS-S1EF.1005
REQ-11.01.03-TS-S1EF.1010
REQ-11.01.03-TS-S1EF.1015
REQ-11.01.03-TS-S1EF.1020

REQ-11.01.03-TS-S1EF.1025
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A.4 Requirements for Free Route

REQ-11.01.03-TS-S1EF.1030
REQ-11.01.03-TS-S1EF.1035
REQ-11.01.03-TS-S1EF.1040
REQ-11.01.03-TS-S1EF.1045
REQ-11.01.03-TS-S1EF.1050
REQ-11.01.03-TS-S1EF.1055
REQ-11.01.03-TS-S1EF.5010
REQ-11.01.03-TS-S1EF.1060
REQ-11.01.03-TS-S1BT.1005
REQ-11.01.03-TS-S1EF.1065
REQ-11.01.03-TS-S1EF.1070

REQ-11.01.03-TS-S1EF.1075

REQ-11.01.03-TS-S1FR.1005
REQ-11.01.03-TS-S1NR.1005
REQ-11.01.03-TS-S1FR.1010
REQ-11.01.03-TS-S1FR.4005
REQ-11.01.03-TS-S1FR.4010
REQ-11.01.03-TS-S1FR.4015
REQ-11.01.03-TS-S1FR.4020
REQ-11.01.03-TS-S1FR.4025
REQ-11.01.03-TS-S1FR.4030

REQ-11.01.03-TS-S1FR.1015

Edition 02.00.00

A.5 Requirements for UDPP (User Driven Prioritisation

Process)

REQ-11.01.03-TS-S1ST.2005
REQ-11.01.03-TS-S1ST.2010

REQ-11.01.03-TS-S1ST.2015
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A.6 Requirements for AIM (Aeronautical Information
Management)

REQ-11.01.03-TS-S1ST.2020
REQ-11.01.03-TS-S1NR.3005

REQ-11.01.03-TS-S2NR.2005

REQ-11.01.03-TS-S1HT.1005
REQ-11.01.03-TS-S1HT.1010
REQ-11.01.03-TS-S1NR.1020
REQ-11.01.03-TS-S1HT.4005
REQ-11.01.03-TS-S1HT.4010
REQ-11.01.03-TS-S1HT.4015
REQ-11.01.03-TS-S1NR.4005
REQ-11.01.03-TS-S1HT.4020
REQ-11.01.03-TS-S1HT.5005
REQ-11.01.03-TS-S1HT.5010

REQ-11.01.03-TS-S1T7S.4010

Edition 02.00.00

Related Interface Requirements can be found in a separate IRS document [27]

A.7 Requirements for HMI (Human Machine Interface)

REQ-11.01.03-TS-S1HT.1005
REQ-11.01.03-TS-S1HT.1010
REQ-11.01.03-TS-S1TS.1030
REQ-11.01.03-TS-S1TS.1035
REQ-11.01.03-TS-S1NR.1020
REQ-11.01.03-TS-S1EF.1045
REQ-11.01.03-TS-S1NR.1020
REQ-11.01.03-TS-S1EF.1050
REQ-11.01.03-TS-S1HT.4005

REQ-11.01.03-TS-S1HT.4010
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1493
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1496
1497
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Appendix B Deleted Requirements from WP11.01.03
Technical Specifications

B.1 FOC TS Specification Step 1

[REQ]

Identifier

REQ-11.01.03-TS-0105.0005

Requirement

The FOC system shall generate Nominal Preferred Route Information (NPR
Information), when the generation has been started in the NPR Data Entry
Control. Depending on Airspace Users’ processes and system capabilities
the generated NPR information shall include minimum:

Airline designator

Flight Number

Period of Operation

Days of Operation

Service Type

ICAO Aircraft Type

ICAO Code of Departure Airport

ICAO Airport of Destination Airport

Scheduled Time of Departure

Scheduled Time of Arrival

Statistical Blocktime

The FOC system shall store the Nominal Preferred Route Information and
report it to the Operator Console.

Title Nominal Preferred Route calculation

Status <Deleted>

Rationale Delete Reason: The concept of Nominal Preferred Route Information is
conflicting with the dynamic approaches of free route, AFUA etc. as a
nominal case cannot be pre-defined. Depending on Airspace Users’
processes and system capabilities, Nominal Preferred Route may be
provided with different levels of granularity.

Category <Functional>

Validation Method <Live Trial>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0001 <Partial>

[REQ]

Identifier REQ-11.01.03-TS-0105.0010

Requirement The FOC system shall calculate a 4D route when the EFPL Selector is
selected. The FOC system shall store the 4D Route to the Nominal
Preferred Route Information and report the Nominal Preferred Route
Information to the Operator Console.

Title 4D Route Calculation

Status <Deleted>

Rationale Delete Reason: The requirement is describing how to generate NPR data.
There would be several options to do that. The described one is only one of
them. Hence this requirement leaves the context of the TS document.
Depending on Airspace Users processes and system capabilities the type of
route may be provided as 4D route. The Nominal Preferred Route
Information must be stored and reported to the HMI. This provides the
Airspace User the possibility for verification of output and to do necessary
adaptions.

Category <Functional>
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1501

1502
1503

1504
1505

1506
1507

1508
1509

1510
1511
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Validation Method <Live Trial>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0005 <Partial>
[REQ]

Identifier REQ-11.01.03-TS-0105.0020

Requirement

The FOC shall calculate Flight Performance Data when the EFPL Flight
Performance Data Selector is selected, else it shall add the Gross Weight to
every routing point of the 4D trajectory and store this data to the Nominal
Preferred Route Information.

Title Flight Performance Data selection

Status <Deleted>

Rationale Delete Reason: This requirement is mixing different aspects. Besides the
NPR topic it covers EFPL related aspects. EFPL related aspects are
covered by requirements in chapter 3 of this document. NPR concept has
still not reached maturity in superior documents and can hence not be
worked out in this TS. Depending on the selection the Airspace User the
FOC system either adds the Flight Performance Data or the Gross Weight
to the Nominal Preferred Route Information.

Category <Functional>

Validation Method <Live Trial>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0005 <Partial>

[REQ]

Identifier REQ-11.01.03-TS-0255.0005

Requirement

The FOC system shall receive TTA messages from the Network Manager
and store them.

Title Receive TTA

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1TS.2005) /
wording harmonized. Flight Data Support Management is responsible for
evaluating, processing and distributing up-to date flight data. Once a flight
plan is filed to NM it could be that NM returns a TTA. The system must be
able to receive such a Target Time Constraint message.

Category <Functional>

Validation Method <Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>

[REQ]

Identifier REQ-11.01.03-TS-0255.0010

Requirement The FOC shall store ATM constraints.

Title Receive ATM constraints

Status <Deleted>

Rationale Delete Reason: Not necessary anymore as redundant with REQ-11.01.03-

TS-S1TS.4005. Planning constraints applied to a flight by ATM should be
processed and added to the FOC restriction database to be considered
during trajectory generation
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1512
1513

1514
1515

1516
1517

1518
1519

1520
1521

1522
1523

Category <Functional>

Validation Method <Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0055 <Partial>
[REQ]

Identifier REQ-11.01.03-TS-0305.0010

Requirement

The FOC system shall generate flight trajectory data according to all PTR
when selected with the PTR Selector.

Title PTR in trajectory generation

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1TS.1005) /
wording harmonized. The PTRs will be published by the NM manager to
improve the trip fuel generation in the FOC system. PTRs can be
considered directly, by adapting the generated vertical profile or indirectly by
considering additional fuel amount and not adapting the vertical profile.
PTRs must not be mandatorily considered in trajectory generation. If an
FOC includes the PTR functionality, it shall be possible to enable or disable
it.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0035 <Full>

[REQ]

Identifier REQ-11.01.03-TS-0305.0015

Requirement

The FOC system shall generate trajectories that fulfil TTA constraints
relevant for the respective flight when selected with the TTA Constraint
Selector.

Title TTA in Trajectory Generation

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S2TS.1005) /
wording harmonized. The FOC system shall consider TTAs throughout the
trajectory generation process if enabled by the Airspace User.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>

[REQ]

Identifier REQ-11.01.03-TS-0305.0020

Requirement The FOC system shall store all TTA/ CTA to the flight.

Title CTA flight recalculation

Status <Deleted>

Rationale Delete Reason: Content already covered by REQ-11.01.03-TS-S1TS.2005.
If a flight is affected by a CTA a recalculation will be needed to consider this
new input in the trajectory data. In case of an autonomous running FOC
system this action can be automatically started if selected.

Category <Functional>
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1530
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Validation Method

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Partial>
[REQ]

Identifier REQ-11.01.03-TS-0305.0022

Requirement

The FOC system shall trigger the trajectory generation process upon
reception of TTA/CTA when selected with the TTA/CTA Recalculation
Selector.

Title CTA flight calculation

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S2T7S.1010) /
wording harmonized. If a flight is affected by a CTA a recalculation will be
needed to consider this new input in the trajectory data. In case of an
autonomous running FOC system this action can be automatically stared if
selected.

Category <Functional>

Validation Method

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Partial>

[REQ]

Identifier REQ-11.01.03-TS-0305.0030

Requirement

The FOC shall generate EFPL based on FOC internal flight trajectory data
when selected with the EFPL selector.

Title EFPL generation

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1TS.1010).
The EFPL data is based on the trajectory generated by the FOC system.
The flight plan transmission functionality shall be able to use this data as
input for the flight plan message

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0025 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0020 <Full>

[REQ]

Identifier REQ-11.01.03-TS-0310.0010

Requirement

The FOC system shall send the EFPL only to ATC Units that are selected
with the EFPL ATC Accept selector.

Title Use of EFPL
Status <Deleted>
Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1TS.1015).

Not every ATC Authority or Network Manager is able to process a flight plan
in EFPL format. Therefore the EFPL shall only be send to ATC authorities/
Network Manager that request this type of flight plan. Furthermore the
Airspace User shall have the capability to decide whether the EFPL is sent
to respective ATC Authorities/ Network Manager or not.
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Category <Functional>
Validation Method
Verification Method <Test>
1536
1537 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0025 <Full>
1538
1539 [REQ]
Identifier REQ-11.01.03-TS-0310.0020
Requirement The FOC shall generate and attach Flight Performance Data to the
Extended Flight Plan when the EFPL Flight Performance Data Selector is
selected.
Title Data Generation
Status <Deleted>
Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1TS.1020).
Flight Performance Data is part of the Extended Flight Plan. The Flight
Performance Data must not necessarily be added to the Extended Flight
Plan. The Airspace User can decide whether Flight Performance Data is
exchanged with the Network Manager.
Category <Functional>
Validation Method
Verification Method <Test>
1540
1541 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0025 <Full>
1542
1543 [REQ]
Identifier REQ-11.01.03-TS-0310.0025
Requirement The FOC shall generate and attach Gross Weight information to every point
of the 4D profile in the EFPL if the EFPL Flight Performance Data selector is
not selected.
Title Gross Weight Information
Status <Deleted>
Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1TS.1025).
Performance Data are part of the Extended Flight Plan. The Performance
Data must not necessarily be added to the Extended Flight Plan. The
Airspace User disables the exchange of Performance Data with the Network
Manager the Gross Weight must be added to every point of the 4D profile.
Category <Functional>
Validation Method
Verification Method <Test>
1544
1545 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Regquirement> REQ-11.01.02-OSED-D001.0020 <Full>
| <SATISFIES> | <ATMS Requirement> | REQ-11.01.02-OSED-D001.0025 | <Full>
1546
1547 [REQ]
Identifier REQ-11.01.03-TS-0305.0025

Requirement

The FOC system shall return information to the HMI upon reception of
TTA/CTA if selected with the TTA/CTA Output Selector.

Title CTA flight indication
Status <Deleted>
Rationale Delete Reason: This requirement leaves the scope of the TS document. A

flight that is affected by a CTA must be indicated in the FOC system as the
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1552
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1556
1557
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1559
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flight dispatcher, in flight monitoring or the irregularly cost manager must
react on the new target time and recalculate the trajectory.

Category <Functional>

Validation Method

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Partial>
[REQ]

Identifier REQ-11.01.03-TS-0410.0020

Requirement

The FOC System shall calculate the surface out time when new de-icing
throughput information is received

Title Request Airport Capacity Data

Status <Deleted>

Rationale Delete Reason: Replaced with REQ-11.01.03-TS-S1NR.1010. In order to
support A-CDM and UDPP the FOC system must be up-to-date with the
latest airport capacity data. This is required to predict turnaround times and
passenger connection probability.

Category <Functional>

Validation Method <Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0120 <Full>

[REQ]

Identifier REQ-11.01.03-TS-0410.0025

Requirement

The FOC System shall calculate the surface out and surface in times when
new airport taxi time information is received.

Title Request Airport Taxi Data

Status <Deleted>

Rationale Delete Reason: Replaced with REQ-11.01.03-TS-S1NR.1010. In order to
support accurate turnaround planning, A-CDM and UDPP the FOC system
must be up-to-date with the latest airport taxi information.

Category <Functional>

Validation Method <Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0130 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0135 <Full>

[REQ]

Identifier REQ-11.01.03-TS-0410.0030

Requirement

The FOC System shall calculate the surface out and surface in times when
new gate assignments are received

Title Request Gate Assignments and Parking Positions

Status <Deleted>

Rationale Delete Reason: Replaced with REQ-11.01.03-TS-S1NR.1010. In order to
support accurate turnaround planning, A-CDM and UDPP the FOC system
must be up-to-date with the latest gate assignments and parking position
information.

Category <Functional>

Validation Method

<Shadow Mode>
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| Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0140 <Full>

[REQ]

Identifier REQ-11.01.03-TS-0505.0005

Requirement The FOC System shall store ATM constraints upon receipt from the Network
Manager.

Title Receive ATM constraints

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1TS.4005) /
wording harmonized. The FOC system stores received ATM
constraints/restrictions in its internal database where it is available for
retrieval by other FOC system components (e.g. Trajectory Generator)

Category <Functional>

Validation Method

<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<ALLOCATED_TO> <Functional block> Information and Communication N/A
Management

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0055 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Partial>

[REQ]

Identifier REQ-11.01.03-TS-0510.0004

Requirement

The FOC System shall store Upper Air Data Request upon receipt from the
aircraft.

Title Storing of Upper Air Data Request.

Status <Deleted>

Rationale Delete Reason: The Request must not necessarily be saved; the focus is on
the reaction of the FOC (see deleted REQ-11.01.03-TS-0510.0005 below).
The FOC system must be able to receive Upper Air Data requests sent from
aircraft and store them in the internal storage for later response generation.

Category <Functional>

Validation Method

<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<ALLOCATED_TO> <Functional block> Information and Communication N/A
Management

<SATISFIES> <ATMS Requirement> FRD-INITIAL4D-846 <Partial>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0155 <Full>

[REQ]

Identifier REQ-11.01.03-TS-0510.0005

Requirement

The FOC System shall send Upper Air Data Response to the aircraft
triggered by the previously storage of Upper Air Data Request.

Title Sending of Upper Air Data Response.
Status <Deleted>
Rationale Delete Reason: The content is covered by the requirements in the WUF TS

document, whose requirements are not included in here. The FOC system
shall generate Upper Air Data responses which include subsets of winds
(direction and speed) and temperatures for subsets of flight phases based

foaunding mambers

B <

Avenue de Cortenbergh 100
'.'.-".'.-".'.-'.5'—:(!5‘-:».’-'!"jl].l.'"."l.J

B -1000 Bruxelles
99 of 145

©OSESAR JOINT UNDERTAKING, 2015. Created by Lufthansa Systems, Sabre Airline Solutions, and Honeywell for the
SESAR Joint Undertaking within the frame of the SESAR Programme co-financed by the EU and EUROCONTROL. Reprint
with approval of publisher and the source properly acknowledged




1572
1573

1574
1575

1576
1577

1578
1579

1580
1581

on content of the request for Upper Air Data sent by aircraft.

Category

<Functional>

Validation Method

<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<ALLOCATED_TO> <Functional block> Information and Communication N/A
Management

<SATISFIES> <ATMS Requirement> FRD-INITIAL4D-846 <Partial>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0155 <Full>

[REQ]

Identifier REQ-11.01.03-TS-0510.0010

Requirement

The FOC System shall send error message in selected ARINC standard to
the aircraft instead of Upper Air Data Response when the Upper Air Data
Request is not valid.

Title

Error message for invalid Upper Air Data request.

Status

<Deleted>

Rationale

Delete Reason: Error handling is rather a matter of how something is
implemented. It is not part of the SESAR concept. Every aircraft requesting
Upper Air Data should have valid flight plan in the FOC system and
requested waypoints have to be known to FOC system too otherwise it is
not able to process request. Flight Crew should be notified about failure of
weather uplink by error message. Error message format is based on
selected ARINC standard (e.g. ARINC 702 or ARINC 633)..

Category

<Functional>

Validation Method

<Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<ALLOCATED_TO> <Functional block> Information and Communication N/A
Management

<SATISFIES> <ATMS Requirement> FRD-INITIAL4D-846 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0155 <Full>

[REQ]

Identifier REQ-11.01.03-TS-0510.0015

Requirement

FOC System shall send error message in selected ARINC standard to the
aircraft instead of Upper Air Data Response in case that Upper Air Data are
not available.

Title Error message for missing Upper Air Data.

Status <Deleted>

Rationale Delete Reason: Error handling is rather a matter of how something is
implemented. It is not part of the SESAR concept. In case that FOC system
does not have corresponding weather data prediction, error message is sent
to Flight Crew so that it knows about unsuccessful weather update. Error
message format is based on selected ARINC standard. (e.g. ARINC 702 or
ARINC 633).

Category <Functional>

Validation Method <Real Time Simulation>

Verification Method <Test>

[REQ Trace]
Relationship
<ALLOCATED_TO>

<SATISFIES>
<SATISFIES>
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1582
1583

1584
1585

1586
1587

1588
1589

1590
1591

[REQ]

Identifier

REQ-11.01.03-TS-0730.0005

Requirement

The FOC system shall expect an acknowledgement of correct reception
from the Network Manager when a message has been sent and the Timeout
Selector is selected. The timespan of the timeout shall be defined by the
Timeout Selector.

Title Loss of information — Timeouts and retries

Status <Deleted>

Rationale Delete Reason: This requirement leaves the scope of the TS document.
Messages may be lost on the network of suffer from long delays. To cope
with this the FOC system may expect an acknowledgment. On timeouts, the
FOC system must assume the message was not received and retransmit it.
In case of a permanently broken link, the retransmission has no effect so
the retransmission is limited. Exceeding the retry limit is considered an
error.

Category <Interface>

Validation Method

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0025 <Partial>

[REQ]

Identifier REQ-11.01.03-TS-0730.0010

Requirement

The FOC system shall report an error to the Operator Console when the
number of retransmissions has been exceeded. The number of
retransmission shall be defined by the Retransmission Selector.

Title Retransmission on timeouts

Status <Deleted>

Rationale Delete Reason: This requirement leaves the scope of the TS document.
Messages may be lost on the network of suffer from long delays. To cope
with this the FOC system may expect an acknowledgment. On timeouts, the
FOC system must assume the message was not received and retransmit it.
In case of a permanently broken link, the retransmission has no effect so
the retransmission is limited. Exceeding the retry limit is considered an
error.

Category <Interface>

Validation Method

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0025 <Partial>

[REQ]

Identifier REQ-11.01.03-TS-0730.0015

Requirement

The FOC system shall generate the EFPL messages that shall be send to
the NM according to the data requirements defined for the EUROCONTROL
Extended Flight Plan Service

Title Interoperability of EFPL data
Status <Deleted>
Rationale Delete Reason: Not necessary anymore as redundant with multiple

requirements in chapter 3. The EFPL that is exchanged with the NM
manager must include all information required in the definition of the
EUROCONTROL Extended Flight Plan Service and comply with the
requirements given in regard to accuracy, units and formats.
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1592
1593

1594
1595

1596
1597

1598
1599

1600
1601

1602
1603

Category <Interoperability>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.00020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.00025 <Full>
[REQ]

Identifier REQ-11.01.03-TS-0730.0020

Requirement

The FOC shall be able to receive Flight Plan reply messages in EFPL
format sent by the Network Manager.

Title Reply Message

Status <Deleted>

Rationale Delete Reason: Not necessary anymore as redundant with REQ-11.01.03-
TS-S1EF.1025. If a flight plan was transmitted, the ATC Authority/ Network
Manager will return a reply. This message may contain
A flight plan validation reply
Route proposal

Category <Functional>

Validation Method

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.00020 <Partial>

[REQ]

Identifier REQ-11.01.03-TS-0510.0025

Requirement

The FOC system should implement ARINC 702 standard for Upper Air Data
Request and Response formatting.

Title Upper Air Data message formatting

Status <Deleted>

Rationale Delete Reason: The requirement has been identified as superfluous in an
internal review process as it contains no changes compared to the current
operating method. ARINC 702 is current industry standard for Upper Air
Data exchange between FOC system and aircraft FMS via ACARS.
Implementation of another standard in aircraft FMS is not envisioned for
Step 1.

Category <Interoperability>

Validation Method

<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<ALLOCATED_TO> <Functional block> Information and Communication N/A
Management

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0155 <Full>

[REQ]

Identifier REQ-11.01.03-TS-0710.0005

Requirement The FOC system shall use UTC time as reference.

Title Align air and ground times

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1TS.4010).

The time reference for the air and the ground systems may vary. To ensure
that the data obtained from the a/c can be mixed with the ground data for
other flights there is a need to ensure that UTC time reference is used by all
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1604
1605

1606
1607

1608
1609

1610
1611

1612
1613

air and ground systems.

Category <Performance>

Validation Method

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> TBD

[REQ]

Identifier REQ-11.01.03-TS-0735.0005

Requirement

The FOC system shall have a Human Machine Interface (HMI) that is used
to enter Selectors and set Trigger to start FOC system functions.

Title Human Machine Interface

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1TS.1030).
The FOC system will be operated by human beings that will manually start
and stop different functions or define input parameters that are used for the
system automation.

Category <HMI>

Validation Method

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0010 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0015 <Full>

<SATISFIES> <ATMS Regquirement> REQ-11.01.02-OSED-D001.0020 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0025 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0030 <Full>

<SATISFIES> <ATMS Regquirement> REQ-11.01.02-OSED-D001.0040 <Full>

[REQ]

Identifier REQ-11.01.03-TS-0735.0010

Requirement

The HMI shall include the following selectors:
TTA Constraints Selector
TTA/CTA Recalculation Selector
TTA/CTA Output Selector

PTR Selector

EFPL Selector

EFPL ATC Accept Selector

NPR Data Entry Control

NPR Selector

Timeout Selector
Retransmission Limit Selector

Title HMI Selector List

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1TS.1035) /
wording changed to reflect updated content. This requirement defines the
selector that shall be available in the FOC system HMI

Category <HMI>

Validation Method

Verification Method <Test>

[REQ Trace]
Relationship
<SATISFIES>
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1614
1615

1616
1617

1618
1619

1620
1621

1622
1623

B.2 AFUA TS
[REQ]

Identifier

REQ-11.01.03-TS-0225.0005

Requirement

The FOC system shall link received RTSA information (SUUP and RTSA
UUP) with flights whose trajectories are affected by the RTSA information.

Title Flight Identification.

Status <Deleted>

Rationale Delete Reason: Not necessary anymore as redundant with REQ-11.01.03-
TS-S1AF.1005. SUUPs /RTSA UUPs inform about the changing status of
airspaces (release or booking) that may have been previously planned for
usage by a certain amount of trajectories in the time interval of interest. The
identification of concerned trajectories and of related flight numbers is
crucial for creating the list of flights to be re-calculated within the <FB>
Flight Planning, and — therefore — to trigger the individual AO’s safety and
impact assessment.

Category <Functional>

Validation Method <Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<ALLOCATED_TO> <Functional block> Flight Data Support Management N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0070 <Partial>
[REQ]

Identifier REQ-11.01.03-TS-0225.0010

Requirement

The FOC system shall display all flights linked to the RTSA information
(SUUP and RTSA UUP) with relevant operational attributes.

Title Flight Listing

Status <Deleted>

Rationale Delete Reason: This requirement has been superseded by REQ-11.01.03-
TS-S1NR.1020. Based on the outcome of the flight identification step, the
FOC system shall list all flights linked to SUUPS/RTSA UUPs with relevant
operational attributes (flight number, phase of flight, final fuel/fuel on-board,
time to released ARES, availability of any datalink). Individual trajectories
will be then re-calculated within the <FB> Flight Planning.

Category <Functional>

Validation Method <Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<ALLOCATED_TO> <Functional block> Flight Data Support Management N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0070 <Partial>
[REQ]

Identifier REQ-11.01.03-TS-0225.0015

Requirement

The FOC system shall identify all flights linked to the SUUP/RTSA UUP that
are too close to the released airspace based on individual airspace user’s
parameters and highlight them.

Title Flight Listing/2
Status <Deleted>
Rationale Delete Reason: Not necessary anymore as redundant with REQ-11.01.03-

TS-S1AF.1005. The FOC system shall identify and highlight all flights linked
to SUUPs/RTSA UUPs that are too closed to the released airspaces in a
way the airspace user can decide whether to re-calculate relevant
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1624
1625

1626
1627

1628
1629

1630
1631

1632
1633
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trajectories within the <FB> Flight Planning or skip this step.

Category

<Functional>

Validation Method

<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<ALLOCATED_TO> <Functional block> Flight Data Support Management N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0070 <Partial>
[REQ]

Identifier REQ-11.01.03-TS-0305.0035

Requirement

The FOC system shall re-calculate - consistently with the information
brought about by the RTSA information - the trajectory of all flights that have
been identified as affected by the RTSA information itself.

Title

Trajectory Re-calculation.

Status

<Deleted>

Rationale

Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1AF.1005) /
wording harmonized. To assess the impact of an airspace release or
booking, concerned trajectories shall be re-calculated to collect the
information required by the FOC to make decisions. For flights too close to
the released airspace (according to the parameters set by the individual
airspace user) the trajectory revision might not apply. Therefore such
condition must be recognized to avoid unintended workload on AU side.

Category

<Functional>

Validation Method

<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<ALLOCATED_TO> <Functional block> Flight Planning N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0045 <Full>
[REQ]

Identifier REQ-11.01.03-TS-0505.0010

Requirement

The FOC system shall receive the RTSA information (SUUP/RTSA UUP)
sent by the NM system, validate and store it.

Title SUUP/RTSA UUP Reception

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1AF.4005) /
wording harmonized. Getting SUUPs and RTSA UUPs (i.e. checking
whether an ARES has been released or booked)) is the main trigger for the
whole RTSA-related process of each individual FOC.

Category <Functional>

Validation Method <Real Time Simulation>

Verification Method <Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>

<APPLIES_TO>

<SATISFIES>
<SATISFIES>
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Linked Element Type Identifier Compliance
<Enabler> AOC-ATM-13 <Full>
<Enabler> SWIM.INFR-05a <Full>
<Functional block> Information and Communication N/A
Management

<Operational Focus Area> OFA05.03.01 N/A

<ATMS Requirement> REQ-11.01.02-INTEROP-D001.0003 <Full>
<ATMS Requirement> REQ-11.01.02-INTEROP-D001.0003 <Full>
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1636
1637

1638
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[REQ]

Identifier

REQ-11.01.03-TS-0225.0020

Requirement

The FOC system shall initiate the RTSA impact assessment process in the
shortest time possible

Title Performance of RTSA Information Processing.

Status <Deleted>

Rationale Delete Reason: This requirement has been deleted as the content is
assumed to be standard. As the time window especially for the in-flight
trajectory revision is very short, the reaction time for the generation of a new
trajectory must be as short as possible.

Category <Performance>

Validation Method <Real Time Simulation>

Verification Method <Analysis>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<ALLOCATED_TO> <Functional block> Flight Data Support Management N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0001 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0005 <Full>
[REQ]

Identifier REQ-11.01.03-TS-0305.0040

Requirement

The FOC system shall initiate a trajectory revision in the shortest time
possible.

Title Performance of Trajectory Re-calculation.

Status <Deleted>

Rationale Delete Reason: This requirement has been deleted as the content is
assumed to be standard. As the time window especially for the in-flight
trajectory revision is very short, the reaction time for the generation of a new
trajectory must be as short as possible.

Category <Performance>

Validation Method <Real Time Simulation>

Verification Method <Analysis>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<ALLOCATED_TO> <Functional block> Flight Planning N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0001 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0002 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0003 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0005 <Full>
[REQ]

Identifier REQ-11.01.03-TS-0305.0045

Requirement

The FOC system shall generate a trajectory under consideration of all legal
requirements that are essential for a safe execution of a flight.

Title Safety of Trajectories.

Status <Deleted>

Rationale Delete Reason: The requirement has been identified as superfluous in an
internal review process as it contains no changes compared to the current
operating method. It must be ensured that the trajectory is generated under
consideration of all safety relevant aspects. Only if all these parameters are
considered a safe and orderly execution of trajectories can be ensured.

Category <Safety>

Validation Method <Real Time Simulation>

Verification Method <Analysis>
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1644
1645

1646
1647

1648
1649

1650
1651

1652
1653

1654
1655

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<ALLOCATED_TO> <Functional block> Flight Planning N/A

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0030 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0035 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0045 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0065 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0110 <Full>

<SATISFIES> <ATMS Regquirement> REQ-11.01.02-OSED-D001.0125 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0150 <Full>

[REQ]

Identifier REQ-11.01.03-TS-0505.0015

Requirement The FOC system shall receive relevant ACK or REJ messages from IFPS.

Title EFPL Acknowledgment or Rejection

Status <Deleted>

Rationale Delete Reason: Not necessary anymore as redundant with REQ-11.01.03-
TS-S1EF.1025.

Category <Functional>

Validation Method

<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <Enabler> AOC-ATM-13 <Full>

<SATISFIES> <Enabler> AOC-ATM-20 <Full>

<ALLOCATED_TO> <Functional block> Information and Communication N/A
Management

<APPLIES_TO> <Operational Focus Area> OFA05.03.01 N/A

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0020 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0025 <Full>

[REQ]

Identifier REQ-11.01.03-TS-0510.0020

Requirement

The FOC system shall send updated flight plans and related briefing
information to concerned crews.

Title Flight Plan to Crews

Status <Deleted>

Rationale Delete Reason: The content of this requirement is considered legacy. It is
already implemented in accordance with EASA OPS. To inform the pilots
about the new operational scenario and enable Captain’s decision-making.

Category <Functional>

Validation Method

<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <Enabler> AOC-ATM-20 <Full>

<ALLOCATED_TO> <Functional block> Information and Communication N/A
Management

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<SATISFIES> <ATMS Requirement> REQ-11.01.02-INTEROP-D001.0004 <Partial>

B.3 BMT TS

[REQ]

Identifier REQ-11.01.03-TS-S5202.0010

Requirement

The FOC shall link data received with an ATC-to-FOC-RBT-Conflict-
Advisory message with the flight identified in the ATC-to-FOC-RBT-Conflict-
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Advisory message.
Title Linking of ATC Area(s) to Avoid with FOC flights.
Status <Deleted>
Rationale Delete Reason: Not necessary anymore as redundant with REQ-11.01.03-
TS-S2NR.3005. The ATC Area to Avoid, included in the ATC-to-FOC-RBT-
Conflict-Advisory is not generic data; it is only related to the flight defined in
the advisory message (EFPL).
Category <Functional>
Validation Method <Live Trial><Shadow Mode>
Verification Method <Test>
1656
1657 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ENBO03.01.01 TMF Trajectory Management = <Full>
Framework and System Interoperability
with air ground data sharing
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory
<ALLOCATED_TO> <Functional block> Flight Data Support Management N/A
<SATISFIES> <Enabler> AUO-0204-B Agreed Reference <Full>
Business/Mission Trajectory/RBT/RMT in
Step 2
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0015 <Partial>
1658
1659 [REQ]
Identifier REQ-11.01.03-TS-S5202.0020
Requirement The FOC shall update the Operational Scenarios of a flight identified in an
ATC-to-FOC-RBT-Conflict-Advisory message upon reception of an ATC-to-
FOC-RBT-Conflict-Advisory message.
Title Update of Operational Scenarios due to ATC-to-FOC-RBT-Conflict-Advisory
Status <Deleted>
Rationale Delete Reason: The concept of an “Operational Scenario” is one way how
to implement efficient trajectory negotiations and, thus, shall not be
described in a requirement. Instead, a new requirement (REQ-11.01.03-TS-
S1NR.3015) has been added that provides the base for efficient trajectory
negotiations. The reception of AA2A data shall lead to the initialization of a
Trajectory Review within the FOC. Such Trajectory Review could generally
be triggered by an update of the Operational Scenario. As different events
might lead to such updates, this intermediate requirement is needed.
Category <Functional>
Validation Method <Live Trial><Shadow Mode>
Verification Method <Test>
1660
1661 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory
<SATISFIES> <Enabler> ENBO03.01.01 TMF Trajectory Management
Framework and System Interoperability
with air ground data sharing
<ALLOCATED_TO> <Functional block> Flight Data Support Management N/A
<SATISFIES> <Enabler> AUO-0204-B Agreed Reference <Full>
Business/Mission Trajectory/RBT/RMT in
Step 2
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0015 <Partial>
1662
1663 [REQ]
Identifier REQ-11.01.03-TS-S202.0020

Requirement

The FOC shall update the Operational Scenarios of a flight identified in an
ATC Reply message upon reception of an ATC Reply message.

Title

Update of Operational Scenarios due to ATC Reply
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Status <Deleted>

Rationale Delete Reason: The concept of an “Operational Scenario” is one way how
to implement efficient trajectory negotiations and, thus, shall not be
described in a requirement. Instead, a new requirement (REQ-11.01.03-TS-
S1NR.3015) has been added that provides the base for efficient trajectory
negotiations. The ATC Reply will include information about the validity of the
proposed trajectory, a reject reason if the trajectory has been rejected and
one or several AA2A(s) if the trajectory causes further conflicts. This
information must be related to the respective flight. The update of the
respective OS shall trigger further actions.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]
Relationship
<APPLIES_TO>

<SATISFIES>

<ALLOCATED_TO>

Linked Element Type Identifier Compliance
<Operational Focus Area> OFAO03.01.04 Business and Mission N/A
Trajectory

<Enabler> ENBO03.01.01 TMF Trajectory Management | <Full>
Framework and System Interoperability
with air ground data sharing

<Functional block> Flight Data Support Management N/A

<SATISFIES> <Enabler> AUO-0204-B Agreed Reference

Business/Mission Trajectory/RBT/RMT in

Step 2
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0055 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0015 <Partial>
[REQ]
Identifier REQ-11.01.03-TS-S5203.0010

Requirement

The FOC shall initiate a new RBT Review Scenario if the Operational
Scenario was updated, the Inflight Trajectory Revision Selector is selected
and no active RBT Review Scenario is available for the respective flight.

Title Trajectory revision start

Status <Deleted>

Rationale Delete Reason: This requirement is unnecessary due to REQ-11.01.03-TS-
S1TS.4005 and REQ-11.01.03-TS-S1EF.1030. Not all AU might intend to
support the inflight trajectory revision; therefore it must be optional to avoid
unintended workload on AU side. In such case ATC will re-plan the
trajectory on their side in accordance with the FC.
The ATC-to-AOC-RBT-Conflict-Advisory is a message will only be received
for flights that are already in the execution phase or close to the execution
phase.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]
Relationship
<APPLIES_TO>

<SATISFIES>

<ALLOCATED_TO>
<SATISFIES>

<SATISFIES>
<SATISFIES>

[REQ]
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Linked Element Type Identifier Compliance
<Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory

<Enabler> ENBO03.01.01 TMF Trajectory Management = <Full>
Framework and System Interoperability

with air ground data sharing

<Functional block> Flight Planning N/A
<Enabler> AUO-0204-B Agreed Reference <Full>
Business/Mission Trajectory/RBT/RMT in
Step 2
<ATMS Requirement> REQ-11.01.01-DOD-2100.0035 <Full>

<ATMS Requirement> REQ-11.01.01-DOD-2100.0015 <Partial>
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Identifier

REQ-11.01.03-TS-5203.0020

Requirement

The FOC shall update the active RBT review Scenario of a certain flight with
the AA2A data upon reception of new AA2A data.

Title AA2A allocation to RBT Review Scenario

Status <Deleted>

Rationale Delete Reason: This requirement is unnecessary due to REQ-11.01.03-TS-
S1TS.400 and REQ-11.01.03-TS-S1EF.1030. As the negotiation of the
trajectory is an iterative process where the number of AA2As might increase
with every iteration step, the data must be kept and gathered until the
trajectory negotiation has been finished. The AA2A data will be linked with
this RBT Review Scenario and not further be used after it has been
inactivated.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]
Relationship
<APPLIES_TO>

<SATISFIES>

Linked Element Type Identifier Compliance
<Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory

<Enabler> ENBO03.01.01 TMF Trajectory Management | <Full>
Framework and System Interoperability

with air ground data sharing

<ALLOCATED_TO> <Functional block> Flight Planning N/A
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0035 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0015 <Partial>
<SATISFIES> <Enabler> AUO-0204-B Agreed Reference <Full>
Business/Mission Trajectory/RBT/RMT in
Step 2
[REQ]
Identifier REQ-11.01.03-TS-S203.0030

Requirement

The FOC shall generate a new trajectory triggered by an update of the RBT
Review Scenario.

Title Trajectory generation upon RBT Review Scenario update

Status <Deleted>

Rationale Delete Reason: This requirement has been superseded by REQ-11.01.03-
TS-S1INR.1015. The update of the RBT Review Scenario shall trigger the
generation of a new trajectory that shall be proposed to ATC as a solution
for the identified conflict. The trajectory will be generated according to all
requirements of flight planning and under consideration of the received
AA2A data.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]
Relationship
<APPLIES_TO>
<SATISFIES>

<ALLOCATED_TO>
<SATISFIES>

<SATISFIES>
<SATISFIES>
<SATISFIES>

[REQ]

foaunding mambers

Linked Element Type Identifier Compliance
<Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory

<Enabler> ENBO03.01.01 TMF Trajectory Management | <Full>
Framework and System Interoperability

with air ground data sharing

<Functional block> Flight Planning N/A
<Enabler> AUO-0204-B Agreed Reference <Full>

Business/Mission Trajectory/RBT/RMT in

Step 2
<ATMS Requirement> REQ-11.01.01-DOD-2100.0015 <Partial>
<ATMS Requirement> REQ-11.01.01-DOD-2100.0035 <Full>
<ATMS Requirement> REQ-11.01.01-DOD-2100.0060 <Full>
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Identifier

REQ-11.01.03-TS-5203.0040

Requirement

The FOC shall update the Operational Scenario of a certain flight and the
respective filed trajectory with the ATC Validity Status upon reception from
the ATC system.

Title

Trajectory status update.

Status

<Deleted>

Rationale

Delete Reason: This requirement was determined in an internal review
process.as being redundant: A trajectory is considered valid unless rejected.
Furthermore, this requirement was a special requirement in the context of
VP-775. Whenever a trajectory has been published its current status must
be updated accordingly to avoid any confusion. Therefore it must be
indicated whether the trajectory has been accepted or rejected by ATC.

Category

<Functional>

Validation Method

<Live Trial><Shadow Mode>

Verification Method

<Test>

[REQ Trace]
Relationship
<APPLIES_TO>

<SATISFIES>

Linked Element Type Identifier Compliance
<Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory

<Enabler> ENBO03.01.01 TMF Trajectory Management | <Full>
Framework and System Interoperability

with air ground data sharing

<ALLOCATED_TO> <Functional block> Flight Planning N/A
<SATISFIES> <Enabler> AUO-0204-B Agreed Reference <Full>
Business/Mission Trajectory/RBT/RMT in
Step 2
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0015 <Partial>
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0045 <Full>
[REQ]
Identifier REQ-11.01.03-TS-5203.0050

Requirement

The FOC shall initiate the Trajectory Distribution after reception of the ATC
Validity Status “Accepted”.

Title Initialization of trajectory distribution (filing/ briefing/ RBT trigger)

Status <Deleted>

Rationale Delete Reason: This requirement was a special requirement in the context
of VP-775. After review it has not been considered a general requirement.
As in a holistic Trajectory Management Process all ATM stakeholder must
be considered and as it is yet not defined how the SBT becomes RBT, this
“black box” has be defined to gather all these open items in one process
until the respective concepts are mature.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]
Relationship
<APPLIES_TO>

<SATISFIES>

Linked Element Type Identifier Compliance
<Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory

<Enabler> ENBO03.01.01 TMF Trajectory Management | <Full>
Framework and System Interoperability

with air ground data sharing

<ALLOCATED_TO> <Functional block> Flight Planning N/A
<SATISFIES> <Enabler> AUO-0204-B Agreed Reference <Full>
Business/Mission Trajectory/RBT/RMT in
Step 2
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0040 <Full>
[REQ]
Identifier REQ-11.01.03-TS-5203.0060

Requirement

The FOC shall inactivate the active RBT Review Scenario upon initialization
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of the trajectory distribution process.

Title RBT Review Scenario deactivation

Status <Deleted>

Rationale Delete Reason: The structural composition of requirements has changed
with this TS document to align the concepts coming from the different TS
documents. This new structure makes this requirement not necessary
anymore. The negotiation ends when a trajectory has been found that can
be used as RBT. If this has been achieved the purpose of the RBT Review
Scenario has been achieved and it is not further needed.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]
Relationship
<APPLIES_TO>

<SATISFIES>

Linked Element Type Identifier Compliance
<Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory

<Enabler> ENBO03.01.01 TMF Trajectory Management | <Full>
Framework and System Interoperability

with air ground data sharing

<ALLOCATED_TO> <Functional block> Flight Planning N/A
<SATISFIES> <Enabler> AUO-0204-B Agreed Reference <Full>
Business/Mission Trajectory/RBT/RMT in
Step 2
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0030 <Full>
[REQ]
Identifier REQ-11.01.03-TS-S205.0010

Requirement

The FOC shall receive ATC-to-FOC-RBT-Conflict_Advisories coming from
an ATC system.

Title Reception of ATC-to-FOC-RBT-Conflict Advisories

Status <Deleted>

Rationale Delete Reason: Not necessary anymore as redundant with REQ-11.01.03-
TS-S2NR.3005. Within Europe the data exchange between FOC and ATC
is still not established. Therefore it is required to develop interfaces between
these two domains to allow an trajectory negotiation between these two
ATM stakeholder and beyond that to achieve the target to implement a
Trajectory management between all ATM stakeholders.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory
<SATISFIES> <Enabler> ENBO03.01.01 TMF Trajectory Management = <Full>
Framework and System Interoperability
with air ground data sharing
<SATISFIES> <Enabler> ENBO02.01 SWIM <Partial>
<ALLOCATED_TO> <Functional block> Information and Communication N/A
Management
<SATISFIES> <Enabler> AUO-0204-B Agreed Reference <Full>
Business/Mission Trajectory/RBT/RMT in
Step 2
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0055 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2600.0050 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2600.0055 <Full>
[REQ]
Identifier REQ-11.01.03-TS-5205.0020

Requirement

The FOC shall store ATC-to-FOC-RBT-Conflict-Advisory data upon
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reception from ATC.

Title Reception of ATC Area to Avoid data
Status <Deleted>
Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S2BT.3005) /
wording harmonized. The system shall store the data included in the ATC-
to-FOC-RBT-Conflict-Advisory message internally to make it available for
other functionalities.
The ATC-to-FOC-RBT-Conflict-Advisory message will include:
e An EFPL representing the trajectory that conflicts with other traffic
e And one or several ATC Area(s) to Avoid.
Category <Functional>
Validation Method <Live Trial><Shadow Mode>
Verification Method <Test>

[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory
<SATISFIES> <Enabler> ENBO03.01.01 TMF Trajectory Management | <Partial>
Framework and System Interoperability
with air ground data sharing
<SATISFIES> <Enabler> ENBO02.01 SWIM <Partial>
<ALLOCATED_TO> <Functional block> Information and Communication N/A
Management
<SATISFIES> <Enabler> AUO-0204-B Agreed Reference <Full>
Business/Mission Trajectory/RBT/RMT in
Step 2
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0055 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2600.0050 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2600.0055 <Full>
<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0030 <Full>
Requirement>
[REQ]
Identifier REQ-11.01.03-TS-5205.0030

Requirement

The FOC shall store data received in an ATC Reply messages coming from
the ATC system

Title Reception of ATC reply
Status <Deleted>
Rationale Delete Reason: Not necessary anymore as redundant with REQ-11.01.03-
TS-S2BT.3005. The system shall store the data included in the ATC-to-
FOC-RBT-Conflict-Advisory message internally to make it available for other
functionalities.
The ATC-to-FOC-RBT-Conflict-Advisory message will include:
e The Validation Status of the sent trajectory
e The Reason in case of a reject
e And one or several ATC Area(s) to Avoid in case of a reject.
Category <Functional>

Validation Method

<Live Trial><Shadow Mode>

Verification Method

<Test>

[REQ Trace]
Relationship
<APPLIES_TO>

<SATISFIES>

<ALLOCATED_TO>

<SATISFIES>
<SATISFIES>

Linked Element Type Identifier Compliance
<Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory

<Enabler> ENBO03.01.01 TMF Trajectory Management = <Full>
Framework and System Interoperability

with air ground data sharing

<Functional block> Information and Communication N/A
Management

<ATMS Requirement> REQ-11.01.01-DOD-2100.0055 <Full>

<ATMS Requirement> REQ-11.01.01-DOD-2600.0050 <Full>
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<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2600.0055 <Full>
[REQ]

Identifier REQ-11.01.03-TS-S205.0035

Requirement

The FOC shall update the Operational Scenario with AA2A data and
trajectory data in real-time.

Title

Performance of Operational Scenario update.

Status

<Deleted>

Rationale

Delete Reason: The concept of an “Operational Scenario” is one way how to
implement efficient trajectory negotiations and, thus, shall not be described
in a requirement. Instead, a new requirement (REQ-11.01.03-TS-
S1NR.3015) has been added that provides the base for efficient trajectory
negotiations. As the time window especially for the inflight trajectory revision
is very short, the reaction time for the generation of a new trajectory must be
as short as possible. The update of the Operational Scenario is one of the
task that has to be performed in the process chain of trajectory revision.

Category

<Performance>

Validation Method

<Live Trial><Real Time Simulation><Shadow Mode>

Verification Method

<Test>

[REQ Trace]
Relationship
<APPLIES_TO>

<SATISFIES>

<ALLOCATED_TO>

Linked Element Type Identifier Compliance
<Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory

<Enabler> ENBO03.01.01 TMF Trajectory Management = <Full>
Framework and System Interoperability
with air ground data sharing

<Functional block> Flight Data Support Management N/A

<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0035 <Partial>

[REQ]

Identifier REQ-11.01.03-TS-S203.0060

Requirement The FOC shall monitor the trajectory steadily during all phases of the flight.

Title On-going trajectory monitoring

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S2BT.1005) /
wording changed to refer to RBT. To ensure an assessment of changing
planning conditions or on a deviation from the planned route at all stages of
a flight (especially in the in-flight phase) a continuous monitoring must be
ensured.

Category <Performance>

Validation Method

<Fast Time Simulation><Live Trial><Real Time Simulation><Shadow
Mode>

Verification Method

<Test>

[REQ Trace]
Relationship
<APPLIES_TO>

<SATISFIES>

Linked Element Type Identifier Compliance
<Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory

<Enabler> ENBO03.01.01 TMF Trajectory Management = <Full>
Framework and System Interoperability

with air ground data sharing

<ALLOCATED_TO> <Functional block> Flight Planning N/A
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0035 <Full>
[REQ]

Identifier REQ-11.01.03-TS-S5203.0065

Requirement The FOC shall initiate a trajectory review in real-time.

Title Performance of trajectory review initiation

Status <Deleted>
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Rationale

Delete Reason: It is assumed that there is by default no delay in the
initiation of a trajectory review process, which makes this requirement
superfluously. As the time window especially for the inflight trajectory
revision is very short, the reaction time for the generation of a new trajectory
must be as short as possible. The initiation of the trajectory review process
is one of the task that has to be performed in the process chain of trajectory
revision

Category

<Performance>

Validation Method

<Fast Time Simulation><Live Trial><Real Time Simulation><Shadow
Mode>

Verification Method

<Test>

[REQ Trace]
Relationship
<APPLIES_TO>

<SATISFIES>

Linked Element Type Identifier Compliance
<Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory

<Enabler> ENBO03.01.01 TMF Trajectory Management | <Full>
Framework and System Interoperability

with air ground data sharing

<ALLOCATED_TO> <Functional block> Flight Planning N/A
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0035 <Full>
[REQ]

Identifier REQ-11.01.03-TS-S5203.0070

Requirement

The FOC shall generate trajectories under consideration of all legal
requirements that are essential for a safe execution of a flight.

Title

Safety of trajectories.

Status

<Deleted>

Rationale

Delete Reason: Duplicate with also deleted REQ-11.01.03-TS-0305.0045.
Whenever a trajectory is planned or predicted by any ground system it must
be ensured that it was generated under consideration of all safety relevant
aspects as fuel requirements, working and layup time requirements of crew
members, ATFM and ATM requirements etc. Only if all these parameters
are considered a safe and orderly execution of trajectories can be ensured.
A source for such requirements is the EU-OPS requirements.

Category

<Safety>

Validation Method

<Real Time Simulation><Shadow Mode><Expert Group (Judgement
Analysis)>

Verification Method

<Inspection><Test>

[REQ Trace]
Relationship
<APPLIES_TO>

<SATISFIES>

Linked Element Type Identifier Compliance
<Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory

<Enabler> ENBO03.01.01 TMF Trajectory Management | <Full>
Framework and System Interoperability

with air ground data sharing

<ALLOCATED_TO> <Functional block> Flight Planning N/A
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0060 <Full>
[REQ]

Identifier REQ-11.01.03-TS-S5203.0075

Requirement

The FOC shall use the same trajectory during the flight monitoring that was
distributed to the other ATM stakeholders.

Title Seamless use of trajectory
Status <Deleted>
Rationale Delete Reason: Requirement is not needed anymore as replaced by REQ-

11.01.03-TS-S2NR.1010 that refers to RBT monitoring. The trajectory
management will be based on the monitoring of the trajectory during the
whole trajectory lifecycle. The monitoring will compare the flown trajectory
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with the RBT that has been agreed between all ATM stakeholders. Hence
the FOC has to ensure that the trajectory published to the NOP (published
to all other ATM stakeholders) corresponds with the trajectory the AU wants
to fly.

Category <Safety>

Validation Method <Real Time Simulation><Shadow Mode>

Verification Method <Test>

[REQ Trace]
Relationship
<APPLIES_TO>

<SATISFIES>

Linked Element Type Identifier Compliance
<Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory

<Enabler> ENBO03.01.01 TMF Trajectory Management = <Full>
Framework and System Interoperability

with air ground data sharing

<ALLOCATED_TO> <Functional block> Flight Planning N/A
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0055 <Full>
[REQ]

Identifier REQ-11.01.03-TS-5205.0040

Requirement

The FOC shall send trajectory proposals in the EFPL format to the ATC
system.

Title Trajectory proposal format

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1BT.1005).
For the time being the EFPL format as used by NM for the EFPL creation
B2B web service shall be used for the trajectory exchange between FOC
and ATC. This requirement is driven by the need to align and standardize
basic data that is exchanged between all ATM stakeholders.

Category <Interface>

Validation Method

<Live Trial><Shadow Mode>

Verification Method

<Test>

[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory
<SATISFIES> <Enabler> ENBO03.01.01 TMF Trajectory Management = <Partial>
Framework and System Interoperability
<SATISFIES> <Enabler> ENB02.01 SWIM <Partial>
<ALLOCATED_TO> <Functional block> Information and Communication N/A
Management
<SATISFIES> <Enabler> AOC-ATM-20 Sharing of trajectory data <Full>
between AOC/WOC and the ATM world
using B2B web services
<SATISFIES> <Enabler> AOC-ATM-13 Sharing of updated data for <Full>
CDM process between AOC/WOC ATM
systems and ATM world
<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0035 <Full>
[REQ]
Identifier REQ-11.01.03-TS-5205.0050
Requirement The FOC system shall receive ATC Reply messages from the ATC system.
Title Reception of ATC reply
Status <Deleted>
Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1BT.1010).
Upon publication of a trajectory proposal to the ATC system it is expected to
get an ATC Reply message in return. This data is directly linked to the flight
for which a trajectory has been send to the ATC system.
Category <Interface>

Validation Method

<Live Trial><Shadow Mode>

Verification Method

<Test>
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[REQ Trace]
Relationship
<APPLIES_TO>
<SATISFIES>
<SATISFIES>
<SATISFIES>

<SATISFIES>

Linked Element Type Identifier Compliance

<Operational Focus Area> OFA03.01.04 Business and Mission N/A
Trajectory

<Enabler> ENBO03.01.01 TMF Trajectory Management = <Full>
Framework and System Interoperability

<Enabler> ENB02.01 SWIM <Full>

<Enabler> AOC-ATM-20 Sharing of trajectory data <Full>
between AOC/WOC and the ATM world
using B2B web services

<Enabler> AOC-ATM-13 Sharing of updated data for <Full>

CDM process between AOC/WOC ATM
systems and ATM world

<ALLOCATED_TO> <Functional block> Information and Communication N/A
management

<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0035 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0040 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0045 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.01-DOD-2100.0045 <Full>

B.4 EFPL TS

[REQ]

Identifier REQ-11.01.03-TS-5102.0050

Requirement

Upon reception of an EFPL validation reply the FOC system shall link the
validation status, and constraints with the flight identified in the EFPL
validation reply.

Title Processing of 4D trajectory validation reply data

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.1025) /
wording harmonized. If the validation of a 4D trajectory is done a reply will
be received by the FOC. This reply will include the status of the trajectory,
which can be “acknowledged” or “rejected” and a number ‘n’ constraints with
which the trajectory is in conflict. 0 < ‘n’ < «

Category <Functional>

Validation Method <Real Time Simulation><Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0035 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0050 <Partial>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-SPR-FPS1.0021 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<ALLOCATED _TO> <Functional block> Flight Data Support Management N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<ALLOCATED_TO> <Project> 11.01.03 N/A

<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

<SATISFIES> <Service> AeronauticallnformationFeature <Partial>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0020 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0021 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0030 <Full>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-S102.0055

Requirement

The FOC system shall update the Operational Scenarios of a flight identified
in a flight plan validation reply received from NOP/ NM with the validation
status of the trajectory and delivered constraints.
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1736
1737

1738
1739

1740
1741

Title

Flight data update upon flight plan validation reply

Status

<Deleted>

Rationale

Delete Reason: The structural composition of requirements has changed
with this TS document to align the concepts coming from the different TS
documents. This new structure makes this requirement not necessary
anymore. When a flight plan is validated using the 4D trajectory validation
service of NM a reply will be returned by this service. It will include the
validation status for the validated trajectory which can be “acknowledged” or
“rejected” and a number ‘n’ of constraints the trajectory is not adhering to,
where 0 < ‘'n’ < «. As this information is directly related to the validated
trajectory its dataset must be updated with this information.

Category

<Functional>

Validation Method

<Real Time Simulation><Shadow Mode>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0035 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0050 <Partial>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-SPR-FPS1.0021 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<ALLOCATED_TO> <Functional block> Flight Data Support Management N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<ALLOCATED_TO> <Project> 11.01.03 N/A

<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

<SATISFIES> <Service> AeronauticallnformationFeature <Partial>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0020 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0021 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0030 <Full>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-S102.0060

Requirement

The FOC system shall link soft constraints received in a flight plan filing
reply from NOP/ NM with the flight identified in the reply message.

Title

Processing of filing replies including soft constraints

Status

<Deleted>

Rationale

Delete Reason: The structural composition of requirements has changed
with this TS document to align the concepts coming from the different TS
documents. This new structure makes this requirement not necessary
anymore. If a trajectory is filed to NM/ NOP it will be validated and analysed
in regard whether there are tactical constraints that might be considered in
the vertical profile of the trajectory. If such tactical constraints (that do not
lead to rejects and therefore are called soft constraints) are identified by NM
they will be reported to the AU/ FOC who can decide whether a trajectory
with updated vertical profile shall be provided to NM/ NOP or not. If no
update is send to NM/ NOP, NM will generate this updated vertical profile
himself. If an updated vertical profile is delivered by AU/ FOC it will be used
by NM/ NOP directly.

Category

<Functional>

Validation Method

<Real Time Simulation><Shadow Mode>

Verification Method

<Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>

foaunding mambers
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<ATMS Requirement> REQ-11.01.02-OSED-D001.0035 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>
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1742
1743

1744
1745

1746
1747

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0055 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0035 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-SPR-FPS1.0021 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<ALLOCATED TO> <Functional block> Flight Data Support Management N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<ALLOCATED_TO> <Project> 11.01.03 N/A

<SATISFIES> <Service> AeronauticallnformationFeature <Partial>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0020 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0021 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0030 <Full>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-5102.0065

Requirement

The FOC system shall update the Operational Scenarios of a flight identified
in a flight plan filing reply received from NOP/ NM with the soft constraints.

Title

Flight data update upon reception of soft constraints

Status

<Deleted>

Rationale

Delete Reason: The structural composition of requirements has changed
with this TS document to align the concepts coming from the different TS
documents. This new structure makes this requirement not necessary
anymore. If a trajectory has been filed to NM/ NOP a reply message will be
returned. Apart from reject messages that will include constraints that are
not adhered by the filed trajectory, for acknowledged trajectories a set of
“soft constraints” could be included. These “soft constraints” are not
invalidating the trajectory but might be applied to the profile of the trajectory
as an addition. This data is related to the flight for which a trajectory has
been filed. Therefore the flight data must be updated with the “soft

constraints”.

Category

<Functional>

Validation Method

<Real Time Simulation><Shadow Mode>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0035 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0055 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0035 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-SPR-FPS1.0021 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<ALLOCATED TO> <Functional block> Flight Data Support Management N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<ALLOCATED_TO> <Project> 11.01.03 N/A

<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

<SATISFIES> <Service> AeronauticallnformationFeature <Partial>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0020 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0021 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0030 <Full>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-S103.0070

Requirement

The FOC system shall send the 4D trajectory to the EFPL validation service
if triggered by the airspace user.

Title

EFPL validation

Status

<Deleted>

lounding mambers

“ £> Avenue de Cortenbergh 100 | B -1000 Bruxelles

- W Sesanu.eu

119 of 145

©OSESAR JOINT UNDERTAKING, 2015. Created by Lufthansa Systems, Sabre Airline Solutions, and Honeywell for the
SESAR Joint Undertaking within the frame of the SESAR Programme co-financed by the EU and EUROCONTROL. Reprint

with approval of publisher and the source properly acknowledged




Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.1020).
This requirement covers the validation of a FOC trajectory based on EFPL
data. Itis only used to confirm that a calculated trajectory is according to all
constraints and regulations and to get further information on offended
restrictions and constraints in case that the trajectory has been rejected by
NM.
Category <Functional>
Validation Method <Live Trial><Shadow Mode>
Verification Method <Test>
1748
1749 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>
<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0000 <Partial>
<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0050 <Partial>
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<ALLOCATED _TO> <Functional block> Flight Planning N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A
<ALLOCATED_TO> <Project> 11.01.03 N/A
<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>
1750
1751 [REQ]
Identifier REQ-11.01.03-TS-S103.0075
Requirement The FOC system shall recalculate the vertical profile of a trajectory
according to the soft constraints and all ATM constraints available in the
FOC system if triggered by the airspace user.
Title Profile tuning according to soft constraints
Status <Deleted>
Rationale Delete Reason: This requirement is superseded by REQ-11.01.03-TS-
S1INR.1020. Soft constraints, like profile tuning restrictions, will be returned
if applicable when a trajectory is filed to NM/ NOP. Those soft constraints
can be used to file a new profile for a given trajectory (flight plan update) or
to re-estimate the required fuel for the flight execution.
Category <Functional>
Validation Method <Live Trial><Shadow Mode>
Verification Method <Test>
1752
1753 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0035 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>
<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0035 <Full>
<SATISFIES> <ATMS Requirement> REQ-07.06.02-SPR-FPS1.0021 <Full>
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<ALLOCATED_TO> <Functional block> Flight Planning N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A
<ALLOCATED_TO> <Project> 11.01.03 N/A
1754
1755 [REQ]

Identifier REQ-11.01.03-TS-S5103.0080

Requirement The FOC system shall update the vertical profile of a filed trajectory in the
NOP by sending an EFPL update to the NOP/ NM if triggered by the

airspace user.

Title Update of vertical profile

Status <Deleted>

Rationale Delete Reason: This requirement is deleted as no adaption as described in
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1756
1757

1758
1759

1760
1761

1762
1763

the requirement is performed. If soft constraints have been received for a
filed trajectory the airspace user can decide to send an updated trajectory
(which includes a new vertical profile) to NM/ NOP. This information is
additional information for NM and is used instead of a profile generated by

NM himself.

Category

<Functional>

Validation Method

<Live Trial><Shadow Mode>

Verification Method

<Test>

[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0035 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>
<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0040 <Full>
<SATISFIES> <ATMS Requirement> REQ-07.06.02-SPR-FPS1.0021 <Full>
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
<ALLOCATED_TO> <Functional block> Flight Planning N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A
<ALLOCATED_TO> <Project> 11.01.03 N/A
<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0060 <Full>
Requirement>
[REQ]
Identifier REQ-11.01.03-TS-5103.0085

Requirement

The FOC system shall be able to generate EFPL flight plans for flights

planned with the FOC system if triggered by the Airspace User.

Title FIXM generation

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.1040).
The flight plan filed to NM/ NOP will reflect the FOC trajectory that has been

planned by the AU for a certain flight. This FOC trajectory must be
converted to the FIXM format when filed to NM/ NOP when a filing or flight

plan validation service based on the FIXM flight plan format is used.

Category

<Functional>

Validation Method

<Live Trial><Shadow Mode>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0020 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0025 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0030 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0040 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-SPR-FPS1.0021 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<ALLOCATED_TO> <Functional block> Flight Planning N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<ALLOCATED_TO> <Project> 11.01.03 N/A

<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0060 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0070 <Full>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-S105.0070

Requirement

The FOC system shall send EFPM message to the NOP/ NM, if the NM
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1764
1765

1766
1767

1768
1769

EFPL validation service is triggered by the airspace user.

Title EFPL based trajectory validation

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.1005).
The 4D trajectory validation service provided by NM (Eurocontrol) will
available for two different formats. One format will be the EFPL format,
defined by Eurocontrol, the other will be based on the FIXM format.
Depending on what is setup/ triggered by the airspace user the FOC system
must comply with one of the two formats.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0020 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0025 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0000 <Partial>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0030 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0040 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<ALLOCATED_TO> <Functional block> Information and Communication N/A

Management

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<ALLOCATED_TO> <Project> 11.01.03 N/A

<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0020 <Full>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-S105.0075

Requirement

The FOC system shall send a FIXM 4D message to the NOP/ NM, if the NM
EFPL FIXM validation service is triggered by the airspace user.

Title FIXM based trajectory validation

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.1010) /
wording slightly changed. The 4D trajectory validation service provided by
NM (Eurocontrol) will available for two different formats. One format will be
the EFPL format, defined by Eurocontrol, the other will be based on the
FIXM format. Depending on what is setup/ triggered by the airspace user
the FOC system must comply with one of the two formats.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>

<APPLIES_TO>
<APPLIES_TO>

lounding mambers

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-11.01.02-OSED-D001.0025 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>
<ATMS Requirement> REQ-07.06.02-OSED-0001.0000 <Partial>
<ATMS Requirement> REQ-07.06.02-OSED-0001.0030 <Full>
<ATMS Requirement> REQ-07.06.02-OSED-0001.0040 <Full>
<Enabler> AOC-ATM-11 <Full>
<Functional block> Information and Communication N/A
Management
<Operational Focus Area> OFA03.01.04 N/A
<Operational Focus Area> ENB03.01.01 TMF N/A
£> Avenue de Cortenbergh 100 | B -1000 Bruxelles
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1770
1771

1772
1773

1774
1775

1776
1777

<ALLOCATED_TO> <Project> 11.01.03 N/A

<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0020 <Full>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-S105.0080

Requirement

The FOC system shall receive soft constraint information from the Network

Manager.

Title Receive soft constraints

Status <Deleted>

Rationale Delete Reason: Not necessary anymore as redundant with REQ-11.01.03-
TS-S1EF.1035. The Network Manager will send out soft constraint IDs for
trajectories that have been filed to the NOP/ NM. The airspace user might
use them to calculate an updated vertical profile or to improve the fuel
estimation for a certain flight.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0035 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0055 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0035 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-SPR-FPS1.0021 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<ALLOCATED_TO> <Functional block> Information and Communication N/A

Management

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<ALLOCATED_TO> <Project> 11.01.03 N/A

<SATISFIES> <Service> AeronauticallnformationFeature <Full>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0020 <Partial>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-S105.0085

Requirement

The FOC system shall send the EFPL as FIXM 4D message, if the
addressed ANSP or Network Manager is able and requires to receive it and
if triggered by the airspace user.

Title ADT FIXM filing

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.1015).
For the 4D trajectory filing and update two different types of format, EFPL
and FIXM, will be available. The airspace user has the choice to send the
flight plan in FIXM or EFPL format. Apart from that it must be checked
whether the addressed recipient is able to receive the 4D trajectory in the
respective format.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>

lounding mambers

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-11.01.02-OSED-D001.0020 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-D001.0025 <Full>
<ATMS Requirement> REQ-07.06.02-OSED-0001.0000 <Partial>
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1778
1779

1780
1781

1782
1783
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Edition 02.00.00

02.00.00

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0030 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0040 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<ALLOCATED_TO> <Functional block> Information and Communication N/A

Management

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<ALLOCATED_TO> <Project> 11.01.03 N/A

<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0020 <Full>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-S105.0105

Requirement

The FOC system shall allow the system user to trigger whether an ICAO
FPL or EFPL is generated for a flight.

Title Flight plan type options

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.1055).
Flight plan information can include two different types of content. The first
option only includes the flight plan according ICAO PANS-ATM doc 4444,
the other type includes information as defined by Eurocontrol as Extended
Flight plan. The FOC system must be adaptable in regard whether the ICAO
FPL or the EFPL is used.

Category <Interoperability><Maintainability>

Validation Method

<Live Trial><Shadow Mode>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<ALLOCATED_TO> <Project> 11.01.03 N/A

<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0060 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0070 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0020 <Full>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-S105.0110

Requirement

The FOC system shall allow the system user to trigger whether the ICAO
FPL is transmitted to NM/ NOP using ICAO TXT, ICAO XML or ICAO FIXM

based services.

Title ICAO FPL format selection
Status <Deleted>
Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.5005).

Depending on the way how the ICAO FPL is send NM/ NOP different type of
ICAO FPL message formats are applicable. It must be possible to select
how the flight plan is send to NM/ NOP. The respective selected way will
define in which format the flight plan will be transmitted.
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1784
1785

1786
1787

1788
1789

1790
1791

Category

<Interoperability><Maintainability>

Validation Method

<Live Trial><Shadow Mode>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<ALLOCATED_TO> <Project> 11.01.03 N/A

<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0060 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0070 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0020 <Full>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-S105.0115

Requirement

The FOC system shall allow the system user to trigger whether the EFPL is
transmitted to NM/ NOP using EFPM or FIXM 4D message based services.

Title EFPL format selection

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.5010).
Depending on the way how the EFPL is send NM/ NOP different type of
EFPL message formats are applicable. It must be possible to select how the
flight plan is send to NM/ NOP. The respective selected way will define in
which format the flight plan will be transmitted.

Category <Interoperability><Maintainability>

Validation Method

<Live Trial><Shadow Mode>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<ALLOCATED_TO> <Project> 11.01.03 N/A

<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0060 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0070 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0020 <Full>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-S107.0055

Requirement It shall be possible to adapt the flight plan contents and formats.

Title Adaptability of flight plan data and formats

Status <Deleted>

Rationale Delete Reason: This requirement is purely describing an implementation
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1792
1793

1794
1795

1796
1797

1798
1799

Project Number 11.01.03

Edition 02.00.00

D24 - D24 - D11 1 3-TS - Technical Specification Step 1 and Step 2 for FOC System - Edition

02.00.00

aspect and, therefore, is considered to be out of the scope of this TS
document. The content, especially of the EFPL as well as the format,
especially of all XML flight plan messages might develop within the next
years. Therefore it is important to ensure the adaptability within the FOC
system.

Category

<Maintainability>

Validation Method

<Expert Group (Judgement Analysis)>

Verification Method

<Review of Design>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-SPR-FPS1.0021 <Full>

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<ALLOCATED_TO> <Project> 11.01.03 N/A

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0060 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0070 <Full>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-S107.0060

Requirement

The generation of the extended flight plan shall not affect the system
performance in a negative way.

Title EFPL performance impact

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.1060).
The provision of the EFPL is additional work that has to be done by the
FOC. As the main purpose of the FOC is the planning of the flight
operations and filing of a flight plan is only an interface function needed to
ensure interoperability with all ATM stakeholders, it shall not influence the
performance of the flight planning in a negative way.

Category <Performance>

Validation Method <Real Time Simulation><Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<ALLOCATED_TO> <Project> 11.01.03 N/A
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0002 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0003 <Full>
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
[REQ]

Identifier REQ-11.01.03-TS-S5102.0070

Requirement

Constraints and the FPL validity status returned by NM/ NOP in EFPL reply
messages shall be stored in the FOC system for later analysis.

Title EFPL reply storage

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.1030).
The constraints and the validity status might be used for further analysis
within the FOC. Therefore it must remain available in the FOC system.

Category <Metadata>

Validation Method

<Expert Group (Judgement Analysis)>

Verification Method

<Review of Design>
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1800
1801

1802
1803

1804
1805

1806
1807

1808
1809

Project Number 11.01.03
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02.00.00

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<ALLOCATED_TO> <Project> 11.01.03 N/A

<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0002 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0003 <Full>

<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0035 <Full>

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0030 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0060 <Full>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-S102.0075

Requirement

Soft constraints returned by NM/ NOP in EFPL reply messages shall be
stored in the FOC system for later analysis.

Title Soft constraint storage

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.1035) /
wording harmonized and soft constraints have been replaced by PTRs. The
soft constraints might be used for further analysis within the FOC. Therefore
it must remain available in the FOC system.

Category <Metadata>

Validation Method

<Expert Group (Judgement Analysis)>

Verification Method

<Review of Design>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<ALLOCATED_TO> <Project> 11.01.03 N/A

<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0002 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0003 <Full>

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<SATISFIES> <Enabler> AOC-ATM-11 <Full>

<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0030 <Full>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-S107.0065

Requirement

The FOC system shall provide EFPL flight plans in a human readable
format to the system users.

Title EFPL display

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.1045) /
wording slightly changed. The EFPL will be exchanged in the XML formats
FIXM 4D and EFPM. Both are very hard to read for human beings.
Therefore the FOC system must be able to provide the EFPL content in a
way that the system users are able to read them.

Category <HMI>

Validation Method

<Expert Group (Judgement Analysis)>

Verification Method

<Review of Design><Test>

[REQ Trace]
Relationship
<ALLOCATED_TO>
<SATISFIES>
<SATISFIES>
<APPLIES_TO>
<APPLIES_TO>
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Linked Element Type Identifier Compliance
<Project> 11.01.03 N/A
<ATMS Requirement> REQ-11.01.02-OSED-D001.0020 <Full>
<ATMS Requirement> REQ-11.01.02-OSED-D001.0030 <Full>
<Operational Focus Area> OFA03.01.04 N/A
<Operational Focus Area> ENB03.01.01 TMF N/A
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1810
1811

1812
1813

1814
1815

1816
1817

1818
1819

<SATISFIES> <Enabler> AOC-ATM-11 <Full>
[REQ]
Identifier REQ-11.01.03-TS-S107.0070

Requirement

The FOC system shall provide EFPL flight plan filing and validation replies
in a human readable format to the system users.

Title EFPL reply display

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.1050).
The EFPL filing and validation replies will be provided in the XML formats.
Both are very hard to read for human beings. Therefore the FOC system
must be able to provide the content included in those replies in a way that
the system users are able to read them.

Category <HMI>

Validation Method

<Expert Group (Judgement Analysis)>

Verification Method

<Review of Design><Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<ALLOCATED_TO> <Project> 11.01.03 N/A
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0020 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0030 <Full>
<SATISFIES> <ATMS Requirement> REQ-07.06.02-OSED-0001.0035 <Full>
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A
<SATISFIES> <Enabler> AOC-ATM-11 <Full>
[REQ]

Identifier REQ-11.01.03-TS-S107.0075

Requirement

The information provided by the Extended Flight Plan Filing request
message shall be in accordance with WS-N WSDL and XSD format.

Title EFPL filing via SWIM

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.1065).

SWIM-TI binding: REQ-14.01.04-TS-0901.0304

Category <Interface>

Validation Method

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<ALLOCATED_TO> <Functional block> Information and Communication N/A

Management

<ALLOCATED_TO> <Project> 11.01.03 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A

<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A

<SATISFIES> <ATMS Requirement> REQ-11.01.03-TS-S105.0070 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.03-TS-S105.0075 <Full>

<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0060 <Full>
Requirement>

<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0070 <Full>
Requirement>

[REQ]

Identifier REQ-11.01.03-TS-S107.0080

Requirement

The information provided by the Extended Flight Plan Update request
message shall be in accordance with WS-N WSDL and XSD format.

Title

EFPL update via SWIM
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Status <Deleted>
Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.1070).
SWIM-TI binding: REQ-14.01.04-TS-0901.0304
Category <Interface>
Validation Method
Verification Method <Test>
1820
1821 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<ALLOCATED_TO> <Functional block> Information and Communication N/A
Management
<ALLOCATED_TO> <Project> 11.01.03 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A
<SATISFIES> <ATMS Requirement> REQ-11.01.03-TS-S105.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.03-TS-S105.0075 <Full>
<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0060 <Full>
Requirement>
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0070 <Full>
Requirement>
<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0010 <Full>
Requirement>
<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0020 <Full>
Requirement>
1822
1823 [REQ]
Identifier REQ-11.01.03-TS-S107.0085
Requirement The information provided by the Extended Flight Plan Validation request
message shall be in accordance with WS-N WSDL and XSD format.
Title EFPL validation via SWIM
Status <Deleted>
Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1EF.1075).
SWIM-TI binding: REQ-14.01.04-TS-0901.0304
Category <Interface>
Validation Method
Verification Method <Test>
1824
1825 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<ALLOCATED_TO> <Functional block> Information and Communication N/A
Management
<ALLOCATED_TO> <Project> 11.01.03 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.04 N/A
<APPLIES_TO> <Operational Focus Area> ENB03.01.01 TMF N/A
<SATISFIES> <ATMS Requirement> REQ-11.01.03-TS-S105.0070 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.03-TS-S105.0075 <Full>
<SATISFIES> <Service> ExtendedFlightPlanSubmission <Full>
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0010 <Full>
Requirement>
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0060 <Full>
Requirement>
<SATISFIES> <Information Exchange IER-07.06.02-OSED-EFPL.0070 <Full>
Requirement>
<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0010 <Full>
Requirement>
<SATISFIES> <Information Exchange IER-11.01.02-OSED-BMT1.0020 <Full>
Requirement>
1826 B.5 Free Route TS
1827  [REQ]
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1828
1829

1830
1831

1832
1833

1834
1835

1836
1837
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02.00.00

Identifier

REQ-11.01.03-TS-5102.0100

Requirement

Upon reception of the Free Routing Airspace volume availability the FOC
shall process this data such that it is available for trajectory planning.

Title Processing of FRA volume availability information

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1FR.4005) /
wording harmonized. In order to be able to plan valid trajectories in FRA the
FOC must know about the FRA volume availability.

Category <Functional><Operational>

Validation Method

<Fast Time Simulation><Live Trial><Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> TBD

<SATISFIES> <Enabler> AOC-ATM-10 <Full>
<SATISFIES> <Enabler> ENB03.01.01 <Full>
<ALLOCATED_TO> <Functional block> Flight Data Support Management N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S102.0105

Requirement

Upon reception of the Free Routing Airspace time availability the FOC shall
process this data such that it is available for trajectory planning.

Title Processing of FRA time availability information

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1FR.4010) /
wording harmonized. In order to be able to plan valid trajectories in FRA the
FOC must know about the FRA time availability.

Category <Functional><Operational>

Validation Method

<Fast Time Simulation><Live Trial><Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> TBD

<SATISFIES> <Enabler> AOC-ATM-10 <Full>
<SATISFIES> <Enabler> ENB03.01.01 <Full>
<ALLOCATED_TO> <Functional block> Flight Data Support Management N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S102.0110

Requirement

Upon reception of the rule “Free Routing Airspace Horizontal Entry/Exit
features” the FOC shall process this data such that it is available for
trajectory planning.

Title Processing of FRA horizontal entry/exit features information

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1FR.4015) /
wording harmonized. In order to be able to plan valid trajectories in FRA the
FOC must know about the horizontal entry/exit features.

Category <Functional><Operational>

Validation Method

<Fast Time Simulation><Live Trial><Real Time Simulation>

Verification Method

<Test>

[REQ Trace]
Relationship
<SATISFIES>
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1838
1839

1840
1841

1842
1843

1844
1845

1846
1847

<SATISFIES> <Enabler> AOC-ATM-10 <Full>

<SATISFIES> <Enabler> ENB03.01.01 <Full>
<ALLOCATED _TO> <Functional block> Flight Data Support Management N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S102.0115

Requirement Upon reception of the rule “Free Routing Airspace Vertical Entry/Exit

features” the FOC shall process this data such that it is available for
trajectory planning.

Title Processing of FRA vertical entry/exit features information
Status <Deleted>
Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1FR.4020) /

wording harmonized. In order to be able to plan valid trajectories in FRA the
FOC must know about the vertical entry/exit features.

Category <Functional><Operational>

Validation Method <Fast Time Simulation><Live Trial><Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> TBD

<SATISFIES> <Enabler> AOC-ATM-10 <Full>

<SATISFIES> <Enabler> ENB03.01.01 <Full>

<ALLOCATED_TO> <Functional block> Flight Data Support Management N/A

<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A

<ALLOCATED_TO> <Project> P11.01.03 N/A

[REQ]

Identifier REQ-11.01.03-TS-S102.0120

Requirement Upon reception of the rule “Free Routing Airspace allowed Intermediate
Points” the FOC shall process this data such that it is available for trajectory
planning.

Title Processing of FRA allowed intermediate points information

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1FR.4025) /

wording harmonized. In order to be able to plan valid trajectories in FRA the
FOC must know about the allowed intermediate points for flight planning.
These points can be currently published points or user-defined lat/long

points.
Category <Functional><Operational>
Validation Method <Fast Time Simulation><Live Trial><Real Time Simulation>
Verification Method <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> TBD
<SATISFIES> <Enabler> AOC-ATM-10 <Full>
<SATISFIES> <Enabler> ENB03.01.01 <Full>
<ALLOCATED_TO> <Functional block> Flight Data Support Management N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]
Identifier REQ-11.01.03-TS-S102.0125
Requirement Upon reception of the rule “Free Routing Airspace Minimum/Maximum
allowed segment length” the FOC shall process this data such that it is
available for trajectory planning.
Title Processing of FRA allowed minimum/maximum segment length information
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1848
1849

1850
1851

1852
1853

1854
1855

1856
1857

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1FR.4030) /
wording harmonized. In order to be able to plan valid trajectories in FRA the
FOC must know about the allowed minimum/maximum segment length.

Category <Functional><Operational>

Validation Method

<Fast Time Simulation><Live Trial><Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> TBD

<SATISFIES> <Enabler> AOC-ATM-10 <Full>
<SATISFIES> <Enabler> ENB03.01.01 <Full>
<ALLOCATED_TO> <Functional block> Flight Data Support Management N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S103.0100

Requirement

The FOC shall generate trajectories under consideration of the Free Routing
airspace availability and all rules valid in the Free Routing Airspace.

Title Trajectory generation in FRA

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1FR.1005) /
wording harmonized. To make use of the flight planning opportunities that
Free Routing offers, the FOC must be able to plan valid trajectories in FRA
by obeying all rules existing.

Category <Functional><QOperational>

Validation Method

<Fast Time Simulation><Live Trial><Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> TBD

<SATISFIES> <Enabler> AOC-ATM-10 <Full>
<SATISFIES> <Enabler> ENB03.01.01 <Full>
<ALLOCATED TO> <Functional block> Flight Planning N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-5104.0100

Requirement

A change of the Free Routing Airspace availability shall trigger the FOC to
reassess the planned trajectory.

Title Trajectory update in FRA

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1FR.1010) /
wording harmonized. If there is a change in the Free Routing Airspace
availability, the FOC shall reassess the planned trajectory to determine
whether changes are necessary as the route may have become invalid or
whether a now possible trajectory is more beneficial to the airspace user.

Category <Functional><Operational>

Validation Method

<Fast Time Simulation><Live Trial><Real Time Simulation>

Verification Method

<Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
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1858
1859

1860
1861

1862
1863

1864
1865

1866
1867

<ALLOCATED _TO> <Functional block> Flight Operations Management N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S103.0105

Requirement

If the ATS route network remains available in the Free Routing Airspace, the
FOC shall allow the airspace user to trigger whether a trajectory is planned
using the ATS route network only or using all possibilities in the Free
Routing Airspace.

Title Flight Planning Options in FRA

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1FR.1015).
The airspace user may decide to only use the ATS route network for flight
planning if it remains available in Free Routing Airspace and not to make
use of all new flight planning options.

Category <Functional>

Validation Method

<Fast Time Simulation><Live Trial><Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> TBD

<SATISFIES> <Enabler> AOC-ATM-10 <Full>
<SATISFIES> <Enabler> ENB03.01.01 <Full>
<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S5102.0130

Requirement

Upon changes in the possibilities for planning a trajectory in Free Routing
Airspace, the FOC shall update the affected data internally sufficiently fast.

Title Change induced data update

Status <Deleted>

Rationale Delete Reason: It is assumed that there is by default no delay in the
“receive and store” process, which makes this requirement superfluously. In
addition, no similar requirements for other kind of data (like for example
RTSA) has been identified. In order to be constantly able to plan valid
trajectories in FRA, the FOC must immediately incorporate any changes to
any data relevant for trajectory generation in FRA.

Category <Operational><Performance>

Validation Method

<Fast Time Simulation><Live Trial><Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> TBD

<SATISFIES> <Enabler> AOC-ATM-10 <Full>
<SATISFIES> <Enabler> ENB03.01.01 <Full>
<ALLOCATED _TO> <Functional block> Flight Data Support Management N/A
<APPLIES_TO> <Operational Focus Area> OFA03.01.03 N/A
<ALLOCATED_TO> <Project> P11.01.03 N/A
[REQ]

Identifier REQ-11.01.03-TS-S5104.0105

Requirement

Upon changes in the options to plan a trajectory in Free Routing Airspace,
the airspace user shall complete the assessment of the need for a
recalculation of the trajectory by the FOC sufficiently fast.

Title

Trajectory update assessment in FRA

Status

<Deleted>
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1868
1869

1870
1871

1872
1873

1874
1875

Project Number 11.01.03

Edition 02.00.00

D24 - D24 - D11 1 3-TS - Technical Specification Step 1 and Step 2 for FOC System - Edition

02.00.00

Rationale

Delete Reason: This requirement is superseded by REQ-11.01.03-TS-
S2NR.1015. If there are new options to plan a trajectory in the FRA due to
for example a change in the volume availability, the airspace user must
assess, whether it wants to recalculate the previously calculated trajectory
in order to take advantage of the new planning option. However, this
assessment must be completed sufficiently fast in order to initiate the
necessary processes in the FOC and affected airspace user units.

Category

<Operational><Performance>

Validation Method

<Fast Time Simulation><Live Trial><Real Time Simulation>

Verification Method

<Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>
<APPLIES_TO>
<ALLOCATED_TO>

Linked Element Type Identifier Compliance
<ATMS Requirement> TBD

<Enabler> AOC-ATM-10 <Full>
<Enabler> ENB03.01.01 <Full>
<Functional block> Flight Operations Management N/A
<Operational Focus Area> OFA03.01.03 N/A
<Project> P11.01.03 N/A

B.6 EFPL-AIM-UDPP-FR TS Honeywell

[REQ]

Identifier

REQ-11.01.03-TS-S105.0090

Requirement

The FOC system shall import the EAUP/EUUP from the Network Manager
via B2B in AIXM (SWIM).

Title EAUP/EUUP import via SWIM

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1HT.5005).
The Functional Block “Information and Communication Management” of the
FOC system needs to import the EAUP/EUUP information from Network
Manager (NM) via B2B in AIXM format (SWIM).

Category <Operational>

Validation Method

<Real Time Simulation>

Verification Method

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> AIMS-06 <Full>
<SATISFIES> <Enabler> AIMS-19a <Full>
<SATISFIES> <Enabler> SWIM-APS-02a <Full>
<SATISFIES> <Enabler> SWIM-APS-02b <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0150 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-INTEROP-D001.0003 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-INTEROP-D001.0005 <Full>
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 <Full>
[REQ]

Identifier REQ-11.01.03-TS-S105.0095

Requirement

The FOC system shall be able to import D-NOTAM information from the NM
via B2B in AIXM format

Title D-NOTAM consistency

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1HT.4020) /
wording changed to also include D-MET information. Consistent information
in time will avoid inconsistent situational awareness and decision making

Category <Operational>

Validation Method

<Real Time Simulation>

Verification Method
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Project Number 11.01.03

Edition 02.00.00

D24 - D24 - D11 1 3-TS - Technical Specification Step 1 and Step 2 for FOC System - Edition

02.00.00
1876
1877 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> AIMS-06 <Full>
<SATISFIES> <Enabler> AIMS-19a <Full>
<SATISFIES> <Enabler> SWIM-APS-02a <Full>
<SATISFIES> <Enabler> SWIM-APS-02b <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-INTEROP-D001.0003 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-INTEROP-D001.0005 <Full>
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 <Full>
1878
1879 [REQ]
Identifier REQ-11.01.03-TS-S105.0100
Requirement The FOC system shall present only valid D-NOTAM information in UTC time
format
Title D-NOTAM consistency
Status <Deleted>
Rationale Delete Reason: All D-NOTAM related aspects have been covered in the
corresponding requirements in chapter 3. Consistent information in time will
avoid inconsistent situational awareness and decision making
Category <Operational>
Validation Method <Real Time Simulation>
Verification Method
1880
1881 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> A/C-57 <Full>
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<SATISFIES> <Enabler> AIMS-19a <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-INTEROP-D001.0007 <Full>
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 <Full>
1882
1883 [REQ]
Identifier REQ-11.01.03-TS-S105.0150
Requirement The FOC system shall indicate a time when the last update of information
has been performed
Title D-NOTAM consistency
Status <Deleted>
Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1HT.5010) /
wording changed to widen the scope. Consistent information in time will
avoid inconsistent situational awareness and decision making
Category <Design>
Validation Method <Real Time Simulation>
Verification Method
1884
1885 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-INTEROP-D001.0007 <Full>
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 <Full>
1886
1887 [REQ]
Identifier REQ-11.01.03-TS-S205.0100

Requirement

The FOC system shall display the airspace information in horizontal (lateral
view) map projection

Title

Airspaces projected in map
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1888
1889

1890
1891

1892
1893

1894
1895

1896

Project Number 11.01.03

Edition 02.00.00

D24 - D24 - D11 1 3-TS - Technical Specification Step 1 and Step 2 for FOC System - Edition

02.00.00

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1HT.4010).
To allow user to clearly identify the airspace shape, the airspace is
presented in lateral graphical form as an object on the map

Category <Design>

Validation Method <Real Time Simulation>

Verification Method

[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<SATISFIES> <Enabler> SWIM-APS-02b <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-INTEROP-D001.0007 <Full>
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 <Full>
[REQ]
Identifier REQ-11.01.03-TS-S205.0105
Requirement The FOC system should display the navigation information in the form of
aeronautical chart when the flight plan is available
Title Navigation information for aeronautical chart
Status <Deleted>
Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1HT.1010).
The system allows the user to switch on or off any layer of the navigation
information in the aeronautical chart, when the flight plan is available. The
information should contain:
- Waypoints
- Navaids
- Airways
- Airspaces
- Airports
Category <Functional>
Validation Method <Real Time Simulation>
Verification Method

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<SATISFIES> <Enabler> SWIM-APS-02b <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-INTEROP-D001.0007 <Full>
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 <Full>
[REQ]

Identifier REQ-11.01.03-TS-S105.0155

Requirement

For each airspace there shall be information about the airspace identifier,
the type of airspace, vertical limitations and validity times displayed on
reguest

Title Airspace information

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1HT.4005).
The user needs access to information about each airspace, containing the
airspace identifier, the type of airspace, vertical limitations and validity
times, to safely perform the flight.

Category <Functional>

Validation Method <Real Time Simulation>

Verification Method
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1897 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-INTEROP-D001.0007 <Full>
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 <Full>
1898
1899 [REQ]
Identifier REQ-11.01.03-TS-S205.0115
Requirement The design of the graphical presentation of airspaces should allow the user
to clearly interpret multiple overlapping airspaces, and to distinguish
between them
Title Multiple airspaces
Status <Deleted>
Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1HT.4015). It
should be obvious from the design that there are multiple airspaces one on
top of another
Category <Design>
Validation Method <Real Time Simulation>
Verification Method
1900
1901 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-INTEROP-D001.0007 <Full>
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 <Full>
1902
1903 [REQ]
Identifier REQ-11.01.03-TS-5205.0120
Requirement The FOC system shall filter D-NOTAMs according user settings criteria
applicable for given flight plan
Title D-NOTAM filtering
Status <Deleted>
Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1HT.1005) /
wording changed to also reflect filtering of D-METs. The system should be
capable of displaying D-NOTAMSs that are relevant for the given flight plan,
based on the 4D criteria:
- lateral filtering according to distance from route in the flight plan
- vertical filtering above and under certain flight level
- time-based filtering
The user should be able to change the filtering criteria according to own
preferences, and to see what are filtering criteria currently applied.
Category <Functional>
Validation Method <Real Time Simulation>
Verification Method
1904
1905 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<SATISFIES> <Enabler> SWIM-APS-02b <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-INTEROP-D001.0007 <Full>
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 <Full>
1906
1907 [REQ]
Identifier REQ-11.01.03-TS-S205.0125

Requirement

The FOC system shall store filtering criteria when triggered by the user
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1908
1909

1910
1911

1912
1913

1914

1915
1916

1917
1918

Title Saving of filtering criteria

Status <Deleted>

Rationale Delete Reason: The storage of filter criteria was determined to be not
absolutely necessary for the system in an internal review process. The FOC
system should allow saving of users setting for filtering criteria

Category <Functional>

Validation Method <Real Time Simulation>

Verification Method

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <Enabler> AIMS-07 <Full>

<SATISFIES> <Enabler> AIMS-07a <Full>

<SATISFIES> <Enabler> SWIM-APS-02b <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>

<SATISFIES> <ATMS Requirement> REQ-11.01.02-INTEROP-D001.0007 <Full>

<APPLIES_TO> <Operational Focus Area> ENB02.01.02 <Full>

[REQ]

Identifier REQ-11.01.03-TS-S205.0130

Requirement The FOC system shall display any change of airspace information
(indication of activation/deactivation of airspace)

Title Airspace status change

Status <Deleted>

Rationale Delete Reason: This requirement has been superseded by REQ-11.01.03-
TS-S1INR.4005. The user should be informed about airspace related
information, for example to indicate whether an airspace, which was not
active on the briefing, becomes active, and also vice versa.

Category <Functional>

Validation Method <Real Time Simulation>

Verification Method

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> AIMS-07 <Full>
<SATISFIES> <Enabler> AIMS-07a <Full>
<SATISFIES> <Enabler> SWIM-APS-02b <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-SPR-D001.0004 <Full>
<SATISFIES> <ATMS Requirement> REQ-11.01.02-INTEROP-D001.0007 <Full>
<APPLIES_TO> <Operational Focus Area> ENB02.01.02 <Full>

B.7 EFPL-AIM-UDPP-FR TS Sabre Airline Solutions

[REQ]

Identifier REQ-11.01.03-TS-0410.0040

Requirement The FOC should be capable of transmitting FDA priority to Airport Gaming
Platform.

Title SendFDAPTriority

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1ST.2005) /
wording slightly changed. FOC UDPP prototype should be able to send the
initial and subsequent FDA priority to the Airport CDM system so that the
flight sequence and delays can be calculated based on the AU priority .

Category <Functional>

Validation Method Human-in-the-Loop Simulation

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
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1920
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1927
1928

1929
1930

1931
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02.00.00

<SATISFIES> <ATMS Requirement> TBD <Full>
[REQ]

Identifier REQ-11.01.03-TS-0410.0045

Requirement

The FOC should be capable of reading CCS information including Ol and
Duration published by Airport Gaming Platform.

Title ReadCCSlInformation

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1ST.2010) /
wording slightly changed. FOC UDPP prototype should be able to get the
updated CCS information including Ol and Duration from the Airport Gaming
Platform .

Category <Functional>

Validation Method Human-in-the-Loop Simulation

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> TBD <Full>

[REQ]

Identifier REQ-11.01.03-TS-0410.0050

Requirement The FOC should be capable of transmitting OC to Airport CDM Platform.

Title SendOC

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1ST.2015) /
wording slightly changed. FOC UDPP Prototype should be able to send the
initial and subsequent OC'’s to the Airport CDM system so that the flight
sequence and delays can be calculated based on the OC's.

Category <Functional>

Validation Method Human-in-the-Loop Simulation

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> TBD <Full>

[REQ]

Identifier REQ-11.01.03-TS-0410.0055

Requirement

The FOC should be capable of reading EOBT information published by
Airport Gaming Platform.

Title ReadDelayEOBTInformation

Status <Deleted>

Rationale Delete Reason: Change of identifier (now REQ-11.01.03-TS-S1ST.2020) /
wording slightly changed. FOC UDPP prototype should be able to get the
updated EOBT information based on the FDA priority and OC'’s provided by
AU’s from the Airport Gaming Platform.

Category <Functional>

Validation Method Human-in-the-Loop Simulation

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> TBD <Full>

[REQ]

Identifier REQ-11.01.03-TS-0320.001

Requirement The FOC system shall visualize D-MET information.
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Title PTR in trajectory generation

Status <Deleted>

Rationale Delete Reason: Requirements on visualization are not included in this TS
document, unless considered as absolutely necessary for a specific SESAR
concept. The PTRs will be published by the NM manager to improve the trip
fuel generation in the FOC system. PTRs can be considered directly, by
adapting the generated vertical profile or indirectly by considering additional
fuel amount and not adapting the vertical profile. PTRs must not be
mandatorily considered in trajectory generation. If an FOC includes the PTR
functionality, it shall be possible to enable or disable it.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

[REQ]

Identifier REQ-11.01.03-TS-0320.002

Requirement The FOC system shall visualize D-NOTAM information.

Title TTA in Trajectory Generation

Status <Deleted>

Rationale Delete Reason: Requirements on visualization are not included in this TS
document, unless considered as absolutely necessary for a specific SESAR
concept. The FOC system shall consider TTAs throughout the trajectory
generation process if enabled by the Airspace User.

Category <Functional>

Validation Method <Live Trial><Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Full>

[REQ]

Identifier REQ-11.01.03-TS-0320.003

Requirement

The FOC system shall provide configurable filter capabilities for D-MET and
D-NOTAM information.

Title CTA flight recalculation

Status <Deleted>

Rationale Delete Reason: Not necessary anymore as redundant with REQ-11.01.03-
TS-S1HT.1005. If a flight is affected by a CTA a recalculation will be needed
to consider this new input in the trajectory data. In case of an autonomous
running FOC system this action can be automatically started if selected.

Category <Functional>

Validation Method

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0040 <Partial>
[REQ]

Identifier REQ-11.01.03-TS-0320.004

Requirement

The FOC system shall provide update capabilities for D-MET and D-
NOTAM information.

Title

CTA flight calculation
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Status <Deleted>

Rationale Delete Reason: Not necessary anymore as redundant with REQ-11.01.03-
TS-S1HT.4020. If a flight is affected by a CTA a recalculation will be needed
to consider this new input in the trajectory data. In case of an autonomous
running FOC system this action can be automatically stared if selected.

Category <Functional>

Validation Method

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Regquirement> REQ-11.01.02-OSED-D001.0040 <Partial>

[REQ]

[REQ]Identifier

REQ-11.01.03-TS-0810.0005

Requirement

FOC UDPP prototype would integrate with the Airport Gaming Platform
using XML message exposed through Webservice

Title UDPPIntegrationbetweenFOCand Airport
Status <Deleted>
Rationale Delete Reason: The structural composition of requirements has changed
with this TS document to align the concepts coming from the different TS
documents. This new structure makes this requirement not necessary
anymore. FOC UDPP prototype would integrate with the Airport Gaming
Platform using webservice exposing the following elements which would be
used for UDPP validation
¢ Individual FDA Priorities for Flights
e CCS information including Ol and Duration
¢ Individual OC's for Flights
e Flight Delay EOBT information for Flights
Category <Functional>
Validation Method Human-in-the-Loop Simulation
Verification Method <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> TBD
[REQ]
Identifier REQ-11.01.03-TS-0745.0005

Requirement

The FOC UDPP Prototype system shall have a Human Machine Interface
(HMI) that is used by Operator to get the CCS information published by the
Airport Gaming Platform

Title Human Machine Interface

Status <Deleted>

Rationale Delete Reason: The structural composition of requirements has changed
with this TS document to align the concepts coming from the different TS
documents. This new structure makes this requirement not necessary
anymore. The FOC system will be operated by human beings will allow the
operators to get the CCS information including Ol and Duration published by
the Airport Gaming Platform

Category <HMI>

Validation Method Human-in-the-Loop Simulation

Verification Method <Test>

[REQ Trace]
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Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> TBD <Full>
1955
1956 [REQ]
Identifier REQ-11.01.03-TS-0745.0005
Requirement The FOC UDPP Prototype system shall have a Human Machine Interface
(HM)) that is used to update the FDA Priority and OC for flights
Title Human Machine Interface
Status <Deleted>
Rationale Delete Reason: The structural composition of requirements has changed
with this TS document to align the concepts coming from the different TS
documents. This new structure makes this requirement not necessary
anymore. The FOC system will be operated by human beings will allow the
operators to update the FDA priority and OC'’s for flights which are impacted
by the CCS
Category <HMI>
Validation Method Human-in-the-Loop Simulation
Verification Method <Test>
1957
1958 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> TBD <Full>
1959
1960 [REQ]
Identifier REQ-11.01.03-TS-0745.0005
Requirement The FOC UDPP Prototype system shall have a Human Machine Interface
(HMI) that is used by Operator to get the EOBT information published by the
Airport Gaming Platform
Title Human Machine Interface
Status <Deleted>
Rationale Delete Reason: The structural composition of requirements has changed
with this TS document to align the concepts coming from the different TS
documents. This new structure makes this requirement not necessary
anymore. The FOC system will be operated by human beings will allow the
operators to get the EOBT information and flight sequence published by the
Airport Gaming Platform
Category <HMI>
Validation Method Human-in-the-Loop Simulation
Verification Method <Test>
1961
1962 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> TBD <Full>
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Appendix C Deleted requirements in the source

documents

[REQ]

Identifier REQ-11.01.03-TS-0410.0005

Requirement The FOC system shall provide an EOBT release button in the HMI.

Title Request Air Traffic Demand Data

Status <Deleted>

Rationale Note for deletion: Will be moved to IER.in the next D11.1.2-1 (OSED Step 1)
iteration The FOC system must be able to connect to the NM using SWIM to
pull demand data. The demand shall afterwards be used for flight
scheduling purposes or to estimate a 4D trajectory.

Category <Functional>

Validation Method <Shadow Mode>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0145

[REQ]

Identifier REQ-11.01.03-TS-0410.0010

Requirement The FOC system shall update the AOP with the latest EOBT when the
EOBT release button is pressed

Title Request Air Traffic Demand Data

Status <Deleted>

Rationale Note for deletion: Will be moved to IER.in the next D11.1.2-1 (OSED Step 1)
iteration The FOC system must be able to connect to the NM using SWIM to
pull demand data. The demand shall afterwards be used for flight
scheduling purposes or to estimate a 4D trajectory

Category <HMI>

Validation Method

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

[REQ]

Identifier REQ-11.01.03-TS-0410.0035

Requirement The FOC System shall calculate the turn around times when new airport
environmental information is received.

Title Request Airport Environmental Information

Status <Deleted>

Rationale Note for deletion: Will be moved to SESAR Step 2. Note: This requirement
remains deleted in this step 2 document, as it has no FOC relevance, but
more Airport Operations Centre (ApOC) relevance. For the avoidance of
doubt the term environmental information is used in the context of physical
architecture of the airport (e.g.: gate to gate distances).In order to support
accurate turn-around planning, A-CDM and UDPP the FOC system must be
up-to-date with the latest airport environmental data. This includes gate to
gate distances and terminal transfer times. The Operations Controller and
the Irregularity Recovery Manager needs that information to predict
passenger connection times and thus help the In-Flight Monitoring Officer
and the Flight Dispatcher to accurately consider delay costs

Category <Functional>

Validation Method <Shadow Mode>
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| Verification Method | <Test> |
1974
1975 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-11.01.02-OSED-D001.0135
1976
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1977 -END OF DOCUMENT-

1978
1979
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